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User's Guide Notices

Notice

Information contained in this document is believed to be accurate and reliable at the time of
printing. However, due to ongoing product improvements and revisions, AudioCodes cannot
guarantee accuracy of printed material after the Date Published nor can it accept responsibility
for errors or omissions. Updates to this document can be downloaded from
https://www.audiocodes.com/library/technical-documents.

This document is subject to change without notice.

Date Published: January-28-2018

WEEE EU Directive

Pursuant to the WEEE EU Directive, electronic and electrical waste must not be disposed of
with unsorted waste. Please contact your local recycling authority for disposal of this product.

Customer Support

Customer technical support and services are provided by AudioCodes or by an authorized
AudioCodes Service Partner. For more information on how to buy technical support for
AudioCodes products and for contact information, please visit our Web site at
https://www.audiocodes.com/services-support/maintenance-and-support.

Abbreviations and Terminology

Each abbreviation, unless widely used, is spelled out in full when first used.

Document Revision Record

LTRT Description
30805 Initial document release for Version 1.05.45
30806 Updates for adding SNMPvV3 users and new template for Skype for Business.

30807 Update of Version number to 1.0.5.51
30808 Updated to Version 1.0.5.65
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Documentation Feedback

AudioCodes continually strives to produce high quality documentation. If you have any
comments (suggestions or errors) regarding this document, please fill out the Documentation
Feedback form on our Web site at https://online.audiocodes.com/documentation-feedback.
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User's Guide 1. Introduction

1 Introduction

This document describes how to install and use the AudioCodes SCOM Management Pack
which manages AudioCodes gateways in the SCOM environment.

SCOM (System Center Operations Manager) enables customers to reduce the cost of data
center management across server operating systems and hypervisors through a single,
familiar and easy-to-use interface. Different views show state, health and performance
information, as well as alerts generated according to availability, performance, configuration
or an identified security situation. Operators can gain a rapid insight into the state of the IT
environment, and the IT services running across different systems and workloads.

The purpose of the AudioCodes SCOM Management Pack is to allow the SCOM server to
monitor AudioCodes gateways through SNMP. This includes Discovery, health states, alerts,
performance counters and tasks.

Note: The AudioCodes SCOM Management Pack runs only on SCOM 2012 and on
SCOM 2012 R2. It is not backward-compatible to run on SCOM 2007.
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2 AudioCodes Management Pack - Gateway
Support

The following AudioCodes gateways are supported by the AudioCodes SCOM
Management Pack:

Mediant 4000 E-SBC

Mediant 3000 Gateway and E-SBC

Mediant 2600 E-SBC

Mediant 2000 Media Gateway

Mediant 1000 Media Gateway

Mediant 1000B Gateway and E-SBC

Mediant 1000B MSBR

Mediant 800 MSBR

Mediant 800B Gateway and E-SBC

MediaPack Media Gateways MP-124 (FXS)
MediaPack Media Gateways MP-118 (FXS and FXO)
MediaPack Media Gateways MP-114 (FXS and FXO)
MediaPack Media Gateways MP-112 (FXS)
MediaPack 1288
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3

3.1

A\

Setting up the AudioCodes SCOM
Management Pack

This chapter describes the following setup procedures:
B Running the Setup Wizard. See below
B Importing Management Pack. See Section 3.2 on page 22.

Running the Setup Wizard

This section describes how to setup the AudioCodes SCOM Management Pack environment
on the SCOM server. Once you have completed this setup, you can import the AudioCodes
Management Pack into the SCOM environment and manage AudioCodes devices.

Note: This step is only required if you have received the Management Pack in executable
file format.

» To setup the AudioCodes Management Pack:
1. Runthe AudioCodesSCOM.exe file; the AudioCodes SCOM Setup wizard is displayed:
Figure 3-1: AudioCodes Setup Wizard Welcome Screen

" 8] Setup - AudioCodes SCOM ESREETT)

Welcome to the AudioCodes
SCOM Setup Wizard

This will install AudioCodes SCOM version 1.0.2.3 on your
computer.

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

Mext = ]| Cancel

2. Click Next; the Select Destination Location screen is displayed:
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Figure 3-2: Select Destination Location

AudioCodes SCOM Management Pack

r
i5! Setup - AudicCodes SCOM =L=

Select Destination Location
Where should AudioCodes SCOM be installed?

j Setup will install AudioCodes SCOM into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse,

C:\Program Files\AudioCodes SCOM Browse. ..

At least 2.9 MB of free disk space is required.

< Back l[ Mext = ][ Cancel

Choose the folder for installing the AudioCodes Management Pack, and then click Next;

the Ready to Install screen is displayed:

Figure 3-3: Ready to Install

a
i Setup - AudioCodes SCOM ==

Ready to Install
Setup is now ready to begin instaling AudioCodes SCOM on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -
C:\Program Files\AudioCodes SCOM

« Back ][ Install ]’ Cancel

User's Guide
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4. Verify the installation settings and then click Install; the Completion screen is displayed:
Figure 3-4: AudioCodes Setup Wizard Complete

== h

i Setup - AudioCodes SCOM

Completing the AudioCodes SCOM
Setup Wizard

Setup has finished installing AudioCodes SCOM on your
computer.

Click Finish to exit Setup.

5. Click Finish to exit the setup.
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3.2 Importing Management Pack

This section describes how to import the AudioCodes Management Pack into the SCOM
2012 or 2012R2 environment. Once you import the Management Pack, you can manage
AudioCodes gateways via the SNMP interface.

» To import the AudioCodes Management Pack into the SCOM environment:

1. Startthe SCOM; the SCOM interface is displayed.

2. In the main SCOM window, click the Administration pane; the Administration pane
is displayed:

Figure 3-5: Administration Pane

BA audiocodes - Dperations Manager [_[Ox]
Fle Edt View Go Tasks Tools Help

searchv _ B, @ -

Administration €

4 |<fB Administration N
8, Cannected Management Growps 2

= .5 Administration Overview
4 [ Device Management .
iy Agent Managed -

i Agentless Managed

Al Mansgement Servers ‘0‘ Required Configuration Tasks: Actions:
& Pending Managemert
E unpt/Linx computers

% Management Pads

Configure computers and devices to manage

In order for Cperati

Manager to manage and monitor your
network you must o 3

plete the following steps:

Import management packs
View Management Pack Catalog

.

5] Network Management % Required: Configure computers and devices to manage
15 piscovery Rules
=2 Network Devices
5% Network Devices Pending Managemert

Find management agents for other platforms

“ Required : Import management packs Find connectors for other management tools

% Required: Enable Notification Channels

e % Upgrade to full version Key Concepts:
|2 Channels The Administration Workspace
&5 Subseribers Discovering Metwork Devices
LiZ] Subscriptions . . . Run As Accounts and Profiles

4 & Product Connectors _,/ Optional Configuration: Run As Accounts and Profiles for UNIX and Linux
0 Internal Connectors Management Packs

23 Resourca Pocks Optionally configure the following components: e

4 %p Run &5 Configuration % Configure Active Directory (AD) Integration Destination Management Pack
#] Accounts Active Directory (AD) integration allows you to leverage your
2. Profiles investment in AD by enabling you to create AD based rules to assign
451 UNDX L Accounts computers ta Management Group. Learn About:

4 (5 Security Selecting Targets and Groups

2, UserRales % Configure Client Monitoring

@, settings Client Monitoring enables you to monitor operating systems and
e applications for errors and participate in the Customer Experience
Improvement Pragram.

Creating a Resource Fool

Online Resources:

Microsoft System Center Online

Microsoft System Center Community

Discovery Wizard... Report an Issue or Suggestion to Microsoft

Bl WMonitoring
/A Authoring
"l Administration

F{{ My Workspace

Ready P
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Figure 3-6: Import Management Packs Option

Discovery Wizard, .,

B

reate Management Pack.

Download Management Packs L.,

Import Management Packs. ..

Mew User Raole 3

) Create Run As Account...
1_ reate Run As Profile. ..

=5 Mew channel 3
_1_3 Mew subscriber ..

o1 Mew subscription...
™ Add Management Group
=

[

Refresh F=

3. Inthe Navigation tree, right-click Management Packs, and then from the pop-up menu,
choose Import Management Packs; the Select Management Packs window is

displayed:
Figure 3-7: Select Management Packs

@ Help
Import list : = add = 7 Properties ... X Remowve
| Mame | Version &dd From catalog ...
Status details :

Irstall Cancel |

Y
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4. Click the Add button, and then choose Add from disk; the following dialog is displayed:

Figure 3-8: Online Catalog Connection
Cnline Catalog Connection l-“_]

| Some of the management packs you select may have
' dependencies that cannot be located locally.

Would you like to search the online catalog for
these dependencies?

5. Click No to decline choosing Management Pack from a Catalog.
6. Locate the saved AudioCodes Management Pack (in XML format) on you disk (the

location that you chose in Section 3 on page 19) and then click the Open button; the
Select Management Packs window is displayed:

Figure 3-9: Select AudioCodes Management Packs

mport Management Packs ﬂ

@ Help

Management Packs

< Add + % Properties ... % Remove

Import ligt :
| Mame | erzion | Release Date | Status | ELA |

v bl anagement Pack [1.0.2.0

Status details :
Audiocodes Gy Management Pack version 1.0.2.0 iz imported.

Install | Cancel |

¥

7. Select the AudioCodes GW Management Pack, and then click the Install button.
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4 Discovering Gateway Devices

When Management Packs are installed you have to discover your AudioCodes gateways as
Network Elements to enable SCOM to make a full discovery. You discover the gateways by
using the Discovery Wizard to create a Discovery Rule.

A Note: You can create a single Discovery rule for each SCOM server.

4.1  Creating Discovery Rule

This section describes how to discover gateways as a network device.

» To discover the gateway as a Network Device:

1. Inthe Administration pane, right-click Network Devices ,and then in the pop-up menu,
choose Discovery Wizard:

Figure 4-1: Open Discovery Wizard

Discovery wWizard. ..

Create Management Pack,
Download Management Packs L.,

Import Management Packs. ..

Mew User Fole 3

b S G GBI (B

Create Run As Account...

|'”|"¢'

Creake Run As Prafile. .

Mew channel 3

T4

Mew subscriber, .,

T

o Mew subscripkion, .
M Add Management Graup

o Refresh FS
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The Computer and Device Management Wizard is displayed:

Figure 4-2: Computer and Device Management Wizard

General Froperties Choose the type of computers or devices to discover and manage.
Dizcovery Method
Default Accounts s G S

Devices Discover Windaws computers in your Active Directory
7 "f environment and install agents on the ones you want to

Schedule Discovery ’ /' manage.
é ! f

Summary

Completion
UNIX/Linux computers

This enables vou to discover IMIX and Linus computers in

your environment and install agents on the ones you want to

manage.
o

Network dexices

“485 1 Dizcover and monitor network devices using Simple
v 4 Metwork Management Protocol [SHMP).

Select a discovery type and click Mext to continue.

<E|evious| Mext » I LCreate | Cancel |

2. Selectthe Network devices option, and then click Next; the General Properties window
is displayed:
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Figure 4-3: General Properties

I Network Devices Discovery Wizard
& Help
Dizcovery Methad Specify general properties
Default dccounts
Devices
Schedule Discavery Description [optionall
Surmmary ;I
Caompletion ;I
Select a management or gateway server
Select an Operations Manager management server or gateway server to wn the
discovens A server can run only one network discovery. Servers that already mun a
network discovery do not appear in the list,
Available servers:
SCOM.ipnc15 local |
Select a resource pool Create Resource Fool |
Select an Operations Manager resource pool for monitoring of discovered network
dewvices.
Ayailable pools:
AllManagement Servers Resource Paol j
< Frevious | Mest = I Save | Cancel |

3. Inthe 'Name' field, enter a description of the Discovery Rule.

4. From the Available servers drop-down list, choose the SCOM server e.g.,
SCOM.iLync15.local, and then click Next; the Discovery Method window is displayed:
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Figure 4-4: Discovery Method

General Properties

@ Help
Select a discovery type
Drefault ccounts
] (+ Explicit discovery
Devices Operations Manager will discover only those network devices you specify.
Schedule Discovery
Summary = Recursive discovery
Completion Operations Manager will discover the devices that you specify and all devices that are

connected to the devices that you specify.

IZ@ZIMore about discovering network. devices

<Erevi0us| Mext > I Save | Cancel |

5. Select the appropriate actions, and then click Next; the Defaults Accounts page is
displayed:

Figure 4-5: Default Accounts

F Network Devices Discovery Wizard [ %]

General Properties @) Help

Dizcovery Method Specify the default Run As accounts for discovery

Default A

Select one or more SMMPYT or SHMPv2 Run &3 accounts as the default accounts for
discovering network devices. You can overide the default accounts for individual network

Devices devices or add accounts for SMMPY2 devices later in this wizard,

Schedule Dizcavery

Surnmar
Y Create Account...

Completion
u Bun Az accounts:
| Account Mame | Description |
public
Select Al Ceardl |

More about Fun &3 accounts

< Previous | Mest » Save Cancel
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6. Choose the default SNMP SCOM account (this account is always-'public’) or click
Create Account button to create a new default account; a wizard opens. Enter a Display
Name and Community String (use the same community string that is configured on the
network device that you wish to discover), and then click Create.

7. Click Next; the Devices page is displayed with the new user details:

Figure 4-6: Devices
F Network Devices Discovery Wizard [ %]
- !_J
General Properties @ Help
Dizcovery Method Specify devices

Default &ccounts

Specify the netwark devices that you want to dizcover and manage. “You can also impaort &
text file that contains the P addreszes of your network. devices.

Schedule Dizcovery

Summary || Import... =g add.. [ Edit.. 2% Remove
Completion Devices:
Device | Fiun &z Account | SHMP Versionl Fort | Accesz Mode |
1595.189.192.249 Usze default accounts W1 oy 161 SHEP
10.30.60.218 public: W1 ory2 181 SHMP
10.30.50.217 Usze default accounts W1 oy 161 SHEP
10.30.50.219 Usze default accounts W1 oy 161 SHEP

| Advanced Discovery Settings. .. I

IZ@ZIMore about network, dizcovery settings

< Previous | Mest » | Saye | Cancel |

8. Click the “*#%.. putton to add the IP addresses of devices to be discovered (if you wish
to add a device with SNMPv3, see Section 5 on page 37); the Add a Device dialog is
displayed:
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Figure 4-7: Add a Device

Add a Device Ed

Specify the zettings for the nebwork device vou want to dizcover.

Mame or |P address: ()

Access mode: SHEP version:
I'H.-"I or ve j
Part number: SHEMP YT or Y2 Run As account:
161 - IUSE selected default accounts j

Add SMMP YT or W2 Bun Az Account |

ii}' kare about network, dizcoveny zettings

] ;4 I Cancel

9. Inthe 'Name or IP address' field, enter the Enter the Name or IP address of the device.

10. From the Access mode field drop-down list, select SNMP.

11. Optional: From the 'SNMP V1 or V2 Run As Account' drop-down list, select a different
already configured default account.

e If you wish to configure a new SNMP V1 or V2 default account, then click the
Add SNMP V1 or V2 Run As Account button; a wizard opens. Enter a Display
Name and Community String (use the same community string that is configured
on the network device that you wish to discover), and then click Create.

Note that the same dialog opens as in the 'Default Accounts' step above.
12. Click Next; the Schedule Discovery screen is displayed:
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F Network Devices Discovery Wizard

General Properties
Dizcoveny Method

Default Accounts

Devices

Surnmary

Completion

Figure 4-8: Schedule Discovery

& Help

Schedule the network discovery

" Run the discovery iule at scheduled imes
Time of day:

IEIEI:EIEI 5:

Dayz of the week:
[T Sunday

™| tanday

[T Tuesday

[ wednesday
[T Thursday

I~ Eriday

[T Saturday

£ Run the discovery e manually

Sawve Cancel

<F'revinus| Mest > I

13. Selectthe Ru

n the discovery rule manually option, and then click Next; the Summary

page is displayed:
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Figure 4-9: Summary

F MNetwork Devices Discovery Wizard [ %]
General Properties @ Heb
Discovery Method Confirm the settings
Default Accounts J
Devices Name .

Audiocodes GWs discovery
Schedule Discovery
- Description:
Surmmary
Eampletio Run As accounts:
public
Discovery method:
Explicit
Number of devices specified:
4
Schedule:
Run Manuazlly
< Previous I et > Save | Cancel |
14. Review the settings, and then click Save.
15. Wait for the discovery rule to complete saving.
Figure 4-10: Discovery Saving Progress
F MNetwork Devices Discovery Wizard E
General Propertiez @ Helb
Dizzovery Method Creating the discovery...
Defauit Accaunts ™, Pleaze wait while the discovery mile iz created.  This could take a minute
Devices | depending on the speed of your computer.
Schedule Discovery
Summary
Completion
< Brevious Tests Save Cancel
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16. Click the Close button; a confirmation window is displayed:

Figure 4-11: Network Discovery Rule Confirmation

f‘ Network Devices Discovery Wizard

General Properties

Discovery Method
i @ The network discovery rule was successfully created

Default Accounts

Devices

Schedule Discowver . . .
Y ¥ Bur the network dizcovery ile after the wizard iz closed

Summary

Completion . . . . L
o To view progress when a network. digcovery rule is running, open the Adminiztration
workspace, expand Metwork M anagement, and click Discovery Rules.

@) Help

LCloze |

The newly created rule should appear in the 'Discovery Rules' pane. When the rule
has been successfully created, it should have the status 'ldle'.

17. Wait for 5-8 minutes to allow the SCOM to make a full discovery.

Figure 4-12: Discovery Rules Confirmation

A piscovery Rules - Audiocodes - Operations Manager

Fle Edit View Go Tasks Tools Help

[_[O0x]

Administration < Discovery Rules (1)

[ Agentiess Managed 2| A Leokfor: EindMow  Clear x

8 Management Servers | metwork Discovery server + | status
&% Pending Mangement SCOM_SQL2003_R2.Giant-Steps... Idle
[ UNDiLinux Computers
% Management Packs
4 (3 Network Management:
|5 DiscoveryRules
= Wetwork Devices
5% Netwark Devices Pending Management
4 1 Wotifications
2 Channeks
&) subscribers
“-] Subscriptions
4 & Product Connectors

L Internal Connectors

A3 Resouree Pools

4 ‘ Last Discovered 4 | LastPending /| Last Run Time
1 ] 01/12/2012 22:50:27

aueq yse|

4 ¥ Run A3 Configuration K|
40 Accounts Details:

L. Profiles -

N LINTA i Aoremrinds

Discavery Wizard, .,
Bl Monitoring
# Authoring
. Administration

[ My Workspace

Ready

<
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18. Click the Administration pane, and then in the Navigation tree, select Network

Devices.

Figure 4-13: Network Devices

B network Devices - Audiocodes - Dperations Manager

Fle Edit View Go Tasks Tools Help

I Search v . !\I<

Drnd (@7 @ .

Administration

[ Agentless Managed
%ﬁ] Management Servers
l_':L Pending Management
d UND¥linux Computers

W Management Packs

a _=g Netwiork Management

JB Discovery Rules

! Metwork Devices

':{“‘f Metwork Devices Pending Management

4 | -] NMotifications
|z Channels
;‘34 Subscribers
-5 Subscriptions
4 & Product Connectors
L5 Internal Connechors
A4 Resource Paols
4 S?;- Run &: Configuration
] Accounts
;. Profiles

L LI i Aeenninds

Discovery Wizard...

.‘ Monitoring
4/'?[‘ Authering
" Administration

EE My Workspace

Ready

4 Metwork Devices (2)

& G Logkfor: [

Tame

4 | IP Address

Find Mow Clear

Runds Account

4 Resource Pool: All Manage ment Servers Resource Pool (5)

10.30,50.217
10.30,50.217
10.30.50.219
Audiocodes.cam

Audiocades.cam

4

10.30,50,217
10.30,50,217
10.30.50.219
195.189.192.249
195,159,192,243

public
public
public
public
public

=] B3
<
x
Access Mode
SHMPOMLY
SHMPOMLY
SMMPORNLY
SHRPORLY
SMMPOMLY
&
@
e
-
o
=
[
oml
4

All discovered gateways are displayed in this window.

Note: Wait for five-eight minutes to allow the SCOM to make a full discovery.
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4.2 Managing SCOM Accounts

SCOM accounts are managed in the Accounts screen.

>
1.

Accounts (13)

To view currently defined SCOM user accounts:

Open the Accounts page (Administration > Run as Configuration > Accounts); a
screen similar to the following is displayed:

Accounts Page

> Tasks
Mlame # | Description Last Madified = ‘@‘
4 Type: Action Account (2) Aetiome ,-\
e} ILYMCASsAdministrator This is the user account under which all rules run by default on the agent. 11/3/2013 11:39:22 &AM
e‘, Local System Action Account Builtin SYSTEM account to be used as an action account 11/3/2013 11:18:45 AN =] Properties
4 Type: Community String (1) 75 Delete
L public 1174/2013 3:09:23 PM | Create Run As Account...

4 Type: SNMPv3 Authentication (7)

& Brad
& Brad
& Brad
Ly Daniel
& Mike
S Mike
sy Ofer

4 Type: Windows (3)

S Data Warehouse Report Deployment A..  Data Warehouse Report Deployment Account 11/3/2013 11:47:10 AW
%5 Local System Windows &ccount Built in SYSTEM account 117342013 11:18:27 A
‘:-‘_.v Metwork Service Windows Account Builtin Metwork service account 11732013 11:18:27 AM

11/6/2013 11:36:28 AM
11/5/2013 6:29:53 PM
11/6/2013 113937 AM
11/6/2013 2:55:07 PM
11/6/2013 2117:27 PM
11/6/2013 2:13:41 PM
11/6/2013 2:19:45 PM

Il

e  To view the account properties, select an account, and then in the Tasks pane,
click the Properties button.

e To delete a user, select an account, and then in the Tasks pane, click the Delete
button.

4.2.1 Adding Network Devices to Discovery Rule

This

>
1.

section describes how to add network devices to an existing Discovery Rule.

To add network devices to an existing discovery rule:

In the Discovery Rules window, double-click the Discovery Rule; the Network Devices
Discovery Wizard is displayed with the existing settings.

Run the wizard as described above in Section 4.1 on page 25.
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5 Configuring SNMP

This section describes how to configure the SNMP connection between the managed
AudioCodes devices and the SCOM.

The following topics are described:

B Adding SNMPv3 Users. See below.

B Disabling SNMP trap service. See Section 5.2 on page 50.

B Setting up the device to send SNMP traps. See Section 5.3 on page 51.

5.1 Adding SNMPv3 Users

This section describes how to add SNMPv3 users. You initially need to create the SNMPv3
on the device in the Web Interface, and then add the same user in the SCOM using the
Discovery Wizard.

Note: You must configure identical user credentials in the SCOM as you configure in the
Web Interface.

5.1.1 Adding SNMP V3 Users in the Device Web Interface

The SNMP v3 Users page allows you to configure authentication and privacy for up to 10
SNMP v3 users.
» To configure SNMP v3 users:

1. In the device Web Interface, open the SNMP v3 Users page (Configuration tab >
System menu > Management sub-menu > SNMP sub-menu > SNMP V3 Users).

2. Click Add; the following dialog box appears:
Figure 5-1: SNMP V3 Setting Page - Add Record Dialog Box

Add Record

Index i

User Mame

Authentication Protocol Mane -
Privacy Protocol Mone -

Authentication Key

Privacy kKey
iSroup Read-Write -

B Submit | % Cancel
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Figure 5-2: SCOM V3 User Added

- SNMPV3 Use

w SNMPv3 Users

Add + Edit Delete @

ShowiHide [
Index - User Name Autg:;gzz:ion Privacy Protocol Authentication Key Privacy Key Group
0 SCOM MD5 DES = = Read-Write
page[t  |of1 Show records per page Viewl-1of1

Selected Row #0

User Name: SCOM Authentication Key: e3
Authentication Protocol: MD5 Privacy Key: &
Privacy Protocol: DES Group: Read-Write

3. Configure the SNMP V3 Setting parameters according to the table below.
4. Click Submit to apply your settings.

5. Open the Maintenance Actions page (Maintenance tab > Maintenance menu >
Maintenance Actions).

Figure 5-3: Resetting the Device

+ Reset Configuration
Reset Board
Burn To FLASH Yes [+]
Graceful Option Mo El
+ LOCK /UNLOCK
Lock LOCK
Graceful Option Mo El
Gateway Operational State UNLOCKED
+ Save Configuration
Burn To FLASH

6. Ensure that the 'Burn to FLASH' field is set to Yes (default).
7. Click the Reset button.
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Table 5-1: SNMP V3 Users Parameters

Parameter

Index
[SNMPUsers_Index]

User Name

[SNMPUsers_Username]

Authentication Protocol
[SNMPUsers_AuthProtocol]

Privacy Protocol
[SNMPUsers_PrivProtocol]

Authentication Key
[SNMPUsers_AuthKey]

Privacy Key
[SNMPUsers_PrivKey]

Group
[SNMPUsers_Group]

Description

The table index.
The valid range is 0 to 9.

Name of the SNMP v3 user. This name must be unique.

Authentication protocol of the SNMP v3 user.
= [O] None (default)

= [1] MD5

= [2] SHA-1

Privacy protocol of the SNMP v3 user.

= [O] None (default)

= [1] DES

= [2] 3DES

= [3] AES-128

= [4] AES-192

= [5] AES-256

Authentication key. Keys can be entered in the form of a text

password or long hex string. Keys are always persisted as long hex
strings and keys are localized.

Privacy key. Keys can be entered in the form of a text password or
long hex string. Keys are always persisted as long hex strings and
keys are localized.

The group with which the SNMP v3 user is associated.
= [0] Read-Only (default)

= [1] Read-Write

= [2] Trap

Note: All groups can be used to send traps.
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5.1.2

Adding SNMPv3 Accounts in SCOM

This section describes how to add SNMPv3 users in the SCOM.

» To add SNMPv3 accounts:

1. Inthe Administration pane, select Run As Configuration > Accounts, and then in the

Actions pane, select Create Run as Account.
Figure 5-4: New SNMPv3 User

File Edit Miew Go Tasks Tools Help

L Jsewan~ iR

Accounts - SCOM-548 - Operations Manager

== |

Discavery Wizard...

.‘ Monitoring
_}I‘ Authoring
iu Reporting
, Administration

E My Workspace

Ready

Administration < Accounts (6) ¥ Tasks
4 < Administration ~| 4 Look for: | Find Mo Clear o &
a Connected Managemert Groups Marne Description A -
4 |5 Device Management: .
4 Type: Action Account (2) —
# Agent Managed . " . =] properties
3 & Local Systern Action Account Built in S¥3TEM account to be used as an action account A
i Agentless Managed )( Delete
= & SBAdministrator This is the user account under which all rules run by defaul
&J Management 5 ervers ’ 9. Create Run As
& Pending Managemert 4 Type: SNMPv3 Authentication (1) L
& UMELinux Computers A7 SMMPV3_User
'\l; Management Pads 4 Type: Windows (3)
4 ,-__g Network Managemert: Sy DataWarehouse Report Deployment .. Data Warehouse Repart Deployment Account
jﬂ Discowery Rules S Local System Windows SAccount Built in S¥STEM accaunt
222 Metwork Devices = Sy Metwork Service Windows Account Built in Metwork service account
‘:{‘ Metwork Devices Pending Managemert
4 ] Naotifications
2= Channels
& subscribers
S| Subscriptions
4 & Product Connectors
L5 Internal Connednes
23 Resource Pools
4 Run & Configuration
2] Accounts
! Prafiles
] UNILinux Accounts
4 (3 Security -

< m
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The Create Run as Account wizard is displayed:
Figure 5-5: Create Run as Account

Specify general properties for the Run As account

Credentialz

o . Select the type of Run As account that vou wank to create, and then provide a display name
Diigtribution S ecurity and description,
Completion

Fun As account bype:

|SHMPYE Account

Display narme:

Description {optional):

| < Previous || Mewt > || Create || Cancel

2. From the "Run As account type" list box, select SNMPv3 Account.
3. Enter the desired display name and description.
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Introduction
General Properties
Credentials
Drigtribution S ecurnty

Completion

Figure 5-6: Account Credentials

Provide account credentials

Provide credentials For this Windows Fun As account,

User name:
[

Password:

Dormain:

El

Confirm password;

| £ Previous ||

Mest >

LCreate || Cancel |

4. Create the new account using the same credentials that you configured in Section 4.1
on page 25 and in Section 5.1.1 on page 37.

5. Ensure that you set the Distribution Security to the More Secure.... option.
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Introduction
General Properties

Credentials

Completion

Figure 5-7: SNMPv3 User-Distribution Security

Select a distribution security option

The credentials for thiz Fun As account must be distributed to the agent-managed computers
or management servers to perform the monitoring operations that are associated with a Fun
Az profile. Distribution cannat occur until the Run As account iz added to a Run Az profile.

Select a distribution security option for this Run As account:
() Less secure - | want the credentials to be distibuted automatically to all managed
computers.

Caution: Administratars of all recipient computers will be able to access the Fun As
account credentials.

(® More secure - | want to manually select the computers to which the credentials wil be
distributed.

|<Erevi0us || Meut » || Lreate || Cancel |

6. Atthe end of the wizard process, click Create to create the new SNMPv3_User object.

Figure 5-8: SNMPv3 User-Wizard Completed Successfully

Introduction
General Properties
Credentialz
Digtribution Security

Completion

Wizard completed successfully

Y'ou have successfully created this Run As account,

A You must now azzociate this Run As account with an appropriate Run As profile.
Y'ou can edit an existing profile or create a new one.

< Previous | | Mest » | | Lloze | | Cancel
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7.

In the Administration pane, select Run As Configuration > Profiles and then select

the profile that you wish to associate with the new SNMPv3 Run as account.

Figure 5-9: Run as Profile

Ele Edit Yew Go Tasks Tocks Help
seven~ {8 (Pred ([EiTed) @
Admindstration *  Profiles (29) » Tasks
4 P Asministryten oL Leok for: | EndMow  Glewr 5 ]
I'?‘m‘""‘""““m Name « Deseription Actiseas o~
! ‘-r"“‘""‘"'"" R, Micrasoft SyrtemCenter WebApplicatia... -
& :mm::rw B Active Directory Based Ag ignme.. by A based agent assi publish smingstos
e R, Agent Health Opsbgr Dstabase Account  Account ured to access the Operations Maneger databiase to collect agent status. o
& fenging Manigement . APM CIM Encryption Profile The file used enryption bey setings forcolleted senithe data ir B SSE R A3
1 unmincconputen B Automatic Ag Account  Thi duagnasic agert fadure s s
T Managesentfads B, Certificate Srgrang Accourt This Wirnderws stcourt i used for signing the cerificates uted bo secure communicate b
4 (7% mietwark Management R, Client Manitoring Action Account If specified, this all Cli dules part of various nile:
£] DiscoveryRule: | R, Connested Management Group Sizcount  This profile detemmines whi dertials a d i itred ma
2 Network Deviees B R, DataWarehouse Account I specified, this account is used to run all Data Warehause colleetion and symcheonization
S Meburork Devters Penling Maniagenark R Data Warehouse Repost Deployment A This accaunt is used by Data Warehause repa proceduees tn execute «
4’} Mokificabions B Data Warchouse S Server Authenticat... If specitecd, this login risme ol 1
i £ e, B, Detauit Action Account Tive default Health Serace Actron Account
Subsain .
ﬁﬁm 5 R MPUpdae Action Accourt This sccount is wred by the MPUpdate notifier
& & Prouctconnedns &, Notfication Accourt Windows sccourt used by netification rules, Use this sccount's email sddeess 3 email ar
95 intermal Connedon R, Operstionsl Database Account This account is used to read and weite infarmation ta the Operational Database.
i Resource Pucs R, Penaleged Manitosing Account This proile 13 used for monitonng which can onky be dore with  hagh level of privileqe t
# Wy Punfs Configuntion B, Reportmg SDK 500 Sere W ipacifond], thus log Begeis ta b
21l Azcoune: R Reserved This profile 15 reserced and must not be used.
i Profiles R, Resered This profils is reserved and must not be used.
£ uNbinscscezunts &, Resened This prafilk is resened and must net be used.
LB “| R, SHMP Manitoring Account This accaunt is used for SIMP monitaring.
Otutivery Wimd... 2 1 d 2
B, shnabi User
W Monioing R, UNDLinus Action Account This account is used for b priviege UNDC and Linux sceess.
J uhring 2. i i This iz wted for prvileged parations for UNDC and Li w
R, UNDLinux Pravileged Account This account is used for d UMD and L
|5 eporting R, Validate Alen Subserigtion Account  Arcount used by the v 2 i dul - w
@ Adminktration B, Windows Cluskes Sction Account Thus prohle i+ wsed for of Windws Clu T
.m“w - B wi-Mangement Action Account This account is ured for WE-Managerment access.
2] - 2] GO
Feady

8.

and select Properties. The Profile wizard opens:

General Properties

Fiun &3 Accounts

Completion

Figure 5-10:

Introduction

Profile Wizard

Fun As profiles allow monitoring operations (monitars, rules, and tasks) to run as an account that has sufficient
privileges ko successfully monitor protected resources in the netwark, For example, you can use a Run As profile
to read database properties or ko lag on ta a mailbao:.

In addition, administrators can assign different Run As accounts ko different monitared resources, This is useful
when multiple resources are monitored by the same agent or management server, but each agent. or server has
a different security context. For example, a single SQL server might host multiple databases, but each database

has a different owner,

Use this wizard to assign a Run As account that has the necessary privileges to the Run As profile,

To begin the Run As Profile wwizard, click MNext.

[] Do not shaw this page again

Right-click the SNMPv3 profile ("SNMPv3 Monitoring Account” in the above example)

< Previous | ‘ Next » Save

Cancel
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9.

In the General Properties tab, enter the relevant properties and then in the Run As

Accounts tab, select the SNMPv3 account that you just added:

Figure 5-11: Select Run As Account

i

Bun s account;

Add a Bun As Account

Select a Bun Az account to add to thiz profile. Choose an account that haz privileges that are
sufficient to monitor the objects that you specify,

EE

BradSMkPw3

SHMPY3 User

[rata warehouse Report Deplovment Account
Local System Windows Account
Metwork, Service Windows Account

(® A selected class, group, or object;

|| Select... |

Cancel

10. Click Save to save the new account.
11. Inthe Administration pane, click Network Management > Network Devices and select
Discovery Wizard.
12. Run the Discovery Wizard to discover Network Devices.
13. Add the device using the new SNMPv3 user account:
Figure 5-12: Add a Device
Administration o Computer and Device Management Wizard \L‘ » Tasks
[ Agentless Managed ERN 7]
@ Management Servers E}L’\
& Pending Managemert == s
B umtinecomputers Discovery Type
Management Packs
4 }i Netw:rk Management General Properties Spedily devices
' Discovery Rules Discovd Add a Device -
=32 Network Devices Default
‘:‘-‘0-‘ R PR e Rl PR Specify the settings for the network device you want to discover. ol Aol
4 | Notificatiors Sehedy L
LE:_: Channels — Hame or IP address:
aysubscnbers =umma |1D3343|} | i
£Z] Subscriptions Comple;

4 & Product Connectors
25 Internal Connectors
B4 Resource Pools
Pl @s‘ Run As Configuration
3] Accounts
3) Profiles
2] UNIX/Linux Accounts
4 3} Security
a; User Roles
@}, Settings

Discovery Wizard...

.‘ Monitoring
j Authoring
i‘:' Reporting

. Administration

Access mode: SHMP version:

[shmP v e 7]
Port number: SHMP V3 Run As account:
161 3 [snmPv3_tser v
[ A6d SNMP V3 Run As Account |
"@l More about network discovery settings
0K | | Cancel |

@ More about network discovery settings

Advanced Discovery Settings...
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14. Click Create to add the device.

Note: This step it will take 1 hour to 24 hours to discover all the devices with SNMPv3.

The Devices page is displayed with the details of the new SNMPV3 account:

Figure 5-13: Devices Page

F Network Devices Discovery Wizard

General Properties

Dizcovery Method

Default Accounts

Schedule Discoveny

Summary

Campletion

Specify devices

Specify the network devices that wou want to dizcover and manage. v'ou can also import a
text file that containg the P addresses of your network. devices.

|| Import... 2@add.. [ Edi.. X Remove

&) Help

Devices:

Device

I Run &g Account

I SNMPVersiUnI Fort I Access Mode I

1015.7.8
10873
10.3.90.37
10.3.93.230
1015.21.15

Ise default accounts
ge default accounts
|Jse default accounts
|Jse default accounts
Brad

l::&:'MD[E about network. discowvery settings

< Prewvious |

YW1 o2 161 ICHP and SM...
Y1 or 2 161 ICMP and SM...
Y1 o2 161 ICMP and SM...
W1 or'2 161 ICMP and SM...
W3 161 ICMP and SM...

‘ Advanced Discovery Settings. . |

Ment > | Save | Caticel |
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15. Click OK; the Schedule Discovery screen is displayed:

Figure 5-14: Schedule Discovery

F Metwork Devices Discovery Wizard
i}
General Properties @ Heb

Digcoven bethod Schedule the network discovery

Default Accounts
" Bun the discovery rule at scheduled times

Devices

Time of day:

Summary IDD:DD 3:
Dapsz of the week:
[T Sunday

™| bMonday

[T Tuesday

[T wiednesday
™| Thursday

™| Friday

[T Saturday

Completion

{* Run the discovery wle manually

<F'levi0us| Mest > I Save Cancel

16. Select the Run the discovery rule manually option, and then click Next; the Summary
page is displayed:
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F MNetwork Devices Discovery Wizard

General Properties
Discovery Method
Default Accounts
Devices

Schedule Discovery

Summary

Completion

Figure 5-15: Summary

Confirm the settings

@) Help

Name:

Description:

Run As accounts:
public

Discovery method:

Explicit

Schedule:
Run Manuazlly

Audiocodes GWs discovery

Number of devices specified:
4

-

=

< Previous I

et > Save | Cancel |

17. Review the settings, and then click Save.
The following message may be displayed:

Warning

The Fallowing accounts need to be distributed to the health service
'SCOM,ivnc 1S, local' and the members of the management pool ‘Al
Management Servers Resource Pool in order For the discovery to

l'\.

otk
Brad

W'ould waou like Operations Manager to distribube the accounks?

Wes: Distribute accounts and create the discovery,
Mo: Do nok distribube accounks and do not create the discovery,

Figure 5-16: Warning

Yes

B |

Mo

18. Click Yes to confirm.

19. Wait for the discovery rule to complete saving.
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Figure 5-17: Discovery Saving Progress

E Network Devices Discovery Wizard [ %]

General Properties @ Heb
Dizcovery Method Creating the discovery...
Defauit Accaunts ™. Please wait while the discovery nule iz created.  This could take a minute
Devices | depending on the speed of your computer.
Schedule Discovery
Summary
Cormpletion
< Brevious | et > | Saye | Canze|
20. Click the Close button; a confirmation window is displayed:
Figure 5-18: Network Discovery Rule Confirmation
I\ Network Devices Discovery Wizard
_: e
General Properties @ Help

Dizcovery Method
Y @ The network discovery rule was successfully created

Default Accounts
Devices

Schedule Dizcoven . . .
¥ ¥ Bun the netwaork discovery rule after the wizard is closed

Summary

Campletion . ) . . L
" To view progress when a network discovery ule iz running, open the Administration

workspace, expand Metwaork Management, and click Discovery Fules.

LCloze |

21. Wait for the SCOM to make a full discovery.
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5.2 Disabling SNMP Trap Service

In order to view traps from the monitored AudioCodes devices, you must disable the SNMP
Trap service.

» To disable SNMP Trap services

1. Click > Start > Administrative Tools > Services.
2. Ensure that the service SNMP Trap is disabled.
3. Restart the service System Center Management.
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5.3  Setting up the Device to Send SNMP Traps

In order for the device to automatically send SNMP traps to the SCOM server, you must
configure the IP address of the SCOM server as a Trap Destination.

» To send SNMPv3 traps to the SCOM:
1. Openthe SNMP Community String page (SNMP > Community String).
Figure 5-19: SNMP Community String

( SNMP Community String W

Read Only

Read / Write

Read / Write

Read / Write

Read / Write

Read / Write

m

-

# Disable SNMP M. -

Trap Community String public

Trap Manager Host Name SCOM i

N
Submit
2. Ensure that the parameter 'Disable SNMP' is set to default No.
3. Click Submit to apply the changes.
4. Open the SNMP Trap Destinations screen (SNMP > SNMP Trap Destinations).
Figure 5-20: SNMP Trap Destinations

( SNMF Trap Destinations W
IP Address Trap Port Trap User Trap Enable
[ SNMP Manager 1|10.15.25.35 162 Brad - Enable =
| snmp Manager  2(0.0.00 162 v2cParams = Enable =
O/ snmp manager  3/0.0.00 162 v2cParams ~ | Enable ~
| snmp Manager  4[0.000 162 v2cParams = Enable =
v
[ SNMP Manager 5|0.0.0.0 162 v2cParams - Enable « Subimit

5. Inthe IP Address field, type the IP address of the SCOM server to which you wish to
send traps.

6. From the Trap User drop-down list, select the SNMP Trap User that you defined in either
Section 5.1.1 on page 37 or in Section 4.1 on page 25.

7. Click Submit to apply the changes.

8. (Optional): In the SNMP Trusted Manager screen, type the IP address of the SCOM
server to which you wish to send traps.
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Figure 5-21: Trusted Manager IP Address

( SNMF Trusted Managers

Delete Trusted Managers IP Address
|} SNMP Trusted Manager 1 10152535
I} SNMP Trusted Manager 2 0.0.0.0
I} SNMP Trusted Manager 3 0000
|} SNMP Trusted Manager 4 0000
I} SNMP Trusted Manager 5 0.0.00

v

Submit

SNMP Trap Destinations Parameters Description

Parameter

Web: SNMP Manager
[SNMPManagerlsUsed_x]

Web: IP Address
[SNMPManagerTablelP_x]

Trap Port
[SNMPManagerTrapPort_x]

Web: Trap User
[SNMPManagerTrapUser]

Trap Enable
[SNMPManagerTrapSendingEnable_x]

Description

Enables the SNMP Manager to receive traps and checks

the validity of the configured destination (IP address and

port number).

= [O] (check box cleared) = (Default) Disables SNMP
Manager

= [1] (check box selected) = Enables SNMP Manager

Defines the IP address (in dotted-decimal notation, e.g.,
108.10.1.255) of the remote host used as the SNMP
Manager. The device sends SNMP traps to this IP
address.

Defines the port number of the remote SNMP Manager.
The device sends SNMP traps to this port.

The valid value range is 100 to 4000. The default is 162.

Associates a trap user with the trap destination. This
determines the trap format, authentication level, and
encryption level.

= v2cParams (default) = SNMPv2 user community
string

= SNMPv3 user configured in 'Configuring SNMP V3
Users' (see Section 4.1 on page 25)

Activates the sending of traps to the SNMP Manager.
= [O] Disable
= [1] Enable (Default)
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9. Click Submit to apply the changes.

10. Open the Maintenance Actions page (Maintenance tab > Maintenance menu >
Maintenance Actions).

Figure 5-22: Resetting the Device

w Reset Configuration

Burn To FLASH ves [+]
Graceful Option Mo E'

+ LOCK/ UNLOCK

Lock LOCK
Graceful Option Mo El
Gateway Operational State UNLOCKED

+ Sawe Configuration

11. Ensure that the 'Burn to FLASH' field is set to Yes (default).
12. Click the Reset button.
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6 Viewing Gateway Element States

This section describes the GW Elements States. The following topics are described in this
section:

GW Element State View. See Section 6.1 below.

Modules - All Modules State View. See Section 6.2 on page 57.
Modules - System Modules State View. See Section 6.3 on page 58.
Modules — Fan Tray State View. See Section 6.4 on page 59.

Modules — Power Supply State View. See Section 6.5 on page 60.
Trunks/Ports — Digital Trunks State View. See Section 6.6 on page.
Trunks/Ports — Ethernet Ports State View. See Section 6.7 on page 62.

6.1 GW State View

This section describes the GW State View.

» To open the GW State View:

B Inthe AudioCodes Gateway folder, select GW State View; a screen similar to the
following is displayed:

Figure 6-1: GW State View

PR G state Yiew - Audiocodes - Dperations Manager
File Edit View Go Tasks Tools Help

| searchv _ | Byl scope @ .

[-[O]x]

Monitoring <  GW State View (1) » Tasks
=2 windows Computers & A Lookfor: I Find Mow Clear x @ @
2 Agentless Exception Manitorir i i i =
5 A9 P a | Mame | Display Name | Device Version | Device Type [ State Actions  ~
» g Application Monitaring TestDevice TestDevice 6.404,058.005 Product MG 1K

State
J \QZQI Critical

e l{f Start Maintenance |
o] G Alerts Wiews
] GWA Performance Wiew
£F| G State Wiew

4 | Modules

(| AllModules Alert View

EE| il Modules State View

[1s#] Personalize view..

Node Tasks ~

Fan Tray State Wiews

Power Supply State Wiew
22| system Modules State iew
4 | Trunks/Ports
| Al Trunk/Ports Alert iew
Digital Trunks State Wiew
Ethernet Ports State Wiew
» A DataVWarehnise _ILI
4| | 3

Show or Hide Wiews..,

Detail View

Fﬂ Audiocodes SNMP Device properties of TestDevice

Blewy Wiews b
Display TestDevice
TestDevice
Bl Monitoring SNMPONLY

GEMERIC
Product: MG 1K;SW Version: 6.40A.058.005
00-90-8F-13-2E-68

;'jl‘ Authering

% Administration

E?j‘ My Workspace

'=3 Ping

'=j Ping

'=3 Set Device Name
'=3 Show Active Alarmg s
T3 sump Ger

T3 smmp walk

'=: Telnet Console

CF Testcall

|=3 Traceroute

Tasks ~
[Z3 Entity Properties
A4 Health Explorer
Navigation -~
| Alert View

= Diagram View

| [£2] Event View

[ 4

Ready

This screen is described as follows:

e The GW State View window contains all discovered gateways and their current
health state.

e  The Detall View pane at the bottom of the GW State View window contains the
details of each selected gateway, including the Device address and
description.GW State View contains several fields with specific information about
the gateway, including 'State' and 'IP Address'.
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e Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 15.

e You can change the GW State View using the Personalize option — right-click any
column name and select Personalize View or in the Tasks pane, select
Personalize View; the Personalize View window is displayed:

Figure 6-2: Personalize View

F' B
——— . N

Columns to display Sort columns by

IP Address - ’]_p Address -
[] Device Version

[7] DeviceDescription
[] Device Contact
[] Device Location
D Device OID Group items by

|:| Community String -
[] SNMP Versian

] Display Name

] Device Type Then by:
[] Trunks Count

@ Ascending
(7 Descending

|
(Mone)

m

[] channels Count (Mone)

[ Last Reboot Time Then by:
[ Product Type L

[] Device Name (None)
[ Name

] Audiocodes System MaduleClass
[] Audiocodes CPU Madule

[] Audiocodes IPMedia Module

[] Audiocodes IF DigitalModule

[] Audiocodes IFAnalog Madule
[] Audiocodes IFBRIMadule -

’ Reset to Default ][ oK ]l Cancel

e In this window, you can select the fields you wish to view in the GW State View
and sort the data inside the view.

e In addition, you can filter the data displayed in the view using the 'Look For" filter:
Figure 6-3: Look For Filter

m

%Loosznr: Find Mow b
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6.2 Modules — All Modules State View

This section describes the All Modules State View.

» To open the All Modules State View:

B Inthe AudioCodes Gateways folder, select Modules > All Modules State View; a
screen similar to the following is displayed:

Figure 6-4: All Modules State View

R all Modules State View - Audiocodes - Dperations Manager =1 E3
File Edit View Go Tasks Tools Help

Manitoring < All Modules State View (5)

[E] Discovered Inventory a| & Lookfor: Find Now  Clear x

52| Distributed Applications
S Task Status iz

» Tasks
Qe

Audiocodes
() Ethernet Port
Class

Marne ¥ State

Actions

slat 3 Trunk Base
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‘ _ Audiocodes

22| UNDCALinux Computers @ Healthy
22| windows Computers

Agentless Exception Monitoring
e‘A e (&) Healthy TestDevice: achfediantL000CPUMadule at Slot 0 slat
4 Application Monitoring

TestDevice: PowerSupply Module at Slot 1 Slat 1

& Start Maintenan
‘!_;_"‘ Critical TestDevice: achediantl000IFDigitalModule at Slot 0 Slot 0 "@' Critical

: () Healthy WM4K. 10.30.52.31: PowerSupply Module at Slot 1 Slat 1
4 |5 Audiocodes Gateways I Personalize view
] Gw Alerts View (&) Healthy WM4K. 10.30.52.31: PowerSupply Module at Slot 1 Slat 1
5] GW Performance View
il CHiaietien [ Entity Properties
4 5 Modules

Tasks ~

=] Al Modules Alert View @l Health Bxplorer

5| Al Modules State View CotEED &

&¢| Fan Tray State view .

=] Power Supply State View

=] System Modules State View
4 | Trunks/Ports

| Al Trunk/Ports Alert View ] Nework viciity

5| Digital Trunks State View 59 pertormance Vi

&¢| Ethernet Ports State View

<] Diagram view

2] Event View

£ State view
7 Data Warehouse
A Microsoft Audit Collection Services
A Microsoft Windous Client
A Microsoft Windows Server
A Network Monitoring
7 Operations Manager
A Synthetic Transaction
A UNDX/Linux Computers
4 Web ApplicationTransaction Monitaring
1 Windows Service And Process Monitoring | Detail View

Show or Hide Views... i i |-
[ Audiocodes Module Base Class properties of TestDevice: PowerSupply Module at Slot 1
New View b
Display Name TestDevice: PowerSupply Module at Slot 1
. Full Fath Name TestDevice: PowerSupply Module at Slot 1
.‘ b bt ey IP Address 195.189.192.249
. . slot Slot 1
_# Autharing Index 2

2 .. . Key OID 1.3614.1.50039.10.104.23.13.2
% Administration

B My Workspace

|
Ready

This screen is described as follows:

e All Modules State View contains all modules of all discovered gateways as they
are hosted on the real devices. The data represented in this view can be
personalized as described in Section 6.1 on page 55.

e  Select a module to load the Detail View pane at the bottom of the All Modules
State View window.

e Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 15.

Note: Performance view is not supported at this monitoring level.
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6.3

Modules — System Modules State View

This section describes the System Modules State View.

» To open the System Modules State View:

In the AudioCodes Gateways folder, select Modules > System Modules State View;

a screen similar to the following is displayed:

Figure 6-5: System Modules State View

BA System Modules State Yiew - Audiocodes - Operations Manager [_[O[x]
Fle Edit View Go Tasks Tools Help
Monitoring € System Modules State View (10} » Tasks
[ Discovered Tnventory | & Lookfor: FindNow  Clear x @ @
2% Distributed Applications _ Audiocodes T
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> [ Agentiess Exception Monitor e - -
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(@) Healthy MIK-10.30.52.5 acMediantl000CFUmOodule 3t Slot 967 Unknavm: -1 Slot 367
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=] Fan Tray State View
- | Alert View
£!] Power Supply State View
£2£] System Modules State View <! Diagram View
4 [ Trunks/Ports L] Event View
|| Al Trunk/Ports Alert View [F%] Network vicinity
=] Digital Trunks State View 59 performance Vie
=] Ethernet Ports State View ) state vi
2] State view
> [ Data Warehouse
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> [ Microsott Windows Client
> [ Microsoft Windows Server
» L4 Network Monitoring
+ [ Operations Manager
> [ Synthetic Transaction
> [ UND(/Linux Computers
> [’ Web ApplicationTransaction Monitoring 4] | |
> [ Windows Service And Process Monitoring <] Detail View -
Show or Hide Views... =
B Audiocodes system Module Class properties of TestDevice: acMediant1000IFDigitalModule at Slot 0
New View »
Display Name TestDevice: acMediant1000IFDigitalModule at Slot 0
o Full Path Name TestDevicel] ice: acMediant: igi atSlot 0
B Monitoring IP Address 195.189.192.249
p ) slot Slot 0
A Authoring Index 67367393
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Geographical Position 0
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= License Key List 2
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This screen is described as follows:

System Modules State View contains all system modules of all discovered
gateways as they are hosted on the real devices. The data displayed in this view
can be personalized as described in Section 6.1 on page 55.

Select a module to load the Detail View pane at the bottom of the System
Modules State View window.

Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 15.

Note: Performance view is not supported at this monitoring level.
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6.4 Modules — Fan Tray State View

This section describes the Fan Tray State View.

» To open the Fan Tray State View:

B Inthe AudioCodes Gateways folder, select Modules > Fan Tray State View; a screen
similar to the following is displayed:

Figure 6-6: Fan Tray State View

|
TR Fan Tray State View - Audiocodes - Dperations Manager

[_[O[x]
Fle Edit View Go Tasks Tools Help
Monitoring ¢ Fan Tray State View > Tasks
] Discovered Inventory ~| QLookfor: Find Now  Clear x @ @
#2| Distributed Applicato
JJ istributed Applicatiors State 5 | Mame | State ~
3 Task Status () Healthy 10,10.50.3Fan,..  10.10.50.3 Actions
£T] UNDX/Linux Computers ) Healthy 10.10.50.2Fan...  10.10.50.2
iif] windovis Compters () Healthy 10.10.50.4Fan...  10.10.50.4
» [ Agentless Exception Monitaring @) Healthy FarTray 195.189. 192.240

> ('3 Application Monitaring
4 |5 Audiocodes Gateways [Tl Personaiize vien
=] GW Alerts View
3] GW Performance View
5 GW State View
4 [ Modules
|| All Modules Alert View
25] All Modules State View
E22 Fan Tray State View
E22| Power Supply State View
25| System Modules State View
4[5 Trunks/Ports
(=] Al Trunk/Ports Alert View
&%) Digital Trunks State View
E22| Ethernet Ports State View
» |4 DataWarehouse
> [ Microsoft Audit Collection Servicss
> ('3 Microsoft Windows Cliert
> [ Microsoft Windows Server
> [’ Network Monitoring
» (4 Operations Manager
> [ Synthetic Transaction
> [ UNDG/Linux Computers
> [ Web Application Transaction Monitorirg
> "4 Windovs Service And Pracess Monitoring ~—| Detail View

Show or Hide Views..

1 ) Select anitem inthe view aboveto display its details.
New View » 'Y

Bl Monitoring
/A Authoring
% Administration

T myWorkspace

Ready

This screen is described as follows:

e Fan Tray State View contains all fan trays of all discovered GWs as they are
hosted on the real devices. The data represented in the view can be personalized
as described in Section 6.1 on page 55.

e  Select a module to load the Detail View pane at the bottom of the Fan Tray State
View window.

e Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 15.

Note: Performance view is not supported at this monitoring level.
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6.5 Modules — Power Supply State View

This section describes the Power Supply State View.

» To open the Power Supply State View:

In the AudioCodes Gateways folder, select Modules > Power Supply State View; a
screen similar to the following is displayed:

PR Power Supply State Yiew - Audiocodes - Dperations Manager
Fle Edit View Go Tasks Tools Help

Figure 6-7: Power Supply State View
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Ready P

¢ Power Supply State View (8)

| & Lookfor:
State
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Find Now

| Mame:
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144K-10.30.52.32: PowerSupply Module at Slot 1
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M1K-10,30.52.5; PowerSupply Module at Slot 1
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M1K-10,30.52.1: PowerSupply Module at Slot 1

Clear

5 | Slat
Slot 1

Slot 1
Slot 1
Slot 1
Slot 1
Slot 1
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* Tasks
x @ @

State
Actions

A Start Maintenan
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Tasks ~
[Z] Entity Propertie:
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Navigation 4
| Alert View

<] Diagram View
t2| Event View
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This screen is described as follows:

Power Supply State View contains all power supply modules of all discovered
GWs as they are hosted on the real devices. The data represented in the view
can be personalized as described in Section 6.1 on page 55.

Select a module to load the Detail View pane at the bottom of the Power Supply
State View window.

Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 15.

Note: Performance view is not supported at this monitoring level.
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6.6  Trunks/Ports — Digital Trunks State View

This section describes the Trunks/Ports — Digital Trunks State View.

» To open the Trunks/Ports — Digital Trunks State View:

R Digital Trunks State ¥iew - Audiocodes - Operations Manager

Fle Edit View Go Tasks Tools Help

Searchw _ | B Scope

In the AudioCodes Gateways folder, select Trunk/Ports > Digital Trunks State View;
a screen similar to the following is displayed:

Figure 6-8: Digital Trunks State View
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Show or Hide Views..
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Tasks ~
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Navigation
] Mert view
<] Diagram View
+2] Event View
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54| performance Vie
2| state view
5| Detail View v
B Audiocodes Digital Trunk Class properties of TestDevice: acMediant1000IF DigitalModule at Slot 0: Digital Trunk #2
Display Name TestDevice: acMediant1000IFDigitalkodule at Slot 0: Digital Trunk #2
Full Path Name TestDevice\TestDevice: acMediantl000IFDigitalMadule 3t Slot 0\TestDevice: acMediant10001FDigitalModule at Slot 0: Digital
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Index 1
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A

This screen is described as follows:

Digital Trunks State View contains all digital trunks of all discovered gateways as
they are hosted on the real devices. The data represented in the view can be
personalized as described in Section 6.1 on page 55.

Select a module to load the Detail View pane at the bottom of the Digital Trunks
State View window.

Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 15.
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6.7 Trunks/Ports — Ethernet Ports State View

This section describes the Trunks/Ports — Ethernet Ports State View.

» To open the Trunks/Ports — Ethernet Ports State View:

B Inthe AudioCodes Gateways folder, select Trunk/Ports > Ethernet Ports State
View; a screen similar to the following is displayed:

Figure 6-9: Ethernet Ports State View
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Show or Hide Views..
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New View » =~
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This screen is described as follows:

e Ethernet Ports State View contains all Ethernet ports of all discovered gateways
as they are hosted on the real devices. The data displayed in this view can be
personalized as described in Section 6.1 on page 55.

e  Select a module to load the Detail View pane at the bottom of the Ethernet
PortsState View window.

e  Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 15.
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6.8 Diagram View

The Diagram View displays the Gateways' modules in a diagram view. Right-clicking the
element in the diagram opens several additional options, such as opening element-related
views and element-related properties.

» To open the Diagram view:

1. Inthe Monitoring pane, select GW State View, and then select the desired entry.
2. In the Tasks pane, under Navigation, select Diagram View; a screen similar to the

following is displayed:

Figure 6-10: Diagram View
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6.9 Running Tasks

This section describes how to perform various tasks.

6.9.1 Pinging AudioCodes Device

This task describes how to execute the ping operation on the device.

» To execute the ping operation:

1. Openthe GW State View (see Section 6.1 on page 55) and select the required gateway.
2. Do one of the following:

a. Inthe Node Tasks pane, left-click the Ping task.
Figure 6-11: Node Tasks Pane
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Fle Edit View Go Tasks Tooks Help
T sewchv _ | Bjiscome o .
Monitoring < GW State View (3) > Tasks
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S
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2| Digital Trunks State Wiew

| Ethernet Ports State View = Node Tasks -~
Show or Hide iews... 03 ping
aicea Detail View M=
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-

Model

J E Traceroute -
-

Ready

OR
b. Inthe Main Menu, choose Tasks > Node Tasks > Ping.
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Figure 6-12: Tasks Menu
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The Ping Run Task window is displayed:

Figure 6-13: Run Task-Ping

| Run Locay_on

Task Parameters

Mame | Value |
Usemame Admin

PinglP' 127.0.01

Password Admin

Overide |

Task credentials Task description

¢ Uze the predefined Flun As Account

" Other:
User name : |
Pazsword : I
Daomain : |SCOM-PROJECT

Task confirmation

[~ Don't prompt when inning this task in the future

Bun Cancel |
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Task confirmation of the task configuration window (see Figure 6-13), the next time the

f Note: If you check the checkbox 'Don't prompt when running this task in the future' in the
Ping task is run immediately without the ability to change the task configuration.

4. (Optional) Override the Username and/or Password for the Telnet connection:

a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.

b. Setthe new values for Username and/or Password and Device Name.

c. Click the Override button.

5. In the Run Task window, click the Run button; the Task Status — Ping window is

displayed:
Figure 6-14: Task Status-Ping
@_ Task Status - Ping =] 3
The kask completed successhully. @ Help
Task, | Skatus | Task Target |
@Ping Success 00
Task Cukput EE] Copy Texk 53 Copy HTML
Fs
@ Ping Task Description T
Skatus: Success
acheduled 12/14/2011 2:36:59 PM
Tirme:
Start Time: 12114/2011 2:37:02 PM
. _ SooM-

Submitted BY: oo S T Administratar

Run As:

Fun Location:

Targek:

Target Type:  Audiocodes SMMP Device o

Cateqgary: Zuskam
Task Output:
 Qubpot ]
ping 10.10.70_72 -
‘ou can close this dialog at any time, Doing so will nok inkerrupt executing tasks, You can

check the skatus of tasks in a task status view.,
Close |

4

This window contains the Task execution status and output details.
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6.9.2 Displaying Active Alarms

This task describes how to display the active alarms in the 'acActiveAlrmTable' table.

» To display the list of active alarms:
1. Openthe GW State View (see Section 6.1 on page 55) and select the required gateway.
2. Do one of the following:
a. Inthe Node Tasks pane, left-click the Show Active Alarms task.
OR
b. Inthe Main Menu, choose Tasks > Node Tasks > Show Active Alarms.
The Show Active Alarms Run Task window is displayed:

Figure 6-15: Run Task-Show Active Alarms

FIEEEETT

@ Help

Run the task on these targets

Target Run Location
10.10.50.2

Task Parameters

Name Value

Usemame Admin
Password Admin

Task credentials Task description
@) Use the predefined Run As Account
(©) Other :
User name :
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Domain : GSTEPS

Task confirmation

[] Den't prompt when running this task in the future

[ Bun ] [ Cancel
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Note: If you check the checkbox 'Don't prompt when running this task in the future' in the
Task confirmation of the task configuration window (see Section Figure 6-15), the next
time the 'Show Active Alarms' task is run immediately without you being able to change

the task configuration.

3. (Optional) Override the Username and/or Password for the Telnet connection:

a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.

b. Setthe new values for Username and/or Password.

c. Click the Override button.

4. In the Run Task window, click the Run button; the Task Status — Show Active Alarms
window is displayed:

Figure 6-16: Task Status-Show Active Alarms

-
The task completed successfully. @ Help
Task Status Task Target
@) show Active Alarms Success test
Task Output 152 Copy Text 53 Copy HTML

~ -

© Show Active Alarms Task Description

Status: Success

Scheduled Time: 02112010 10:03:04

Start Time: 02112010 10:03:06

Submitted By: GSTEPS\eduardg

Run As:

Run Location:

Target:

Target Type: Audiocodes SMMP Device

Category: Operations

Task Output:
The sccket is not connected.

I ——
NHone
Exit Code: 0

You can closethis dialog at any time. Doing so will not interrupt executing tasks. You can check the status of tasks in atask status view.

Close

This window contains the Task execution status and output details.
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6.9.3  Setting Device Display Name
This task describes how to change the device Display Name in the GW State View table.

» To change the device Display Name:
1. Openthe GW State View (see Section 6.1 on page 55) and select the required gateway.
2. Do one of the following:

a. Inthe Node Tasks pane, left-click the Set Device Name task.
OR

b. Inthe Main Menu, choose Tasks > Node Tasks > Set Device Name.
The Set Device Name Run Task window is displayed:

Figure 6-17: Set Device Name

71, Run Task - Set Device Marme @

@ Help

Run the task on these targets

Target Fiun Location
1010802

Task Parameters

Mame Walue
DeviceM ame Device Mame
CommunityString private

Task credentials Task description

@ Use the predefined Run Az Account
) Other :

User name :

Pazsword :

Damain : GSTEPS

Task confirmation

[ Dan't prompt when wnning this task in the future

Run ] I Cancel

Task confirmation of the task configuration window (see Section Figure 6-15), the next
time the 'Show Active Alarms' task is run immediately without you being able to change

j Note: If you check the checkbox 'Don't prompt when running this task in the future' in the
the task configuration.

Version 1.0.5.65 69 AudioCodes SCOM Management Pack



QC oudiocodes

AudioCodes SCOM Management Pack

3. (Optional) Override the DeviceName and/or CommunityString:

a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.

b. Setthe new values for DeviceName and/or CommunityString.

c. Click the Override button.

4. In the Run Task window, click the Run button; the Task Status — Set Device Name
window is displayed:

Figure 6-18: Task Status-Set Device Name

_‘?QJTask Skatus - Set Dewice Name EI@
The task completed successfully, @ Help
Task Status Task Target
10.10.50.2
4| 1l | »
Task Output 3 Copy Text =2 Copy HTML
) -
@ Set Device Mame Task Description i
Status: Success
Scheduled Time:  12/12/2010 17:14:41
Start Time: 12/12/2010 17:14:44
Submitted By: GSTEPS\eduardg L
Run As: r
Run Location:
Target:
Targst Type: Audiocodes SHMP Device
Category: Custom i
Task Output:
| otpot |
Hone

Yol can close this dislog at any time. Doing so will not interrupt executing tasks, You can

check the status of tasks in a bask status view,

This window contains the Task execution status and output details.
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6.9.4 Testing Call from Gateway

This task describes how to execute the test call from the gateway.

» To test acall from the gateway:
1. Openthe GW State View (see Section 6.1 on page 55) and select the required gateway.
2. Do one of the following:

a. Inthe Node Tasks pane, left-click the Test Call task.
OR
b. Inthe Main Menu, choose Tasks > Node Tasks > Test Call.

The Test Call Run Task window is displayed:

Figure 6-19: Run Task — Test Call

" ron o T, e

'@ Help

Run the task on these targets

Tanget Run Location
10.10.50.4

Task Parameters

Name Walue
Usemame Admin
Password Admin
DTMFs 1234
DestinationPhoneNumber 587654321

Task credentials Task description
@ Use the predefined Run As Account
() Other :
User name :

Password :

Domain : GSTEPS

Task confirmation

[] Den't prompt when running this task in the future
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Note: If you check the checkbox "Don't prompt when running this task in the future" in
Task confirmation of the task configuration window (see Figure 6-20 below), the next time
you run the 'Test Call' task, it is run immediately without you being able to change the

task configuration.

3. (Optional) Override the Username and/or Password for the Telnet connection:
a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.
b. Setthe new values for the Username and/or Password.
c. Click the Override button.

A Note: Do not override the DTMFs and Destination PhoneNumber parameters.

4. In the Run Task window, click the Run button; the Task Status — Test Call window is
displayed:

Figure 6-20: Task Status-Test Call

T N
SETTEETIS. T ek
Thetask completed successfully. @ Help
Task Status Task Target
&) Test Call Sucoess test
Task Output 152 Copy Text 53 Copy HTML
) -
@ Test Call Task Description
Status: Success
Scheduled Time: 02112010 10:04:30
Start Time: 02112010 10:04:33
Submitted By: GSTEPS\eduardg
Run As:
Run Location:
Target:
Target Type: Audiocodes SNMP Device
Category: Operations
Task Output:
S
The socket is not connected.
I ——
None
Exit Code: 0

You can closethis dialog at any time. Doing so will not interrupt executing tasks. You can check the status of tasks in atask status view.

Close

This window contains the Task execution status and output details.
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2

7.1

A\

7.2

Monitoring Gateway Element Health

Once a gateway is discovered, SCOM starts monitoring the gateway to determine its health
state. Monitoring is performed for each discovered 'Gateway', '"Module' and 'Trunk' (together
referred to as gateway elements).

Monitoring Types

The SCOM server collects data from the gateways using the following methods:
B Queries send from the SCOM to the gateway:

e Object-based monitoring is the polling of a specific SNMP object value change
i.e., the acSysModuleOperationalState module-related object is changed. For
example, there is a power supply failure for a gateway power supply module.

e Threshold-based monitoring is an alert issued when a threshold defined for a
performance counter is exceeded. This type of alert is applicable for gateways
and trunks. Each performance counter has two types of thresholds 'High' and
'‘Low'. Each threshold type has two levels: 'Warning' and 'Critical'. Consequently,
the final severity of threshold-based alert depends upon which level of threshold
has been exceeded. Thresholds levels are described in Section 7.5 on page 82.

B Traps send from the gateway to the SCOM:

e Trap-based monitoring is an alert issued as a result of a trap that was captured
from an entire Gateway entity (Gateway, Module or Trunk).

Notes:
e Trap-based monitoring is not automatic. To enable this monitoring, you must
configure the SCOM server as the trap destination. See Section 5.2 on page 50.

e For a full list of all SNMP traps supported by the SCOM, see Appendix A on page
109.

Aggregated Health State

The final Health state of any entity is the aggregation of an entity-related alert and the Health
states of its sub-elements (the Health state propagated from child element to the parent
element).

Rollup Policy is used to determine this final health state of an entity. There are two types of
Rollup policies used for the gateway health state definition:

B Best State rollup policy defines the state of an entity as healthy in the event where at
least one of its sub-elements is healthy, i.e. if a gateway contains several modules and
at least one of the modules is healthy, then the overall state of the gateway is
determined as 'Healthy".

B Worst State rollup policy defines the state of an entity according to the worst severity
of any if its sub-elements, i.e. if a gateway contains several modules, where one of the
modules is healthy, another module has the 'Warning' state and another is 'Critical’,
then the overall health state of the gateway is determined as 'Critical’.

i:f Note: Rollup Policy is not applicable for threshold-based alerts. For information on

Configuring Threshold levels, see Section 7.7 on page 84.
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7.2.1 Aggregated Health State-Gateway

The Aggregated health state of the gateway depends on the Fan Tray and Power Supply
modules health together with the health states of all system modules residing on the gateway
and is calculated according to the following rules:

B Worst state Rollup policy - It is sufficient for the Fan Tray or Power Supply module to
indicate 'Critical’ for the corresponding gateway to indicate 'Critical’.

Dependence Rollup 'Worst State' policy is applicable for all corresponding
Trunks/Ports residing on gateway modules.

B Best state Rollup policy - It is sufficient for a single system module to indicate
'Healthy' for the corresponding gateway to indicate 'Healthy'.

Table 7-1: Health Indication

SNMP Object Health State Indication
Green The object is healthy.
Grey The gateway exists in the list of network devices

(Administration > Network Devices), it was successfully
discovered at least once; however, is not responding to the
monitors' requests.

7.3  SNMP-SCOM Object Severity Mapping

7.3.1 Gateway

The table below describes the translation of the gateway element health states to the
corresponding SCOM health states.

Table 7-2: SNMP Gateway Objects Health State

SNMP Object Health State SCOM Object Health State
noAlarm(0) Healthy
intermediate(1) Warning
minor(3) Warning
major(4) Critical
critical(5) Critical
7.3.2 Module

The table below describes the translation of the module element health states to the
corresponding SCOM health states.

Table 7-3: SNMP Gateway Modules Objects Health State

SNMP Object Module SNMP Object Health State SCOM Health State
acSysModuleOperationalState | enable(2) Healthy
(System module) disable(1) Critical
acSysPowerSupplySeverity Cleared(1) Healthy
(Power Supply module) Indeterminate(2) Warning
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SNMP Object Module SNMP Object Health State SCOM Health State
minor(4) Warning
Major(5) Critical
Critical(6) Critical

7.3.3 Digital Trunks

The table below describes the translation of the digital trunk element health state to the
corresponding health state in the SCOM.

Table 7-4: Digital Trunk SNMP Polling

SNMP Object SNMP Object Health State SCOM Health State Indicator
acTrunkStatusAlarm greenActive (1) Healthy
Other values Critical

The monitor 'AudioCodes Digital Trunk Alarm' queries SNMP Object "Alarm" from table with
OID 1.3.6.1.4.1.5003.9.10.9.2.1.1.1.1.

7.34 SNMP Traps

The table below describes the SNMP traps which cause the gateway module to indicate the
Unhealthy state in the SCOM.

Table 7-5: Unhealthy State

Gateway Module Trap SCOM Unhealthy State
System modules acHwFailureAlarm Warning or Critical
Power Supply module acPowerSupplyAlarm Warning or Critical
Fan Tray module acFanTrayAlarm Warning or Critical
analog trunk module acAnalogPortHighTemperature Critical

acAnalogPortSPIOutOfService

Digital Trunk module acTrunksAlarmNearEndLOS Critical
acTrunksAlarmNearEndLOF
acTrunksAlarmRcvAIS
acTrunksAlarmFarEndLOF

Ethernet ports module acBoardEthernetLinkAlarm Critical

For more information on the traps described in the table below, see Appendix A on page 109.
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7.4  Alert Monitoring

The SCOM Management Pack includes the following active alerts views:
B GW Alerts View. See Section 7.4.1 on page 76.

B All Modules Alerts View. See Section 7.4.2 on page 80.

B All Trunks/Ports Alerts View. See Section 7.4.3 on page 81.

741 GW Alerts View

GW Alerts View shows the entire gateway-related alerts (alerts related to the gateway and
all hosted entities).
» To view gateway alerts:

1. Select the Monitoring pane, and then open the AudioCodes Gateways folder.
2. Select the GW Alerts View; a screen similar to the following is displayed:

Figure 7-1: GW Alerts View

Man&oring * GW Alerts View (17)
Al Aokt [ Frdbew  Oex b
o bon | Path Sourtn #) hve. Roukiion Sate  Corated g [
S Weg)
1 Hetwark Device i hat Rtspondng Hew ALRI0LD LLTSE A 27 Dy, T Mowrs
1 Audicodes GW acBourd ComfgurationEsror ManRos Alert Mew LS 11507 P 2Dy, 5 Mo,
# Severity: Ciilical (F5H
& Mew EERLSHETEVE I
& Mew
& omegnes + Powriuppl MSSule it 510t 3 e
- Mew
o Hew
L] Hew
O oemeeraer Powsriupply WSdule ot St 2 Hew assanm
@ Prw AN 5301 M
@ oumarIesoR +Penwmriuppy Wsule ot flot 3 Hew JINTE AT I
- Hew LA LA
@ Hew
o Mew.
& Hew
& Hew
5] New TN S50 P
(|
e i Mlert Detalls -
;I—ILIJ
A —— i) select an eminithe vem sbave to tspiay s detals.
Fotw View »
3. Select a specific Alert; the Alert Details are loaded:
Figure 7-2: Gateway Module Alert Details
1] | |
= Alert Details =
1. Audiocodes GW sdioaralontigurationLiror Monitor Al At Description |
Audiciudes GW acvardCorfiguralionEror Muriter
Knuwhedge 3 View sdutivnal nowiesge.,

- Horinwiespe
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4. Click onthe View additional knowledge Link to view additional information on the alert.
The Alert Properties are displayed:

Alert Properties Ei

General |Product Knowledge I Compary Knowledge I Histary I Alert Conbext I Zustom Fields I

Ll Audiocodes G'W acB oardConfigurationE rror Monstor Alert

Key Details:

alert source:
Sewerity:
Priarity:

Age:

Cwnet:

Ticket 10t

Alert Description:

Figure 7-3: Alert Properties

ol
Warning
Medium

8 Days, 5 Hours, 4 Minutes

Alert Status:

Once you hawve identified the problem and taken corrective action, wou can select 'Closed' which will remowe the alert From

the swstem once changes are committed,

Mew

=

Change. .. |

[

it Previous 4 MNexk

QK I Cancel | Apply

Additional Information may be displayed in the Alert Description pane.
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5. To view SNMP detailed information, select the Alert Context tab; the SNMP details for
the alert are displayed:

Figure 7-4: Alert Properties-SNMP Information
"General I Product Knowledge I Company Knowledge I History  Alert Context ICustDm Fields I

Source 10.15.21.15
Destination 127.0.0.1

Version 2
ErrorCode SuCCcess

Dbject Identifier Syntax |Value

.1.3.6.1.2.1.1.3.0 Timeticks| 52094533

.1.3.6.1.6.3.1.1.4.1.0 Oid .1.3.6.1.4,1.5003.9.10.1.21.2.0.2
.1.3.6.1.4.1.5003.9.10.1.21.1.1.0 [Integer |1

PSTNCheckClockMaster: Clock might be un-stable - Trunk 0 is set as
acCLOCK,_MASTER_OFF while TDMBusClockSource is Internal. [Tru

.1.3.6.1.4.1.5003.9.10.1.21.1.3.0 [Octets |Board#1
.1.3.6.1.4.1.5003.9.10.1.21.1.4.0 (Integer |1
.1.3.6.1.4.1.5003.9.10.1.21.1.5.0 |Integer |4
.1.3.6.1.4.1.5003.9.10.1.21.1.6.0 [Integer |4
.1.3.6.1.4.1.5003.9.10.1.21.1.7.0 |Integer |56
.1.3.6.1.4.1.5003.9.10.1.21.1.8.0 |Octets
.1.3.6.1.4.1.5003.9.10.1.21.1.9.0 |Octets
.1.3.6.1.4.1.5003.9.10.1.21.1.10.0|Octets
.1.3.6.1.4.1.5003.9.10.1.21. 1. 11.0{Octets | -Oe07-0xDD-0x 0B-0 1 4-0oe0D-Che OF-0oe 0500 00

.1.3.6.1.4.1.5003.9.10.1.21.1.2.0 |Octets

=

4 Previous ¥ Mext [0]4 I Cancel | Apply

5

6. If you wish to configure the Alert Monitor, in the Alert Details screen, click the Alert
Monitor, for example, click the Audiocodes GW acBoardConfigurationError Monitor
link as shown in the figure below.

Figure 7-5: Gateway Monitor Alert Details

| ]
& Alert Details

R

fi Audisoecs G achioantCentiguistioat mas Monitor Alert Aot Bescripton

Knrmlerdge: B Wiew sdditionsl ngwicdge

R
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The gateway alert monitor properties are displayed:

Figure 7-6: Gateway Alert Monitor Properties

. Audiocodes GW acBoardConfigurationError Monitor Properties

General | Healthl Alerting | Diagnoztic and Hecnvery' Cunfiguratinnl Product Fnowledge Dverridesl

General properties

Specify the name and description for the monitor you are creating.

WENTTR

I!-'l'«udiu:ucndes G acBoardConfigurationE rar konitor

Dezcription [optional):

M anagement pack: Audiocodes YW Management Pack

b aritar target:

Audiocodes SMMP Device Select... |

Parent manitar:
I Configuration j

¥ Manitor is enabled

(1] 8 I Cancel Apply |

4

7. Select the Overrides tab to override the monitor. For more information, see Chapter 8
on page 91.
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7.4.2 All Modules Alerts View

All Modules Alerts View shows the module-related alerts (alerts at the module level).
» To view alerts for all modules:

1. Select the Monitoring pane, and then open the AudioCodes Gateways folder.
2. Select the All Modules Alerts View; a screen similar to the following is displayed:

Figure 7-7: All Modules Alert View
R all Modules Alert Yiew - Audiocodes - Operations Manager

JS[=] B3
Fle Edit View Go Tasks Tools Help

| Searchv _ | Oyemdes¥ _ § By Scope @ .

Monitoring

€ All Modules Alert View (5)
=] Discovered Tnventory Al Quookfor [ FindNow  Clear
2% Distributed Applications
S Task Status
[822] UND/Linux Computers
82| Windows Computers
> [ Agentless Exception Monitoring

* Tasks

x @ @
| Hame Resolution State | Created [ mlert
4 Severity: Critical (5) Actions
)

 Tean | sawce

M1k-10.30.52.1 acMediant1000IFDigitalModule at 51, Audiocodes Digital Trunk Alarm Manitor Alert  New 01/02/2013 15:08:00

Mew 01/02/2013 15:07:37
Mew 01/02/2013 15:07:37
Mew 01/02/2013 15:07:36
Audiocodes Digital Trunk Alarm Monitor Alert New 01/02/2013 14:55:00

M1k-10,30.52.5: acMediant1000IFDigitalModule at Sl Audiocodes Digital Trunk Alarm Manitor Alert

> | Application Monitoring M1k-10.30.52.4; acMediant1000IFDigitalModule at 51, Audiocodes Digital Trunk Alarm Manitor Alert

4 | Audiocodes Gatevays
5] GW Alerts View ]
34 GW Performance View
&%| G state view

4 5 Modules

M1k-10.30.52.3: acMediant1000IFDigitalModule at 51, Audiocodes Digital Trunk Alarm Manitor Alert

3
TestDevice: acMediant1000IFDigitalMadule at Slot 0: ...

- e e e o

[T Personalize view

Subscriptio
n
| AllModules Alert View

=] Al Modules State View
=] Fan Tray State View
=] Powrer Supply State View
&| system Modules State View
4 [ Trunks/Ports

|| Al Trunk/Ports Alert View
22| Digital Trunks State View
=] Ethernet Ports State View

> [ Data Warehouse

PN

> [ Microsoft Audit Collection Serviess
> g Microsoft Windows Client

» |4 Microsoft Windows Server

» [ Network Monitoring

> [ Operations Manager

> [ Synthetic Transaction

> [ UNDO/Linux Computers

» [ Web Application Transaction Monitoring 4 | I
> g Windows Service And Process Monitoring =| Alert Details

Show or Hide Views..

i) Selectanitem inthe view aboveto display its details.
New View » Y

Bl Monitoring
/A Authoring
% Administration

[T my workspace

Ready

3. Select a specific Alert; the Alert Details are loaded.

Figure 7-8: Power Module Alert Details

| Alert Details

& Aumiacndes Power Supply Seventy Moniing Alert Alert Desmiptian

o

Knowiedar:

4. Click the View additional knowledge link to view additional details on the alert.

5. If you wish to configure the Alert Monitor, in the Alert Details screen, click the Alert

Monitor, for example, click the Audiocodes Power Supply Severity Monitor link as
shown in the figure above.

Select the Overrides tab to override the monitor. For more information, see Chapter 8
on page 91.
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7.4.3

All Trunks/Ports Alerts View

All Trunks/Ports Alerts View shows the trunk/port-related alerts (alerts on trunk/port level).

» To view alerts for all trunks/ports:

1. Select the Monitoring pane, and then open the AudioCodes Gateways folder.

2. Select the All Trunk/Ports View; a screen similar to the following is displayed:

Figure 7-9: All Trunk/Ports View

Fle Edit Miew Go Tasks Tools Help

i searchv _
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Actions
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3. Select a specific Alert; the Alert Details are loaded.
Figure 7-10: All Trunk/Ports Alert Details

Alert Deebails

& Asdiccndes Dig

Knuwhedge:

View acditionsl kr

4. Click the View additional knowledge link to view additional details on the alert.

5. If you wish to configure the Alert Monitor, in the Alert Details screen, click the Alert
Monitor, for example, click the Audiocodes Digital Trunk Alarm Monitor link as shown
in the figure above.

6. Select the Overrides tab to override the monitor. For more information, see Chapter 8
on page 91.
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7.5 Performance Monitoring

The AudioCodes device enables performance monitoring in the form of ‘counters' for
gateway and trunk modules. For example, for a gateway module, AudioCodes' Mediant 4000
device's 'Attempted Calls IP2Tel' counter polls the number of attempted IP to Tel calls during
the last interval. For a trunk module, the AudioCodes Digital Trunk Available Channels
counter polls the number of available in-service trunks for a specific trunk group. In the
SCOM, the PM counter is represented by a rule (see Section 7.6 on page 83).

Counters always increase in value and are cumulative. Counters, unlike gauges, never
decrease in value unless the server is reset, and then the counters are reset to zero.

Additionally, each counter rule is represented by a pair of threshold monitors (a high
threshold monitor and a low threshold monitor). For example, the 'Attempted Calls IP2Tel'
PM is represented in the SCOM by the 'AudioCodes Attempted Calls IP2Tel High Threshold
Monitor" and 'AudioCodes Attempted Calls IP2Tel Low Threshold Monitor'. For more
information, see Section 7.7 on page 84.

For details on the performance monitoring counters that are supported by the AudioCodes
Management Pack, see Section B on page 169.

7.5.1 Performance View
This section describes the performance view.
» To open the Performance View,

B In the Monitoring pane, select GW Performance View.

Figure 7-11: GW Performance View
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Note:

e The 'Object’ field displays the IP Group index, on IP Group counters, and the SRD
name on SRD counters.

e |IP Group name is not displayed in the SCOM.
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e Right-clicking the graph opens the Personalize View and other options which
allow you to customize the graph.

e  The GW Performance View allows you to view gateway performance counters
behavior. In the Legend window, you can select one or more counters to view
them on the graph. Each counter on the graph has its own color. Using the 'Look
for:' filter, you can limit the Legend to show only the counters on the graph (Items
in the Chart) or only the counters which are not shown on the graph (Items not in
the Chart) or specific counters (ltems by text search). By default, all counters are
available for selection in the Legend window (All Items).

e The GW Performance View provides updated information on most counters every
15 minutes. Counters for Channels provide updated information per minute. A
graph can be refreshed manually (F5) or automatically.

7.6  Rules Monitoring

Rules are used in the SCOM for managing the AudioCodes SIP Performance Monitoring
counters and for managing the Trunk Service Information.

Figure 7-12: Rules Monitoring
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7.6.1 SIP Performance Monitoring Counters

SIP PM counters rules poll data from the AudioCodes devices by default every 15 minutes.
The AudioCodes Management Pack includes a corresponding rule for each supported PM.
For example, "Attempted Calls IP2Tel Counter Rules".

For a full list of PM counters supported by the SCOM, see Appendix B on page 169.

7.6.2 Trunk Service Information

Trunk Service counters (Trunk Performance Statistics) monitor the Channels states (channel
in-service and channel out-of-service). The counters 'AudioCodes Digital Trunk Available
Channels Counter Rule' and the 'AudioCodes Digital Trunk Blocked Channels Counter Rule'
poll the trunk channel information.
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7.7

A\

Normal
Normal
Warning
Warning
Critical

Critical

A\

Threshold Monitoring

This section describes how to configure the threshold values for the device PM counters. For
each supported PM counter rule there is a pair of threshold monitors; a high level threshold
monitor and a low level threshold monitor. For example, for the IP2Tel Counter rule there is
the corresponding pair "AudioCodes Attempted Calls IP2Tel High Threshold Monitor" and
"AudioCodes Attempted Calls IP2Tel Low Threshold Monitor".

You can set, based on your network environment, the low-level and high-level threshold
integer values for these monitors. You can configure these integer values under the following
circumstances:

B When the monitor reaches its HighwWarningLevel threshold
B When the monitor reaches its HighCriticalLevel threshold
B When the monitor reaches its LowWarningLevel threshold
B When the monitor reaches its LowCiriticalLevel threshold

An alarm is by default triggered when the High-Threshold value is exceeded or the Low-
Threshold value is crossed. The alarm is cleared when the PMs value passes below the pre-
defined High-Threshold or above the Low-Threshold value.

Note: The log trap ‘'acPerformanceMonitoringThresholdCrossing' (non-alarm) (see
Section A.2.6 on page 160) is sent each time a PM threshold is exceeded. The severity
field is 'indeterminate’ when crossing above the threshold and 'cleared’ when it returns
below the threshold. The 'source’ varbind in the trap indicates the object for which the
threshold is being crossed.

The following table describes the different alarm states when a threshold is crossed, and the
different states when it is cleared:

Table 7-6: Alarm States

Alarm Initial State Alarm Change State

Warning
Critical
Critical
Clear
Warning
Clear

The alarm that is raised depends on the counter value that is exceeded above the threshold
or is crossed below the threshold.

For example, when the IP to Tel calls counter exceeds 50, an alarm is sent from the device.
Alternatively, when the IP to Tel calls counter drops below 10, an alarm is sent from the
device.

You can either set the threshold level for a specific object or for all objects of class: SNMP
Network device.

Note: See Section 7.3 on page 74 for the mapping between the SNMP severity levels
and the SCOM severity levels.
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» To configure the threshold values:

In the GW State View, right-click the gateway module that you wish to configure, and
then choose Open > Health Explorer for <GW IP>; the Health Explorer is displayed:

JS[=] E3

1.
Figure 7-13: Health Monitor-Initial View

Properties lélHelp Cwerrides -

@ Health Explorer for
Recalculate Health [ Filter Monitars | T4 Refresh

Reset Health
Knowledge | State Change Events I

Health manitors for
Soope is only unhealthy child monitors, x
a lt:}' Entity Health - 00-30-3F-22-17-D7 (Objedt)
4 Eé:é:' Lwailability - 00-90-8F-22-17-D7 [Object]
a l!?l Audiocodes GW Power Supply Dependency Monitar- 00-30-81
Entity Health - : PowerSupply Module at Slot 2 (Objed]
wailability- : PowerSupply Module at Slot 2 [Objed)
Audiocodes Power Supply Severity Monitor - | PowerSupr

<
IQ:OI Audiocaodes GW Severity Manitor- 00-90-8F-22-17-DT (Audioc

Note: You can also configure thresholds for performance monitors in the Monitors
window (Authoring > Monitors); however, this method is easier if you are currently in

the Monitoring pane.
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2. Click the X adjacent to the message "Scope is only unhealthy child monitors"; the full
list of monitors are displayed:

Figure 7-14: Health Monitor-Expanded View

Health Explorer for
() Reset Health 3 Recalculate Health 7 Filter Monitors ()l Refresh

Properties

| Help o7y Overrides =

Health manitars far

Entity Health - 00-90-8F-22-17-D7 [Object] & knowledge | State Change Events (2] |

4 (g8 Availability - 00-30-3F-22-17-D7 [Object] d
@ Audiocades acBoardCallResourcesAlarm Monitor - 00-50-§ Summary
@ Audiocodes acBoardControllerFailureslarm Monitor- 00-9 This monitor is the rollup moniter for all other monitors running against this object. If the state is
@ Audiocodes acBoardFatalErrar Manitor - 00-90-8F-22-17-D unknown, gither monitoring has not begun for this object or there are no monitars defined.
@ Audiocades acBoardOverloadalarm Monitor- 00-90-3F-22- Causes
@ Audiocodes acDChannelStatus Monitor - 00-30-8F-22-17-C An unhealthy state for this monitor indicates some problem with another monitor running against this
@ Audiocodes GW acBoardTemperaturealarm Manitor - 00-1 object. View all current alerts from this object using this link:
@ Audiocodes GW acFeaturekeyErrar Monitor - 00-90-§F-22-2 View Alerts
@ Audiocodes GW acgwldminState Change Manitor- 00-90- Resolutions
@ Audiocodes GW acNTPEerveritatusAlarm Monitor- 00-90-§ Use the health explorer to drill down and find the cause of the unhealthy state. Use the knowledge on

@ Audiocades GW coldStart Monitor- 00-90-8F-22-17-D7 [~ the specific monitor causing the issue to troubleshoot and fix the problem.
> @ Audiocodes GW Fan Tray Dependency Monitor - 00-90-8F-2

@ Audiocodes GW Management Pack aclDAPLostConnectior

@ Audiocodes GW Management Pack acBoardWanlinkalarm

@ Audiocodes GW Management Pack achediaProcess Qwerlo

@ Audiocodes GW Management Pack acwirelessCellulartod

@ Audiocodes GW Management.Pack actnalogPortGroundF

@ Audiocodes GW Management,Pack acOCSPServerStatusal:

) Audiocades GW Power Supply Dependen oy Monitor - 00-91
+ (&) Entity Health - : Powersupply Module at Slat L[Objed)
Entity Health - : PowerSupply Module at Slot 2 [Objed)

Syailability - PowerSupply Module atSlot 2 [Objed]
@ Audiocodes Power Supply acPowersupplyAlarm Mani
IQE'I Audiocodes Power Supply Severity Monitar- : PowerSy

O Configuration - : PowerSupply Module at Slot 2 (Objed)

O Performance - : PowerSupply Module at Slot 2 (Objed)

»

3. Inthe Entity Health tree, expand Performance node.

4. Select the required monitor right-click and choose Monitor Properties; the Threshold
Monitor properties window for this monitor is displayed:
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Figure 7-15: Threshold Monitor Properties
. Audiocodes Attempted Calls IPZ2Tel High Treshold Monitor Properties | x|

. Generall Healthl .-’-'-.Iertingl Diagnosgtic and Recoven I Eunfiguratinnl Product Knowledge  Overides |

Overides are uged to change the monitor, diagnostic and recaovery configuration. You can also
view all overides applied to each by opening the summary dialog.

Chooze the monitor, diagnostic or recoven from the lizt below for which pou want b0 apply
averides for or wigw summany an:

b onitor [Audiocodes Attempted Calls IP2T el High Treshold kMonitar]

Dizable... Ovemide... Wiew summar...

Examplaz
Digable a monitor: | want to dizable monitor for all Windows Computers.
Oweride a diagnostic: | need to ovemride thiz diagnostic for one of my ‘Windows Computers.

Wiew summany of a recoveny: | need to view the objects thiz recovery has been enabled far.

(] I Cancel Smply |

5. Click the Overrides tab; the Overrides screen is displayed.
6. Click the Override button.

Figure 7-16: Override Thresholds
L1
Dizable... Dvernide. .. Far the object: 00-90-5F-30-4B-67

Far all ohjecks of class: Mode

_ For a group...
kar Far all “findows Compukers.
For a specific object of class: Mode

thiz diagnostic for one of my Window

For all objects of another class...

Choose one of the following options:

e For the object <GW IP> - only the threshold levels for this specific gateway are
changed.
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e For all objects of class: SNMP Network Device — the threshold levels for all
currently discovered SNMP gateways in the network.

The Override Properties window is displayed:

Figure 7-17: Override Properties - High Threshold Monitor

Owverride Properties Eq

tanitar nanme: Audiocodes Attermpted Callz IP2Tel High Treshold Monitar
Categony: Custom
Owerrides target: Object:

Ovemde-controlled parameters:

Owemide | Parameter Mame  * | Parameter Type Default Yalue | Oweride Walue | Effective Walue | Change Status il

r Alert zeverity E rwrneration Match monit... [ katch manito... | Match monitar... [ [Mo change]

r Auto-Fezolve Alert Boolean True Tre True [Mao change]
» n Enabled Boolean Falze Falze Falze [Mao change]

- Generates Alert Bonolean True Trg True [Ma change]

r HighCrticalLewel Integer 25 25 25 [Mo change]

r Highif armingLesvel Integer 10 10 10 [Mo change]

r Intervals econds Integer 300 a00 a00 [Mo change]

r SencTime String 1200 1200 1200 [Mao change] =i
< | o

D etails:

Enabled Description Edit...
The parameter is not set by a custorn overnide or by a
management pack. The effective value of thiz parameter
iz the default value of thiz parameter.

Management pack

Select destination management pack:

IAudincode3 G Management Pack j [d e

Help | Ok Spply Cancel |

4
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Figure 7-18: Override Properties - Low Level Threshold Monitor

Override Properties Eq
b anitar name: Audincodes Atternpted Calls IP2Tel Low Treshold Monitor
Categany: Cusztam
Ovemnides target: Ohbject:

Ovenide-contralled parameters:

Owverride | Parameter Name * | Parameter Type Default Value | Overide Value | Effective Yalue | Change Status :I
r Alert severity E numeration td atch monit._. | batch monito. . | kMatch maonitor.. | [Mo change]
r Auto-Resolve Alert Boolean True True True [Ma chanage]
)—n Enabled Boolean Falze Falze Falze [Mo change]
e I Generates Alert Boolean True True Tiue [Mo change]
r IntervalSeconds Inteqer 00 900 300 [Ma chanage]
r LowCriticalLewel Inteqer -1 -1 -1 [Ma chanage]
I Lowiwaminglesel Integer Bl - -1 [Mo change]
I SencTime Sting 1200 1200 1200 [Mo change] =
1| | _"l_
Details:
Enabled Description Edit...

The parameter iz not et by a custom owveride or by a
management pack. The effective value of thiz parameter
iz the default value of this parameter.

Management pack

Select destination management pack:

Andiocodes G Management Pack j ...

Help | 0k | Apply | Cancel |

4

The following parameters define threshold levels for AudioCodes Management Pack
monitors:

e High Threshold Monitors: 'HighCriticalLevel' and 'HighWarningLevel'
e Low Threshold Monitors: 'LowCriticalLevel' and 'LowWarningLevel'

7. Inthe 'Override' column, select the checkbox adjacent to the parameter whose threshold
value you wish to change.
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8. Inthe corresponding 'Override Value' column, set the required value.

Note:
e By default, the High Critical Level Threshold is set to "25". You should change this
value according to your site requirements.
e By default, the Low Critical Level Threshold monitor is set to "-1". You should
change this value according to your site requirements.

e The message in Details pane is context-sensitive. Once you select a check box, the
message text changes accordingly.

9. Click OK to apply the change.
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8 Optimizing SCOM Server Loading

This chapter describes how to optimize the load on the SCOM server for AudioCodes
MP-related functional items. The following sections are described in this chapter:

B Displaying AudioCodes Objects. See Section 8.1.1 on page 92.
B Optimizing Monitors Load. See Section 8.1.2 on page 95.

B Optimizing Discoveries Load. See Section 8.1.3 on page 99.

B Optimizing Rules Load. See Section 8.1.4 on page 81.

A Note: For detailed information, see Appendix C on page 173.

8.1 Introduction

One of the key factors affecting the performance of the SCOM server when working with the
AudioCodes MP is the overloading on the CPU that is triggered by the disparate launching
of AudioCodes MP-related functional items. For example, the discovery of gateways and
their modules and trunks. For each of these operations, a script is run. When many of these
scripts are run simultaneously, the performance of the SCOM server is significantly affected.
When the SCOM server load is optimized, the script running is smoothly distributed over time
so as to prevent CPU bottlenecks and therefore maintain performance.

This smooth distribution is achieved by overriding the values of the following parameters for
the respective discoveries, monitors and rules:

B Polling interval — defines the polling frequency interval; how often (seconds)
functional items are launched (least possible resolution is 60 seconds).

B Sync time — specifies at which time the polling is rearranged; this allows you to set
the exact time in minutes within the hour when a functional item is launched. For
example, if the IP2Tel Calls counter rule is launched every 10 minutes (i.e. the Polling
interval) — this parameter sets the starting time and therefore the subsequent time
sequence for launching this item within the hour (in minutes) i.e., 0, 10, 20 or 3, 13,
23, etc.). For example, when the 'Sync time' is set to 00:04, the IP2Tel Calls counter
rule is launched in the following time sequence: 4, 14, 24, 34, 44, 54 minutes of each
hour.

Note the following:

B When you override the 'Sync' time to launch functional items at different starting times,
this smoothens CPU utilization over time and therefore enhances performance.
However, on the other hand leads to delay, as the time between the relative launching
of each functional item increases.

B Generally it is not recommended to override the 'IntervalSeconds' parameter; because
most of the counters have a low polling frequency with a default value of fifteen
minutes, and depend on the actual information refresh on the gateway devices
themselves. The exception is in the case of specific Trunk counters (see Section 8.1.4
on page 102).

B For a detailed load balancing scenario for SCOM server, see Appendix C on page
173.

Version 1.0.5.65 91 AudioCodes SCOM Management Pack



QC oudiocodes

AudioCodes SCOM Management Pack

8.1.1 Displaying AudioCodes Objects

Before you configure the properties of the monitors, discoveries

and rules, for the purposes

of easy management, it is recommended to set the object scope to view only AudioCodes

functional items.

» To filter the management pack functional items view:
1.

Figure 8-1: Views

4 | Authoring
> [~ Management Pack Templates
#% Distributed Applications
=3 Groups
4 &y Management Pack Objects
Attributes

1 Monitors

|:7py Object Discoveries
% Crerrides

Rules

|z Service Level Tracking
_... Tasks

2 views ¢E—

In the Authoring pane, select Management Pack Objects > Views.

The right-hand pane displays all the functional items that are defined in the current

scope.
In the Main Menu, ensure that the Scope setting is selected:
e  Select View > Scope or press Ctrl+M.

Figure 8-2: View Scope

= object
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’v- M.al Mame Target Management Pack j Dhjet;
$ Disl v Detail Pane Ctrl+D 4 Discovered Type: Audiocodes Analog Trunk Class (2) Discovery
= 6o ) Find Ctil+F i Audiocodes Trunks on Analog Module Initial Discowery Audiocodes IF Analog M., Audiocodes GW Mar
G 53_’*"3' 4 [ Audiacodes GW Analog Trunk Secandary Discavery Audiocades Analog Trun..,  Audiocodes GW Mar
2l 4 Discovered Type: Audiocodes CPU Module (4)
@ : v Scope Curl+M [ Audiocodes Mediant 4000 CPU Module Initial Discovery Audiocodes SHMP Device  Audiocodes GW Mar '
#_ ol 3 Refresh F5 (i) Audincodes CPU Madule Index Discovery Audincodes CPLU Module Audincodes GW Mar
Rl | Status Bar | Audiocodes Mediant 1000 CPU Module Initial Discovery Sudiocodes SMMP Device Audiocodes GW Mar
=7 Service Leve| Tracking | Audiocodes Mediant 600 CPU Module Initisl Discowery Audiocodes Mediant800 .., Audiocodes GW Mar
= ks 4 Discovered Type: Audiocodes Digital Trunk Class (73
] Wiewws | Audiocodes Digital Trunks on Digital Module Initial Discow.. Audiocodes IF Digital Ma...  Audiocodes GW Mar
| Audiocodes Digital Trunks on acTrunkPack-MEDIANT2000 ... Audiocodes acTrunkPack-... Audiocodes GW Mar
| Audiocodes Digital Trunk Secondary Discovery Audiocodes Digital Trunk., Audiocodes GW Mar
| Audiocodes Mediant 800 IF Digital Module Trunk Digital In... Audiocodes Mediant 800 ... Audiocodes GW Mar
\:p Audiocodes Digital Trunks on BRI Module Initial Discovery Audiocodes IF BRI Module  Audiocodes GW Mar
| Audiocodes Mediant 800 IF BRIModule Trunk Digital Initia.. Audiocodes Mediant 800 ... Audiocodes GW Mar
;g Audiocodes Digital Trunk on acTrunkPackIPM2000 Module ... Audiocodes acTrunkPack-...  Audiocodes GW Mar
4 Discovered Type: Audiocodes Ethernet Port Class (3)
| Audiocodes Ethernet Port Initial Discovery Audiocodes CPU Module Audiocodes GW Mar
dd Marikoring Wizard... 7 Audigcodes Ethernet Port Secandary Discovery Audiocodes Ethernet Port, Audiocodes W M_aiﬂ
Mew Distributed Application. .. | I d
New Group... Object Discovery Details: v
@ Select an object discovery above to view details
.. Monitoring
J Authoring
Administration
_\_?:‘ My Workspace
Ready 4
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The Scope Management Pack Objects window is displayed:

Figure 8-3: Scope Management Pack Objects

Scope Management Pack Objects E

Select the class, group, or object that you want to target from the list below. You can also filter or sort the list to make
items easier to find.

Look for:

|.~’-‘«udi-:-cndes Clear |

' Vfiew commen targets
&+ Viiew all targets

Target = | Management Pack | Description -
[] &udiocodes acTrunkPack Audiocades G Manageme

[] Audiocodes acTrunkPack Audiocades G Manageme
DAudiocodes.&.nalog Trun Audiocodes G Manageme

[] &udiocades CPU Module Audiocades Gy Manageme

[] Audiocades DChannel 1 Audiocodes G Manageme
DAudincodesDigitalTrunkAudiocudesGNManageme
DAudincodesEtheme’c Por Audiocodes G Manageme

DAudincodes Fan Tray Audiocodes G hManageme

[] sudiocodes Gy kediant Audiocodes Gv kanageme Device Mediant4000
[] &udiocodesIFADSL Mo Audiocades G Manageme
DAudiocodesIFAnalogM Audiocodes G Manageme

[] Audiocodes IF BRI Madul Audiocades G Manageme

|:| Audiocodes: IF Digital Mo Audiocodes GW Manageme

[] &udiocodesIF SHDSL M Audiocodes G Manageme

[] &udiocodes IF TIAWAN M Audiocades G Manageme
DAudiucndesIFWAN Mo Audiocodes G Manageme

[] Audiocodes IP Media Mo Audiocodes G hManageme -
4| | B
Select All | Clear All | 1033 total Targets. 45 visible. [ selected

Heln I MK I Cancel I
3. Inthe 'Look for' field, enter "Audiocodes".
4. Select the View all targets option.

5. Click either Select All or select only specific targets whose functional items (monitors,
discoveries or rules) should be changed, and then click OK.
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All AudioCodes Management Pack related-entities are displayed in the right-hand

pane:
Figure 8-4: AudioCodes Management Pack Entities
Meonitors
Management pack objects are now scopedtol Audiocodes Analog Trunk Class, Audiocodes,,, Change Scope.., x
Target Type Inherited From =l

Audiocodes Analog Trunk Class
Audiocodes CPU Module
Audiocodes DChannel Class
Audiocodes Digital Trunk Class
Audiocodes Ethernet Port Class
Audiocodes Fan Tray

Audiocodes GW Mediant4000

Audiocodes IF ADSL Module |-
Audiocodes IF Analog Module

Audiocodes IF BRI Module

Audiocodes IF Digital Module

Audiocodes IF SHDSL Module

Audiocodes IF TIW AN Module

Audiocodes IF WAMN Module

Audiocodes IP Media Module

Audiocodes MI1K Device

Audiocodes MZ2K and M3IK GW Devices Family Class
Audiocodes M2K Device

+Audiocodes M3K Device -
1| | 3
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8.1.2

Optimizing Monitor's Load

This section describes how to configure when monitors are launched.

The following monitors have a high level of CPU utilization, and therefore it is highly
recommended to synchronize the times when they are launched:

B Gateways:
e  Audiocodes Blocked Channels High Threshold Monitor
e Audiocodes Free Channels Low Threshold Monitor
e  *Audiocodes Low Threshold Monitor <PM>— family of monitors
e  *Audiocodes High Threshold Monitor <PM> — family of monitors

Note: All threshold monitors have corresponding counter rules. For example, the
Audiocodes Blocked Channels High Threshold Monitor has the corresponding rule
'‘Audiocodes Digital Trunk Blocked Channels Counter Rule (see Section 8.1.4 on page
102.)

B Trunks:
e AudioCodes Digital Trunk Alarm Monitor (see Section 7.3.3 on page 75).

*For the AudioCodes *Low Threshold Monitor and AudioCodes *High Threshold Monitors
family of monitors, where <PM> is the name of the PM (performance monitor), such as
‘Tel2IP Failed Calls'.
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» To optimize monitors' loading:
1.

Figure 8-5: Monitors Option
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The Monitors window is displayed:

Figure 8-6: Monitors

In the Authoring pane, select Management Pack Objects > Monitors.

PR Monitors - Audiocodes - Operations Manager H=] B3
File Edit View Go Tasks Tools Help
:I— Searchw _ | Create a Monitor ¥ _ | Overrides v -
Authoring < Monitors » Tasks
4 | uthoring Management pack ohjects are now scopedto: Audiocodes &nalog Trunk Class, Audiocodes..,  Change Scope.., gl @
) Management Pack Templates Target \ Type Inherited From \ mas| Monit;" N
ZE Distrinuted Applications > Audiocodes IF BRI Module
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Audiocodes Atkempted Calls Tel2IP Lowe Treshold M., audiocodes Cumul.,  Audiocodes SMMP L, A
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Monitor Description:

j‘ Authoring

Management Pack:  Audiocodes GW Management Pack

¢ Administration

Target Audicodes SHMP Device
ﬁﬂ My Workspace Inherited From: Audiacodes SHMP Device
Knowiledge: View knoviedge

Ready

=l

4

2.
override.

In the 'Monitors' list, expand the tree and select the monitor whose value you wish to
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Figure 8-7: Overriding Object Monitors

Monitors * Tasks
Management packobjects are now scopedto Audiocodes Analog Trunk Class, Audiocodes,..  Change Scope,., x EI 7]

Target Type Inherited From Malil i -
g = | Monitor -

Audiocodes IF BRI Module

Create a Monit
Audiocodes IF Digital Module reate a Monitc

Audiocodes IF SHDSL Module =:| Properties
Audiocodes IF TI'W AN Module Disable
Audiocodes IF WAN Module i
Disable the Monitor 3 (Overrides b
Audiocodes IP | Delet
For all objects of class: Audiocodes M1K Device Cverride the Monitor b | [EEE

4 Audiocodes M1

4 (55 Entity Hes FLIE L Disable Diagnostic

For a specific object of class: Audiccodes M1K Device

15 myailat Cverride Diagnostic
O Config For all objects of another class... ) )
= Disable Recovery
4 55 Performance Aggregate Rollup

Override Recovery
Audiocodes Atternpted Calls IP2Tel High Treshiold M., Audiocodes Cumul.,
Summary [
Audiocodes Attempted Calls IP2Tel Low Treshold M., Audiocodes Cumul.,
Audiocodes Attempted Calls Tel2IP High Treshold M., Audiocodes Cumul,.,  Audiocodes SMMP L A
Audiocaodes Attempted Calls Tel2IP Low Treshald K., Audiocodes Cumul.,.,  Audiocodes SHNWP .. A
Audiocodes Blocked Channels High Treshold Maonitor Audiocodes Blocke...  Audiocodes SKNMP .. A
Audiocodes Busy Calls IP2Tel High Treshold Maonitor  Audiocodes Cumul,.,  Audiocodes SMMP L A
Audiocodes Busy Calls IP2Tel Lowe Treshold Monitar Aydiocodes Cumul.,,  Audiocodes SKMP .., L
Audiocades Busy Calls TelZIP High Treshold Monitor  Audiocodes Cumul.,,  Audiocodes SHWP . Ao
14| | 3

3. Right-click the monitor, choose Overrides > Override the Monitor, and then in pop-up
dialog, select the scope affected by the modification e.g. "For a group".
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The Override Properties window is displayed:

Figure 8-8: Override Properties-Object Monitors-High Level Threshold Monitor

Override Properties
anitar name: Audiocodes Blocked Channels High Treshold bonitar
Category: Custarn
Owernides target: Clazs: Audiocodes M1K Device
Qveride-controlled parameters: Show Monitor Properties... |
Owerride | Parameter Mame ¢ | Parameter Type Default Yalue | Overide Yalue | Effective Walue | Change Status ;I
[ Alert severity Enurneration Match monit... [ Match monito.., | Match monitor... | [Mo change]
- Auto-Resolve Alert Boaolean True True True [Ma change]
- Enabled Boolean True True True [Mao change]
[ Generates Alert Boolean True True True [Mao change]
[ HighCriticalLevel Integer 40 40 40 [Ma change]
[ Highiw/arningLewel Integer 30 a0 i} [Mo change]
- Intervals econds Integer =11] [=11] B0 [Mo change]
3 = P Stiing 1200 1200 1200 [No change] =
4| | [
Details:
syncTime Description Edit...
The parameter is not et by a custom overide or by a
management pack. The effective value of this parameter
iz the default value of thiz parameter.
Management pack
Select destination management pack:
Audiocodes GW Management Pack j Hew...
Help | Ok | Ll | Cancel |
4

4. Select the 'Override’ check box for the 'SyncTime' parameter.

Note: The message in Details pane is context-sensitive. Once you select a check box,
the message text changes accordingly.

5. Inthe 'Override Value' field for 'SyncTime', type the appropriate value.
6. Click OK.
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8.1.3 Optimizing Discoveries' Load

This section describes how to configure when discoveries are launched. SCOM periodically
discovers gateways and their modules and trunks to update their respective health states.
The different types of discoveries are described below:

B Gateways:

e Device Discovery
B Modules:

e |Initial Discovery

e Index Discovery

e  Secondary Discovery
B Trunks:

e |Initial Discovery

e  Secondary Discovery
B Ethernet Port:

e Initial Discovery

e Index Discovery

e  Secondary Discovery

Note: Since the number of trunks which have to be discovered is much higher relative to
the number of modules and gateways, reducing the polling frequency for the number of
trunk-related discoveries will significantly improve the performance of the SCOM server.

For more information, see Appendix C on page 173.

» To optimize discoveries' loading:
1. Inthe Authoring pane, select Management Pack Objects > Object Discoveries.

Figure 8-9: Object Discoveries Option

4 |7 Authoring
> [ Management Pack Templates
#% Distributed Applicatiors
&3 Groups
4 ‘& Management Pack Objects
|:=| Attributes

1 Maonitors
|:pn Object Discoveries (—
B Cverrides
|=| Rules
|z Service Level Tracking
_"' Tasks

#| Views
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The Object Discoveries window is displayed:

Figure 8-10: Object Discoveries

Object Discoveries (269)

Management pack objects are now scopedto Audiocodes Analog Trunk Class, Audiocodes...

Tame

4 Discove

red Type: Audiocodes Analog Trunk Class (2)

g Avdiocodes Trunks on Analog Module Initial Discovery

g Avdiocodes GW Analog Trunk Zecondary Dizcovery

4 Discove

red Type: Audiocodes CPU Module (4)

i Audiocodes Mediant 4000 CPU Module Initial Discovery

g Audiocodes CPU Module Index Discovery

|y Audiocodes Mediant 1000 CPU Module Initial Discovery

iy Audiocodes Mediant 300 CPU Madule Initial Discovery

4 Discovel

| Audiocodes Digital Trunks on Digital Madule Initial Discow..
| Audiocodes Digital Trunks on acTrunkPack-MEDIANT2000 ..

red Type: Audiocodes Digital Trunk Class (7)

i Audiocodes Digital Trunk Secondary Discovery

g Avdiocodes Mediant 300 IF Digital Module Trunk Digital In...

i Audiocodes Digital Trunks on BRI Module Initial Dizcovery

i Avdiocodes Mediant 300 IF BRI Module Trunk Digital Initia...
| Avdiocodes Digital Trunk on acTrunkPackIPR2000 Module ...

4 Discovered Type: Audiocodes Ethernet Port Class (3)

i Audiocodes Ethernet Port Initial Discovery

i Audiocodes Ethernet Port Secondary Discowery

4]

Targek

Audiocodes IF Analog M.,

Audiocodes &nalog Trun..,

Audiocades SMMP Device
Audiocodes CPU Madule
Audiocodes SMRP Device
Audiocodes Mediantg0o ..

Audiocodes IF Digital Ma...
Audiocodes acTrunkPack-...
Audiocodes Digital Trunk...
Audiocodes Mediant 300 ..
Audiocodes IF BRI Module
Audiocodes Mediant 300 ..

Audiocodes acTrunkPack-..

Audiocodes CPU Madule
Audiocodes Ethernet Part..,

2.

In the 'Discoveries' list, expand the tree and select the Discovery object whose value

you wish to override.

* Tasks
Change Scope.., x E] 7]
Management Pack thject

Discovery

Audiocodes GW Mar
Audiocodes GW Mar

Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW kar
Audiocodes GW Mar

Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar

Audiocodes GW Mar

Audiocodes GWM_aFI
3

Figure 8-11: Overriding Object Discoveries

Object Discoveries (269)

Management pack objects are now scopedto Audiocodes Analog Trunk Class, Audiocodes...

Mame

4 Discovered Type: Audiocodes Analog Trunk Class (2)

i Audiocodes Trunks on Analog bModule Initial Discovery

| Audiocodes GW Analog Trunk Secondaty Discovery
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g Audiocodes Mediant 4000 CPU Module Initial Discovery

4 D
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For a group...

Target
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Audiocades Analog Trun..,

Audiocodes

» Tasks
Change Scope.. x D 71
Management Pack. = i
2 j Object
Discovery
Audiocodes GW Mar == .
Properties
Audiocodes G Mar .
\ifyy Disable
verrides b
Disable the Object Discovery LTS
Override the Object Discovery y |Delete
Summary 3

For a specific object of class: Audiocodes Digital Trunk Class

For all objects of another class...

|y Audiocodes Digital Trunk Secondary Discowery

| Audiocodes Mediant 800 IF Digital Module Trunk Digital In...

i Avdiocodes Digital Trunks on BRI Module Initial Discowvery

i Audiocodes bMediant 800 IF BRI Module Trunk Digital Initia..

i Audio

cades Digital Trunk on acTrunkPackIPM2000 Maodule ..

4 Discovered Type: Audiocodes Ethernet Port Class (3)

auumtoues IF Digital Mo..,
Audiocodes acTrunkPack-..,
Audiocades Digital Trunk..,
Audiocodes Mediant 800 ..
Audiocodes IF BRI Module
Audiocodes Mediant 500 ..,

Audiocodes acTrunkPack-...

Audiocodes GV Mar
Audiocodes GW Mar
Audiocodes G Mar
Audiocodes G Mar
Audiocodes GV Mar
Audiocodes GW Mar
Audiocodes G Mar

i Audiocodes Ethernet Port Initial Discowvery Audiocodes CPU Module Audiocodes GW Mar
| Audiocodes Ethertet Port Secondaty Discovery Audiocodes Ethernet Part.,, Audiocodes GW Mar o
4| | 3
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3. Right-click the monitor, choose Overrides > Override the Object Discovery, and then
in pop-up dialog, select the scope affected by the modification e.g. "For all objects of
another class".

The Override Properties window is displayed:
Figure 8-12: Override Properties-Object Discoveries

Override Properties [ %]

Object Discovery name: Audiocodes acTunkPack-MEDIANT 2000 Secondary Discovery
Category: Dizcovery
Overrides target: Clazs: Audiocodes acTunkPack:-MEDIANT 2000

Ovemide-controlled parameters: Show Object Discovery Properties...

Override | P. ter Mame ¢ | P ter Type Default Yalue | Overide Value | Effective Value | Change Status
[T |Enabled Tr Tru Tr
r

| | i

Details:

SyncTime Description Edit...
The parameter iz not zet by a custom override or by a

management pack. The effective value of thiz parameter

iz the default value of thiz parameter.

Management pack

Select destination management pack:

Audiocodes GW Management Pack j MNew.

Help | ak. | Apply | Cancel |
Y

4. Select the 'Override' check box for the 'SyncTime' parameter.

Note: The message in Details pane is context-sensitive. Once you select a check box,
the message text changes accordingly.

5. Inthe 'Override Value' field for 'SyncTime, type the appropriate value.
6. Click OK.
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8.1.4

Optimizing Rule's Load

This section describes how to configure when rules are launched.

There are two specific rules whose values are recommended to override. These rules
(counters) unlike the SIP PMs are not typical device counters; instead they calculate values
based upon monitored information about the Channels' state retrieved from the device (in-
service or out-of-service). These counters (‘AudioCodes Digital Trunk Available Channels
Counter Rule' and 'Audiocodes Digital Trunk Blocked Channels Counter Rule’) by default
collect information every minute and include a large number of monitored entities.
Consequently, this high polling frequency leads to high CPU utilization.

Therefore, you can improve performance by reducing the polling frequency of these counters
using the rule 'Audiocodes.GW.Management.Pack.Trunk.Digital.Channels.Probe' (see
Figure 8-14, Figure 8-15 and Figure 8-16). For this rule, it is recommended to modify both
the 'IntervalSeconds' parameter as well as the 'SyncTime parameter'.

Note: This rule queries the Channels state from the device, and then saves the
information in a file directory specified by System Environment variable
"AudiocodesTempFolder. This information is then aggregated by a script launched by the
SCOM.

It is also recommended to poll no more than one counter rule at any one point in time (for
details, see Appendix C on page 173).

» To optimize rules' loading:
1. Inthe Authoring pane, select Management Pack Objects > Rules.

Figure 8-13: Rules Option

4 |7 Authoring
> [ Management Pack Templates
#% Distributed Applicatiors
&= Groups
4 ‘& Management Pack Objects
1 Maonitors
|7y Object Discoveries
B Cverrides
=] Rules (u—
|z Service Level Tracking
_"' Tasks

#| Views
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The Rules window is displayed:
Figure 8-14: Object Rules

PR Rules - Audiocodes - Dperations Manager

File Edit View Go Tasks Tools Help
I Search Create a Rule -
Authoring

4 7 Authoring
I Management Pack Templates
$ Distributed Applications
51 Groups
4 &5y Management Pack Objeds
i—| Attributes
Monitors
i Object Discoveries
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|=| Rules
|2 Service Level Tracking
] Tasks

] Wiews

Add Monitoring Wizard...
Mew Distributed Application...

Mew Group,..
. Monitoring
A Authoring
Administration

My Workspace

gOiarr\desv - E!I‘,Scuge ) Find El Tasks|| @) -

< Rules (282)

Management pack objects are now scopedto; Audiocodes Analog Trunk Class, Audiocodes..,

Mamne
4 Type: Audiocodes Digital Trunk Class (3)
Audiocodes Digital Trunk Available Channels Counter Rule
Audiocodes Digital Trunk Blocked Channels Counter Rule
=] Audiocodes Digital Trunk Channels Prabe Rule
4 Type: Audiocodes GW Mediant4000 (31)
Audiocodes Attempted Calls Tel2IP Counter Rule
=] Audiocodes Available Channels Counter Rule
=] Audiocodes IPGroupDialogs Counter Rule
=] Audiocodes Established Calls Tel2IP Counter Rule
|i=] Audiocodes Busy Calls IP2Tel Counter Rule
Audiocodes Failed Calls Tel2IP Counter Rule
=] Audiocodes SRDSubsaibeDialogs Counter Rule
=] Audiocodes Attempted Calls IP2Tel Counter Rule
|=] Audiocodes SRDInviteDialogs Counter Rule
=] Audiocodes MoResources Calls [P2Tel Counter Rule
=) Audiocodes Forwarded Calls Tel2IP Counter Rule
|i=] Audiocodes SRDOtherDialogs Counter Rule
Audiocodes MoRoute Calls IP2Tel Counter Rule

=] Audiocodes IPGrouplnwiteDialogs Counter Rule

|

> Tasks

Change Scope.., X | 178

Inherited fram Management Pack

Rule -

|i=| Createa Rule

Audiocodes Digital Trunk... Audiocodes G Mar

Audiocodes Digital Trunk.,.,  Audiocodes GW Mar
Audiocodes Digital Trunk..,  Audiocodes GW Mar 3
Audiocodes SHMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar
Audiocodes SHMP Device  Audiocodes G Mar
Audiocodes SHMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar
Audiocodes SHMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar
Audiocodes SHMP Device  Audiocodes G Mar
Audiocodes SMMP Device  Audiocodes G Mar

Audiocodes SNMP Device Audiocodes GV Mar o
| v

Rule details:

@ Select a rule above to view details

4

2. Inthe'Rules' list, expand the tree and select the rule whose values you wish to override.
For example, the 'Digital Trunk Channels Probe Rule'.
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Figure 8-15: Overriding Object Rules-AudioCodes Digital Trunk Channels Probe Rule

Rules (282) * Tasks
Management pack objects are now scopedto Audiocodes Analog Trunk Class, Audiocodes,..  Change Scope.., » D 71
Marne Inbetited Fram Management Pack,
Rule ~
4 Type: Audiocodes Digital Trunk Class (3)
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— For all objects of class: Audiccodes Digital Trunk Class Override the Rule | SR
=) Audiocode

i For a group...

=] Audiocode Summary »
= Budiocods For a specific object of class: Audiocodes Digital Trunk Class N
2 sudiocode For all objects of another class... b Audiocodes G ar
|i=| &udiocodes Failed Calls Tel2IP Caunter Rule Audiocodes SNMP Dewice Audiocodes G Mar
|i=| Audiocodes SRDSubscribeDialogs Counter Rule Audiocades SKNMP Device Audiocodes GW Mar
=) &udiocodes Attempted Calls IP2Tel Counter Rule Audiocodes SKNMP Device Auydiocodes G Mar
=) &udiocodes SRDInviteDialogs Counter Rule Audiocodes SNMP Device Aydiocodes G Mar
|| &udiocodes MoResources Calls IP2Tel Counter Rule Audiocodes SHMP Device Audiocodes G\ Mar
=] Audiocodes Forwarded Calls Tel2IP Counter Rule Audiocodes SNMP Device Audiocodes G Mar
=) &udiocodes SRDOtherDialogs Counter Rule Audiocodes SNMP Device Audiocodes G Mar
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4| | >

3. Right-click the monitor, choose Overrides > Override the Rule, and then in pop-up
dialog, select the scope affected by the modification e.g. "For a group".

User's Guide 104 Document #: LTRT-30808



User's Guide 8 Optimizing SCOM Server Loading

The Override Properties window is displayed:

Figure 8-16: Override Properties-Audiocodes Digital Trunk Channels Probe Rule

Override Properties E
Rule narme: Audincodes Digital Trunk Channels Probe Rule
Categony: Cusgtom
Overrides target: Clasz: Audiocodes Digital Trunk Clazs

Overide-controlled parameters: Show Rule Properties...

Owenide | Parameter Mame ¢+ | Parameter Type Default Walue | Owveride Walue | Effective Walue | Change Statusz

r Enabled Boolean True True True [Ma change]
P_n Interval Seconds Integer B0 B0 B0 [Ma change]
e r Sync Time String [Ma change]

- Timeout Seconds Integer =] ED B0 [Mo change]
4| | i

Detailz:

Interval Seconds Description Edit...
The parameter is not s;et by a custom override or by a -
management pack. The effective walue of this parameter
iz the default value of this parameter.

Management pack

Select destination management pack:

Audiocodes Gw Management Pack j [Ew..

Help | oK | Ll Cancel |

4

4. Select the 'Override’ check box for the 'SyncTime' parameter.

Note: The message in Details pane is context-sensitive. Once you select a check box,
the message text changes accordingly.

In the 'Override Value' field for 'SyncTime', type the appropriate value.
Select the Override check box for the 'IntervalSeconds' parameter.

In the 'Override Value' field for 'IntervalSeconds', type the appropriate value.
Click OK.

In the 'Rules’ list, select other rules whose values you wish to override. For example,
the 'Audiocodes Failed Calls Tel2IP Counter Rule'.

© ® N oW’
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Figure 8-17: Overriding Object Rules-AudioCodes Failed Calls Tel2IP Counter Rule
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10. Right-click the monitor, choose Overrides > Override the Rule, and then in pop-up
dialog, select the scope affected by the modification e.g. "For a group".

The Override Properties window is displayed:
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Figure 8-18: Override Properties-AudioCodes Failed Calls Tel2IP Counter Rule

Override Properties

Rule narne: Audiocodes Faled Calls Tel2lP Counter Rule
Category: Custam
Overides target: Class: Audiocodes G Mediant4000
Dveride-controlled parameters: Show Aule Properties. .
Oweride | Parameter Mame ¢ | Parameter Type Default Value | Overide Value | Effective Valug | Change Status
r Enabled Boolean True True Tiue [Mo change]
r IntervalSeconds Integer 300 S00 300 [Mo change]
m SyncTime String 1200 1200 1200 [Ma changs]
4 | i
Dietails:
SyncTime Description Edit...
The parameter is not set by a custom overide or by a
management pack. The effective value of this parameter
is the default walue of this parameter.
Management pack
Select destinstion management pack:
Audiocodes G Management Pack j MNev...
Help ok | aey | cancel |
%

11. Select the 'Override' check box for the 'SyncTime' parameter.

12. Inthe 'Override Value' field for 'SyncTime', type the appropriate value.
13. Click OK.
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A SNMP Traps

The tables in the following subsections provide information on SNMP traps that are sent from
the device to the SCOM. The component name (described in each of the following headings)
refers to the string provided in the acBoardTrapGlobalsSource trap varbind.

Notes:

e Traps are not sent automatically to the SCOM. You must first configure the SCOM
server as a Trap Manager on your managed device (see Section 5.2 on page 50).

A e All traps are sent from the SNMP port (default 161).
e To clear a generated alarm, the same notification type is sent; however with the
severity set to ‘Cleared’.

e All trap-based monitors captured are cleared when a new trap arrives with the same
OID and source varbinds.

For detailed information on SNMP, refer to the SNMP Reference Guide for SIP Enterprise
Devices.

A.1 Chassis Alarms

A.1.1 Fan Tray Alarm

A Note: Applicable only to Mediant 1000, Mediant 3000 and Mediant 4000.
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Alarm

(e]]b)

Description

Source Varbind Text

Alarm Text
Event Type

Probable Cause

Alarm Severity

Critical

Major

Cleared

Table A-1: acFanTrayAlarm

acFanTrayAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.29

Sent when a fault occurs in the fan tray or a fan tray is missing.

Chassis#0/FanTray#0

Fan-Tray Alarm <text>

equipmentAlarm

= One or more fans on the Fan Tray module stopped working.
= One or more fans on the Fan Tray module works slower than expected

(heatingVentCoolingSystemProblem)

Condition <text>

Corrective Action

Fan-Tray is missing. | Fan-Tray is missing ' 1. Check if the Fan Tray module is inserted

When one or more Fan-Tray is faulty
fans in the Fan Tray
are faulty.

Fan Tray module is in | -
place and fans are
working.

in the chassis.

2. If the Fan Tray module was removed
from the chassis, re-insert it.

3. If the Fan Tray module has already been
inserted in the chassis and the alarm is
active, send a Return Merchandise
Authorization (RMA) request to
AudioCodes.

Warning: When removing the Fan Tray
module while the power is on (or after it has
recently been switched off), the blades may
still be rotating at high speeds. Therefore, to
avoid bodily harm, make sure that you don't
touch the fan blades.

Fan Tray module is faulty. Send a Return
Merchandise Authorization (RMA) request to
AudioCodes.
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A.1.2 Power Supply Alarm

A Note: Applicable only to Mediant 1000, Mediant 3000 and Mediant 4000.

Table A-2: acPowerSupplyAlarm

Alarm acPowerSupplyAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.30

Description Sent when a fault occurs in one of the power supply (PS) modules or a PS module is

missing.

Default Severity Critical

Source Varbind Text Chassis#0/PowerSupply#<m>, where m is the power supply’s slot number

Event Type equipmentAlarm

Probable Cause powerProblem

Alarm Severity Condition <text> Corrective Action

Major The HA (High Availability) Power-Supply Alarm. Power- ' 1.  Check if the unit is
feature is active (applicable | Supply is missing. inserted in the chassis.
only to Mediant 3000 and 2. Ifit was removed from

Mediant 4000) and one of the

L the chassis, re-insert it.
power supply units is faulty - .
or missing. 3. Ifit'sinserted in the

chassis and the alarm is
active, send a Return
Merchandise
Authorization (RMA)
request to AudioCodes.

Cleared PS unit is placed and - -
working.
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A.1.3 User Input Alarm

Note: Applicable to Mediant 3000 and Mediant 1000.

Alarm

OID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-3: acUserlnputAlarm

acUserlnputAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.36
Sent when the input dry contact is short circuited; cleared when the circuit is reopened.
Critical
Chassis#0
equipmentAlarm
inputDeviceError

Condition <text>

Corrective Action

Input dry contact is short circuited. | User input Alarm. User's | Reopen the input dry contact.
Input-Alarm turn on.

Input dry contact circuit is -
reopened.

A.1.4 PEM Alarm

A Note: Applicable only to Mediant 3000.

Alarm

OID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Severity

Table A-4: acPEMAlarm

acPEMAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.31

Sent when a fault occurs in one of the PEM modules or a PEM module is missing.
Critical

hassis#0/PemCard#<m>, where m is the power entry module’s (PEM) slot number
equipmentAlarm

underlyingResourceUnavailable

Condition <text> Corrective Action

Critical The HA (High Availability) PEM Module Alarm. | 1.  Make sure the PEMs are
feature is active and one of the | PEM card is present and that they're
PEMs (Power Entry Modules) is | missing. inserted correctly.
missing. 2. Ifit's present and inserted
correctly yet the alarm remains
active, send a Return
Merchandise Authorization
(RMA) request to AudioCodes.
Cleared PEM card is placed and both - -
DC wires are in.
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A.1.5 Hardware Failure Alarm

A Note: Applicable only to Mediant 1000.

Table A-5: acHwFailureAlarm

Alarm acHwFailureAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.43

Default Severity Critical

Source Varbind Text Chassis#0/module#<m>, where m is the module’s number

Event Type equipmentAlarm

Probable Cause equipmentMalfunction

Alarm Severity Condition <text> Corrective Action

Critical The module is faulty or has been | Module Alarm: Restart the device to clear this
removed incorrectly. Faulty IF-Module alarm. The alarm is not cleared.

Major Module mismatch - module and IF-Module Restart the device to clear this
CPU board mismatch. Mismatch alarm. The alarm is not cleared.

A.1.6 Timing Module Alarms

A Note: These alarms are applicable only to Mediant 3000.

A.1.7 TM Inconsistent Remote and Local PLL Status Alarm

Table A-6: acTMInconsistentRemoteAndLocalPLLStatus Alarm

Alarm acTMiInconsistentRemoteAndLocalPLLStatus

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.56

Description Inconsistent Remote and Local PLL status.

Default Severity Major

Source Varbind Text Chassis#0/TimingManager#0

Event Type equipmentAlarm

Probable Cause underlyingResourceUnavailable

Alarm Severity Condition <text> Corrective Action

Major The alarm is triggered when the | Timing Manager 1.  Synchronize the timing module.
system is in 1+1 status and Alarm. Local and 2. Reboot the system.

redundant board PLL status is Remote PLLs
different to the active board PLL | status is different.
status

Status remains ‘Major' untila | - - -
reboot. A 'Clear trap is not
sent.
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A.1.8 TM Reference Status Alarm

Table A-7: acTMReferenceStatus Alarm

Alarm acTMReferenceStatus

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.57

Description Timing manager reference status.

Default Severity Major

Source Varbind Text Chassis#0/TimingManager#0

Event Type equipmentAlarm

Probable Cause underlyingResourceUnavailable

Status Changes When primary and secondary clock references are down for more than 24 hours, the alarm

will be escalated to ‘Critical'.

Alarm Severity Condition <text> Corrective Action

Major The alarm is triggered when the | Timing Manager Alarm. 1. Synchronize the timing
primary reference or secondary | PRIMARY REFERENCE module.
reference or both are down. DOWN/SECONDARY

Reboot the system.
REFERENCE DOWN/ALL

REFERENCES ARE DOWN

Status remains 'Major' until | - - -
a reboot. A clear trap is not
sent.
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A.1.9 TM Reference Change Alarm
Table A-8: acTMReferenceChange Alarm

Alarm acTMReferenceChange

OoID 1.3.6.1.4.1.5003.9.10.1.21.2.0.58
Description Timing manager reference change.
Default Severity Indeterminate

Source Varbind Text Chassis#0/TimingManager#0
Event Type

Probable Cause

Alarm Severity Condition <text> Corrective Action

- Log is sent on PLL status Timing Manager Corrective action is not necessary.
change.

A.1.10 Trunk Alarms

A Note: Applicable only to Digital Series.

A.1.10.1 Trunk Near-End LOS Alarm
Table A-9: acTrunksAlarmNearEndLOS

Alarm acTrunksAlarmNearEndLOS
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.49
Default Severity Critical
Source Varbind Text Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk
Event Type communicationsAlarm
Probable Cause lossOfSignal
Alarm Severity Condition <text> Corrective Action
Critical Near-end LOS  Trunk LOS Alarm Los of Signal (LOS) indicates a physical problem.
1. Check that the cable is connected on the board.
2. Check that the correct cable type is being used
(crossed/straight).
3. Contact AudioCodes' Support Center at
support@audiocodes.com.
Cleared End of LOS - -
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A.1.10.2 Trunk Near-End LOF Alarm
Table A-10: acTrunksAlarmNearEndLOF

Alarm

OoID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

acTrunksAlarmNearEndLOF

1.3.6.1.4.1.5003.9.10.1.21.2.0.50

Critical

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

lossOfFrame

Condition

Near end LOF | Trunk LOF Alarm

End of LOF -

A.1.10.3 Trunk AIS Alarm

Alarm

OID
Source Varbind Text

Alarm Text

Event Type

Probable Cause

<text>

Corrective Action
Make sure that the trunk is connected to a proper
follow-up device.

Make sure that both sides are configured with the
same (E1/ T1) link type.

Make sure that both sides are configured with the
same framing method.

Make sure that both sides are configured with the
same line code.

Make sure that the clocking setup is correct.

Contact AudioCodes' Support Center at
support@audiocodes.com.

Table A-11: acTrunksAlarmRcVAIS

acTrunksAlarmRcVvAIS

1.3.6.1.4.1.5003.9.10.1.21.2.0.51

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

PSTN provider has stopped the trunk (receiveFailure)

communicationsAlarm

Alarm Severity Condition <text> Corrective Action

Critical Receive AIS Trunk AIS Alarm e Contact your PSTN provider to
activate the trunk.

o |f the alarm persists, contact the

AudioCodes Support Center at
support@audiocodes.com

Cleared End of AIS -
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A.1.10.4 Trunk Far-End LOF Alarm

Alarm

OoID

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Severity

Critical

Cleared

Table A-12: acTrunksAlarmFarEndLOF

acTrunksAlarmFarEndLOF

1.3.6.1.4.1.5003.9.10.1.21.2.0.52

Critical

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

transmitFailure

Condition

RAI

End of RAI

A.1.10.5 DS1 Line Status Alarm
Table A-13: dsx1LineStatusChange

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Severity

<text>

Trunk RAI Alarm

dsx1LineStatusChange

1.3.6.1.2.1.10.18.15.0.1

Major on raise; Clear on clear

Corrective Action

Make sure that transmission is
correct.

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

<text>

Additional Info1,2,3

DS1 Updated DS1 Line Status.

Line
Status

This variable indicates the Line Status of the interface. It contains loopback,
failure, received 'alarm' and transmitted 'alarms' information.

dsxlLineStatus is a bitmap represented as a sum, so it can represent multiple
failures (alarms) and a LoopbackState simultaneously.

dsx1NoAlarm must be set if and only if no other flag is set.

If the dsx1loopbackState bit is set, the loopback in effect can be determined from
the dsxlloopbackConfig object. The various bit positions are:

1 dsx1NoAlarm No alarm present

2 dsx1RcvFarEndLOF Far end LOF (a.k.a., Yellow Alarm)

4 dsx1XmtFarEndLOF Near end sending LOF Indication

8 dsx1RcVvAIS Far end sending AIS

16 dsx1XmtAIS Near end sending AIS

32 dsx1LossOfFrame Near end LOF (a.k.a., Red Alarm)

64 dsx1LossOfSignal Near end Loss Of Signal

128 dsx1LoopbackState Near end is looped

256 dsx1T16AIS E1 TS16 AIS

512 dsx1RcvFarEndLOMF Far End Sending TS16 LOMF

1024 dsx1XmtFarEndLOMF Near End Sending TS16 LOMF

2048 dsx1RcvTestCode Near End detects a test code

4096 dsx1O0therFailure Any line status not defined here

8192 dsx1UnavailSigState Near End in Unavailable Signal State

16384  dsx1NetEquipOOS Carrier Equipment Out of Service

32768 dsx1RcvPayloadAlS DS2 Payload AIS

65536 dsx1Ds2PerfThreshold DS2 Performance Threshold Exceeded
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A.1.10.6 B-Channel Alarm

Alarm

OoID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Major

Clear

Table A-14: acBChannelAlarm

acBChannelAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.85
Minor
Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk
communicationsAlarm
degradedSignal
Condition <text> Corrective Action

Raised when B-channel
service state changes to 'Out
of Service' or 'Maintenance'

B-Channel Alarm. %s | Corrective action is not necessary

B-channel status changes to ' %s — additional -
'In Service' information

A.1.10.7 NFAS Group Alarm

Alarm
OID
Default Severity

Source Varbind Text

Table A-15: acNFASGroupAlarm

acNFASGroupAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.84
Major

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

Event Type communicationsAlarm
Probable Cause degradedSignal
Alarm Severity Condition <text> Corrective Action
Major Raised when an NFAS NFAS Group Alarm. = The alarm is sent only when
group goes out-of-service %s the backup Non-Facility
Associated Signaling (NFAS)
D-channel also falls, i.e.,
when both D-channels are
down.
= When at least one of the
D-channels (primary or
backup) returns to service,
the alarm is cleared.
= Corrective action is not
necessary.
Clear NFAS group state goes to %s— Additional -
in- service information
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A.1.11 SONET Alarms

A Note: These alarms are applicable only to Mediant 3000 with TP-6310 blade.

The source varbind text for the alarms under this component is Interfaces#0/Sonet#<m>,
where m is the SONET interface number.

A.1.11.1 SONET Section LOF Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-16: AcSonetSectionLOFAlarm

acSonetSectionLOFAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.38

Critical
Interfaces#0/Sonet#<m>, where m is the SONET interface number
communicationsAlarm
lossOffFrame
Condition <text> Corrective Action

LOF condition is present A SONET-Section LOF | Make sure the framing format on the port
on SONET no.n matches the format configured on the line.

Note that the 'sonetSectionCurrentStatus'
field in the sonetSectionCurrentTable will
have a value sonetSectionLOF(4)

LOF condition is not LOF -
present

A.1.11.2 SONET Section LOS Alarm

Alarm

OoID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Table A-17: AcSonetSectionLOSAlarm

acSonetSectionLOSAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.39

Critical

Interfaces#0/Sonet#<m>, where m is the SONET interface number

communicationsAlarm

lossOfSignal

Condition <text> Corrective Action

LOS condition is present = SONET-Section LOS | 1. Make sure the fiber optic cable is
on SONET no #n plugged in correctly.

2. Make sure it's not damaged.

3. Make sure its remote end is correctly
connected and undamaged.

4.  Make sure that configuration of the
remote port is correct.

Note that the 'sonetSectionCurrentStatus'
field in the sonetSectionCurrentTable will
have a value sonetSectionLOS (2)
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Cleared

LOS condition is not - -
present

A.1.11.3 SONET Section AIS Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-18: AcSonetLineAlSAlarm

acSonetLineAlSAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.40

Critical

Interfaces#0/Sonet#<m>, where m is the SONET interface number

communicationsAlarm

receiveFailure
Condition

<text> Corrective Action

AIS condition is present on SONET-  SONET-Line AIS
Line #n

If an Alarm Indication Signal (AIS)

condition is present on a SONET

line:

1. Make sure the remote
configuration is correct.

2. Check the line status at the
remote end of the link.

Note that the 'sonetLineCurrentStatus'
field in the sonetLineCurrentTable
will have a value sonetLineAlS

@)

AIS condition is not present. - -

A.1.11.4 SONET Line RDI Alarm

Alarm

(e]]b)

Default Severity
Source Varbind Text
Event Type

Probable Cause

Table A-19: AcSonetLineRDIAlarm

acSonetLineRDIAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.41

Critical

Interfaces#0/Sonet#<m>, where m is the SONET interface number
communicationsAlarm

transmitFailure

Alarm Severity Condition <text> Corrective Action
Critical RDI condition is present on SONET-Line RDI 1. Check the remote site for
SONET-Line #n alarm conditions.

2. Correct a line problem that
has arisen from the remote
interface.

Note that the 'sonetLineCurrentStatus'

field in the sonetLineCurrentTable

will have a value sonetLineRDI

4

Cleared RDI condition is not present. - -
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A.1.11.5 SONET Path STS LOP Alarm
Table A-20: acSonetPathSTSLOPAlarm

Alarm acSonetPathSTSLOPAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.61
Default Severity Critical

Source Varbind

Text Interfaces#0/Path#<m>, where m is the SONET interface number

Event Type communicationsAlarm

Probable Cause receiveFailure

Alarm Severity Condition <text> Corrective Action
Critical LOP condition is present SONET Path STS Loss of | 1. Verify that the Path configuration is
on Path #m Pointer alarm: LOP identical on both ends. For example, if the

far-end is configured as STS3c instead of
STS3, this is causing the alarm.

2. If the alarm doesn't clear, contact
AudioCodes Support Center at:

support@audiocodes.com

Note that the 'sonetPathCurrentStatus' field in
sonetPathCurrentTable has a value of
sonetPathSTSLOP(2)

STS = Synchronous Transport Signal

Cleared LOP condition is not - -
present

A.1.11.6 SONET Path STS AIS Alarm
Table A-21: acSonetPathSTSAISAlarm

Alarm acSonetPathSTSAISAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.62
Default Severity Critical

Source Varbind

Text Interfaces#0/Path#<m>, where m is the SONET interface number

Event Type communicationsAlarm

Probable Cause receiveFailure

Alarm Severity Condition <text> Corrective Action
Critical AIS condition is present on | SONET Path STS AIS 1. Check the configuration of the SONET
Path #n alarm: AIS path.

2. You may need to check more than just
the next hop. You may need to check the
far end of the path.

Note that the 'sonetPathCurrentStatus' field in
sonetPathCurrentTable has a value of
sonetPathSTSAIS(4)

Cleared AIS condition is not - -
present
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A.1.11.6.1 SONET Path STS RDI Alarm
Table A-22: acSonetPathSTSRDIAlarm
Alarm acSonetPathSTSRDIAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.63

Default Severity

Source Varbind
Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Critical
Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm
transmitFailure

Condition <text> Corrective Action

SONET Path STS RDI alarm:
RDI (Remote Defect
Indicator)

RDI condition is present on
Path #n

Check the stations along the SONET
path for alarm statuses, beginning with
the nearest hop.

The Remote Defect Indicator (RDI) is
sent upstream from the path endpoint to
inform the provider of a problem with its
circuit downstream.

Note that 'sonetPathCurrentStatus' in the
sonetPathCurrentTable has a value of
sonetPathSTSRDI(8)

RDI condition is not present - -

A.1.11.7 SONET Path Unequipped Alarm

Alarm
OID
Default Severity

Source Varbind
Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-23: acSonetPathUnequippedAlarm

acSonetPathUnequippedAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.64

Critical
Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm
receiveFailure
Condition

<text> Corrective Action

Unequipped condition is
present on Path #n

SONET Path Unequipped 1.
alarm: Unequipped

Make sure the SONET path has a
valid sender. The problem
originates with the hub transmitting
the signal to the hub reporting the
alarm.

2. Make sure the other side is set up
correctly. Make sure the carrier's
SONET network is set up correctly.
If you're set up correctly on both
sides, it's probably the carrier's
SONET network that is the
problem.

See also RFC 1595.

Note that 'sonetPathCurrentStatus' in
the sonetPathCurrentTable has a value
of sonetPathUnequipped(16)

Unequipped condition is not
present
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A.1.11.8 SONET Path Signal Label Mismatch Alarm

Alarm
OID
Default Severity

Source Varbind
Text

Event Type

Probable Cause

Table A-24: acSonetPathSignalLabelMismatchAlarm

acSonetPathSignalLabelMismatchAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.65

Critical
Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm

receiveFailure

Alarm Severity Condition <text> Corrective Action
Critical Signal Label Mismatch conditionis ' SONET Path Signal Label 1. Make sure the SONET Path is
present on Path #n Mismatch alarm: correctly provisioned.
SignalLabelMismatch 2. Make sure the received

Cleared S

Synchronous Transport Signal
(STS) or VT signal label (the C2
byte or V5 bits 5 through 7
respectively) is equal to either a
label value corresponding to the
locally provisioned Path-
Terminating Equipment (PTE)
functionality or the label value
corresponding to the equipped,
non-specific code.

See RFC 1595.

Note that ‘sonetPathCurrentStatus' in
sonetPathCurrentTable has a value
of sonetPathSignalLabelMismatch(32)

ignal Label Mismatch conditionis | - -

not present

A.1.11.9 SONET Hardware Failure Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Text

Table A-25: acSonetlfHwFailureAlarm

acSonetlfHwFailureAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.42

Critical on raise; Clear on clear

Interfaces#0/Path#<m>, where m is the SONET interface humber
communicationsAlarm

Transmit failure

SONET/SDH interface Failure Alarm
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A.1.12 DS3 Alarms

Note: These alarms are applicable only to Mediant 3000 with TP-6310 blade.

A.1.12.1 DS3 RAI Alarm
Table A-26: acDS3RAIAlarm

Alarm acDS3RAIAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.66
Default Severity Critical
Source Varbind Interfaces#0/DS3#<m>, where m is the DS3 interface number.
Text
Event Type communicationsAlarm
Probable Cause transmitFailure
Alarm Severity Condition <text> Corrective Action
Critical RAI condition is present on DS3- = DS3 RAIl alarm: RAI To clear the Remote Alarm Indication
Line #n (RAI) failure, remove the presence of
any of the following:
= Far-end Severely Errored Frame
(SEF) / Alarm Indication Signal
(AIS) defect (aka 'yellow'). To
correct it, set the two X-bits in the
M-frame that are set to zero, to
one (RFC 1407).
= One or two alarm signals on the
far-end alarm channel.
Note that the 'dsx3LineStatus' field in
dsx3ConfigTable will have a value of
dsx3RcvRAlFailure(2)
Cleared RIA condition is not present - -
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A.1.12.2 DS3 AIS Alarm
Table A-27: acDS3AISAlarm

Alarm acDS3AISAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.67
Default Severity Critical
Source Varbind Interfaces#0/DS3#<m>, where m is the DS3 interface number.
Text
Event Type communicationsAlarm
Probable Cause receiveFailure
Alarm Severity Condition <text> Corrective Action
Critical AIS condition is present on DS3- = DS3 AIS alarm: AIS = Remove the presence of Alarm
Line #n Indication Signal (AIS) in
contiguous M-frames for a time
equal to or greater than T, where
0.2ms <=T <= 100 ms.
= See RFC 3896 for information on
DS3 AIS framed with "stuck
stuffing".
Note that the 'dsx3LineStatus’ field in
dsx3ConfigTable will have a value of
dsx3RcVAIS(8)
Cleared AIS condition is not present - -
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A.1.12.3 DS3 LOF Alarm
Table A-28: acDS3LOFAlarm

Alarm acDS3LOFAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.68

Default Severity Critical

Source Varbind Interfaces#0/DS3#<m>, where m is the DS3 interface number.

Text

Event Type communicationsAlarm

Probable Cause lossOfFrame

Alarm Severity Condition <text> Corrective Action

Critical LOF condition is present on DS3- | DS3 LOF alarm: LOF 1. Correct the configuration

Line #n settings on the line. They're

correct for the the port but not
correct for the line.

2. Make sure the framing format
configured on the port matches
the framing format on the line.

3. Try see if the other framing
format clears the alarm.

4.  Configure a remote loopback on
the affected interface. Do this
with your provider. Run an
unframed Bit Error Rate Tester
(BERT) to see if there're
problems on the line.

5. lIsolate the problem using hard
or soft loopbacks (if you find
evidence of a bad line).

Note that the 'dsx3LineStatus' field in

dsx3ConfigTable will have a value

dsx3LOF (32)

Cleared LOF condition is not present - -
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A.1.12.4 DS3 LOS Alarm

Alarm
OID
Default Severity

Source Varbind
Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-29: acDS3LOSAlarm

acDS3LOSAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.69

Critical

Interfaces#0/DS3#<m>, where m is the DS3 interface number.

communicationsAlarm

lossOfSignal
Condition <text> Corrective Action
LOS condition is present on DS3- | DS3 LOS alarm: LOS = Achieve an average pulse density

Line #n

of at least 33% over a period of
175 +/- 75 contiguous pulse
positions starting with the receipt
of a pulse.

= The alarm occurs if there are 175
+/- 75 contiguous pulse positions
with no pulses of either positive
or negative polarity. See the IETF
DS3/E3 MIB.

Note that the 'dsx3LineStatus' field in
dsx3ConfigTable will have a value of
dsx3LOS (64)

LOS condition is not present - -

A.1.12.5 DS3 Line Status Change Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type

Probable Cause

Alarm Text

Additional Info1,2,3

Table A-30: dsx3LineStatusChangeTrap

dsx3LineStatusChange

1.3.6.1.2.1.10.30.15.0.1

Major on raise; Clear on clear

Interfaces#0/DS3#<m>, where m is the DS3 interface number.
communicationsAlarm

A dsx3LineStatusChange trap is sent when the value of an instance of dsx3LineStatus
changes. It can be utilized by an NMS to trigger polls. When the line status change results
in a lower level line status change (i.e., dsl), then no traps for the lower level are sent.

DS3 Line Status

Updated DS3 Line Status.

This variable indicates the Line Status of the interface. It contains loopback state
information and failure state information. The dsx3LineStatus is a bit map represented as a
sum, therefore it can represent multiple failures and a loopback (see dsx3LoopbackConfig
object for the type of loopback) simultaneously. The dsx3NoAlarm must be set if and only
if no other flag is set. If the dsx3loopbackState bit is set, the loopback in effect can be
determined from the dsx3loopbackConfig object.

The various bit positions are:

1 dsx3NoAlarm No alarm present

2 dsx3RcvRAlFailure Receiving Yellow/Remote Alarm Indication

4 dsx3XmitRAIAlarm Transmitting Yellow/Remote Alarm Indication
8 dsx3RcVAIS Receiving AlS failure state

16 dsx3XmitAIS Transmitting AIS

32 dsx3LOF Receiving LOF failure state

64 dsx3LOS Receiving LOS failure state

Version 1.0.5.65

127 AudioCodes SCOM Management Pack



- .
Q"OUdIOCOdeS AudioCodes SCOM Management Pack

128 dsx3LoopbackState
256 dsx3RcvTestCode
512 dsx30therFailure
1024 dsx3UnavailSigState
2048 dsx3NetEquipOOS

Looping the received signal
Receiving a Test Pattern

Any line status not defined here
Near End in Unavailable Signal State
Carrier Equipment Out of Service

A.1.13 SS7 Alarms

A.1.13.1 SS7 Link State Change Alarm Trap

Alarm

OoID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Infol
varbind

2. Condition
Alarm status

Corrective Action

Table A-31: acSS7 Link State Change Alarm Trap

acSS7LinkStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.19
Major

communicationsAlarm

other

*% SS7 *** Link %i is %s $s

Operational state of the SS7 link becomes ‘BUSY".
Major

%i - <Link number>

%s - <state name>: { "OFFLINE", "BUSY", "INSERVICE"}
%s — IF link has MTP3 layer, then this string equals:
(SP %i linkset %i slc %i)

Where:

%i - <SP number>

%i - <Link-Set number>

%i - <SLC number>

Otherwise there is NO additional text.

BUSY

Operational state of the link becomes ‘IN-SERVICE’ or ‘OFFLINE’.

cleared

For full details see the SS7 section and SS7 MTP2 and MTP3 relevant standards.
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A.1.13.2 SS7 Link Congestion State Change Alarm Trap
Table A-32: acSS7 Link CongestionState Change Alarm Trap

Alarm

oID

Default Severity
Alarm Type
Probable Cause

Alarm Text

Status Changes
1. Condition
Alarm status

Additional Infol
varbind

2. Condition
Alarm status
Corrective Action

Note :

acSS7LinkCongestionStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.22

Major

communicationsAlarm

other

** SS7 *** Link %i is %s %s

%i - <Link number>

%s — IF link has MTP3 layer, then this string equals:
(SP %i linkset %i slc %i)

Where:

%i - <SP number>

%i - <Link-Set number>

%i - <SLC number>

Otherwise there is NO additional text.

%s - <congestion state>: { "UNCONGESTED", "CONGESTED" }

SS7 link becomes congested (local or remote).
Major

CONGESTED

Link becomes un-congested - local AND remote.
Cleared

Reduce SS7 traffic on that link.

This alarm is raised for any change in the remote or local congestion status.

A.1.13.3 SS7 Link Inhibit State Change Alarm Trap

Alarm

OoID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Table A-33: SS7 Link Inhibit State Change Alarm Trap

acSS7LinkinhibitStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.20

Major

communicationsAlarm

other

*x SS7 *** |ink %i (SP %i linkset %i slc %i) is %s

SS7 link becomes inhibited (local or remote).
Major

%i - <Link number>

%i - <SP number>

%i - <Link-Set number>

%i - <SLC number>

%s - <congestion state>: { "UNINHIBITED", "INHIBITED" }
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Additional Infol varbind INHIBITED

2. Condition
Alarm status
Corrective Action

Note

Link becomes uninhibited - local AND remote
cleared
Make sure the link is uninhibited — on both local and remote sides

This alarm is raised for any change in the remote or local inhibition status.

A.1.13.4 SS7 Link Set State Change Alarm

Alarm

(e]]p)

Default Severity
Alarm Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Infol varbind

2. Condition
Alarm status

Corrective Action

Table A-34: SS7 Link Set State Change Alarm

acSS7LinkSetStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.23
Major

communicationsAlarm

other

***k SS7 *** Linkset %i on SP %i is %s

Operational state of the SS7 link-set becomes BUSY.
Major

%i - <Link-Set number>
%i - <SP number>
%s - <state name: { "OFFLINE", "BUSY", "INSERVICE"}

BUSY
Operational state of the link-set becomes IN-SERVICE or OFFLINE
cleared

For full details see the SS7 section and SS7 MTP3 relevant standards

A.1.13.5 SS7 Route Set State Change Alarm Trap

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Info
2. Condition

Alarm status

Table A-35: SS7 Route Set State Change Alarm Trap

acSS7RouteSetStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.24
Major

communicationsAlarm

Other

**x SS7 *** Routeset %i on SP %i is %s

Operational state of the SS7 route-set becomes BUSY
Major

%i - <Route-Set number>
%i - <SP number>
%s - <state name: { "OFFLINE", "BUSY", "INSERVICE"}

BUSY
Operational state of the route-set becomes IN-SERVICE or OFFLINE.

Cleared
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Alarm

Corrective Action

acSS7RouteSetStateChangeAlarm
For full details see the SS7 section and SS7 MTP3 relevant standards.

The source varbind text for all the alarms under the component above is System#0/SS7#0/
SS7RouteSet#<m> where m is the route set number. (Applicable to Mediant 3000

devices.)

A.1.13.6 SS7 SN Set State Change Alarm Trap

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Infol
varbind

2. Condition
Alarm status

Corrective Action

The source varbind

Table A-36: SS7 SN Set State Change Alarm Trap

acSS7SNSetStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.25
Major

communicationsAlarm

Other

*x SST *** SP %i is %s

Operational state of the SS7 node becomes BUSY
Major

%i - <SP number>
%s - <state name: { "OFFLINE", "BUSY", "INSERVICE"}

BUSY

Cleared when the operational state of the node becomes IN-SERVICE or OFFLINE
Cleared

Signaling Node must complete its MTP3 restart procedure and become un-isolated
For full details see the SS7 section and SS7 MTP3 relevant standards.

text for all the alarms under the component above is

System#0/SS7#0/SS7SN#<m> where m is the SN (signaling node) number. (Applicable to
Mediant 3000 devices.)

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
Condition
Alarm status

<text>value

Additional Infol varbind
Condition

Alarm status

Table A-37: SS7 Ual Group State Change Alarm Trap

acSS7UalGroupStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.74
Major

communicationsAlarm

other

*** SS7 *** Group Id %j Asp status is %s

Group ASP status changes.
Major

%i - Group number

%s - New state ("NO_SCTP", "SCTP_ASSOCIATE", SCTP_FAILURE", "ASP_DOWN",
"ASP_INACTIVE", "ASP_ACTIVE")

When group ASP status changes to "ASP_ACTIVE"

cleared
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Alarm acSS7UalGroupStateChangeAlarm

Corrective Action

The source varbind text for all the alarms under the component above is
System#0/SS7#0/ss7ualgroup#<m> where m is the ual group number. (Applicable to 3000
devices.)

A.1.14 Hitless Software Upgrade Alarm

Note: These alarms apply to Mediant 800B GW & E-SBC HA, Mediant 3000 HA, Mediant
2600 HA, Mediant 4000 HA, Mediant SE SBC HA, and Mediant VE SBC HA.

Table A-38: acHitlessUpdateStatus

Alarm acHitlessUpdateStatus

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.48

Default Severity -

Event Type Other

Probable Cause Other

Alarm Severity Condition <text> Corrective Action

Indeterminate A notification trap sent at the beginning Hitless The corrective action for each condition is
and end of a hitless software update. Update Event | described below.

Failure during the software update also
activates the trap.

Hitless: Start software upgrade. Corrective action is not required.

Hitless fail: Invalid cmp file file - missing Replace the cmp file with a valid one.
Version parameter.

Hitless fail: The software version stream Replace the cmp file with a valid one.
name is too long.

Hitless fail: Invalid cmp file - missing UPG Replace the cmp file with a valid one.
parameter.

Hitless fail: Hitless software upgrade is not Replace the cmp file with a valid one that
supported. supports hitless upgrade of the software

from the current version to the new one.

Hitless: Software upgrade ended Corrective action is not required.
successfully.
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A.1.15 High Availability Alarms

Note: These alarms apply to Mediant 800B GW & E-SBC HA, Mediant 3000 HA, Mediant
4000 HA, Mediant SE SBC HA and Mediant VE SBC HA.

A.1.15.1 HA System Fault Alarm
Table A-39: acHASystemFaultAlarm

Trap
OID
Description

Default
Severity

Source
Varbind Text

acHASystemFaultAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.33

Sent when the High Availability (HA) system is faulty (i.e., no HA functionality).

Critical

System#0/Module#<m>, where m is the blade module’s slot number

Event Type qualityOfServiceAlarm
Probable outOfService
Cause
élee\l/r(-:r‘?ity Condition <text> Corrective Action
Critical HA feature is Fatal exception error High Availability (HA) was lost due to
active but the switchover and should return automatically
system is not . . Lo
working in HA after a few minutes. Corrective action is not
mode required.
TCPIP exception error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
Network processor exception error HA was lost due to switchover and should
(applicable only to Mediant 3000) return automatically after a few minutes.
Corrective action is not required.
SW WD exception error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
HW WD exception error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
SAT device is missing HA was lost due to switchover and should
(applicable only to Mediant 3000) return automatically after a few minutes.
Corrective action is not required.
SAT device error HA was lost due to switchover and should
(applicable only to Mediant 3000) return automatically after a few minutes.
Corrective action is not required.
DSP error HA was lost due to switchover and should
(applicable only to Mediant 3000 and return automatically after a few minutes.
Mediant 4000) Corrective action is not required.
BIT tests error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
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PSTN stack error
(applicable only to Mediant 3000)

Keep Alive error

Software upgrade

Manual switch over

Manual reset

Board removal

(applicable only to Mediant 3000)

TER misplaced

(applicable only to Mediant 3000)

HW fault. TER in slot 2 or 3 is missing
(applicable only to Mediant 3000)

HW fault. TER has old version or is not
functional

(applicable only to Mediant 3000)

HW fault. invalid TER Type

(applicable only to Mediant 3000)

HW fault. invalid TER active/redundant
state

(applicable only to Mediant 3000)

HW fault. Error reading GbE state
(applicable only to Mediant 3000)
Redundant module is missing
(applicable only to Mediant 3000)

Redundant is not connecting
(applicable only to Mediant 3000)
Redundant is not reconnecting after
deliberate restart

No Ethernet Link in redundant module

SA module faulty or missing
(applicable only to Mediant 3000)
Eth link error

Higher HA priority

(Not applicable to Mediant 3000)

Network watchdog error

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to a system reset and
should return automatically after few
minutes. Corrective action is not required.
Return the removed board to the system.

Place the TER card according to the User's
Manual

Place the TER card according to the User's
Manual

Replace the TER card.

Replace the TER card.

Replace the TER card.

Replace the TER card.

1. Insert the redundant module into the
system.

2. If the error continues, reset / replace the
module.

Reset / replace the redundant module.

Reset / replace the redundant module.

Connect Ethernet links to the redundant
module

Make sure the Shelf Alarm module is
inserted correctly.

HA was lost due to switchover,

Connect the Eth link back.

HA was lost due to switchover to unit with
higher HA priority and should return
automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover ,

Fix the network connectivity from failed unit
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Minor

Cleared

HA feature is
active and the
redundant
module is in
startup mode
and hasn't
connected yet

HA system is
active

Waiting for redundant to connect
(applicable only to Mediant 3000)

Corrective action is not required.

A.1.15.2 HA System Configuration Mismatch Alarm

Trap
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm
Severity

Major

Cleared

Table A-40: acHASystemConfigMismatchAlarm

acHASystemConfigMismatchAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.34

Sent when the configuration of the modules in the HA system is not identical, causing instability.

Major

System#0/Module#<m>, where m is the blade module’s slot number

processingErrorAlarm

configurationOrCustomizationError

Condition

HA feature is active:

License Keys of Active
and Redundant modules

are different.

The Active module was
unable to pass on to the

<text>

different feature keys.

feature key.

Redundant module the

License Key.

License key of the
Redundant module is

invalid.

Successful License Key

update

module.

Configuration mismatch in the system:

Active and Redundant modules have

Fail to update the redundant with

Corrective Action

The actions for the conditions are
described below.

Update the Feature Keys of the Active
and Redundant modules.

Replace the Feature Key of the
Redundant module — it may be
invalid.

Feature key did not update in redundant A Replace the Feature Key of the

Redundant module - it may be
invalid.

The feature key was successfully -

updated in the redundant module

A.1.15.3 HA System Switch Over Alarm

Trap
OID

Description

Default Severity

Source Varbind

acHASystemSwitchOverAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.35

Table A-41: acHASystemSwitchOverAlarm

Sent when a switchover from the active to the redundant module has occurred.

Critical

System#0/Module#<m>, where m is the blade module’s slot number

Text
Event Type qualityOfServiceAlarm
Probable Cause outOfService
Alarm Severity Condition <text> Corrective Action
Version 1.0.5.65 135 AudioCodes SCOM Management Pack



- .
Q"OUdIOCOdeS AudioCodes SCOM Management Pack

Trap acHASystemSwitchOverAlarm

Critical A switchover from the active | Switch-over: See the
to the redundant unit has acHASystemFaultAlarm
occurred table above

Cleared 10 seconds have passed - -

since the switchover

A.1.16 Device (Board) Alarms

The source varbind text for all the alarms under this component depends on the device:
B 3000 Series: Board#0<n>
B All other devices: System#0<n>

Where n is the slot number in which the blade resides in the chassis. For Mediant 1000 and
MediaPack, n always equals to 1.

A.1.16.1 Fatal Error Alarm
Table A-42: acBoardFatalError

Alarm acBoardFatalError
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.1
Description Sent whenever a fatal device error occurs.

Default Severity
Event Type
Probable Cause

Alarm Severity

Critical
equipmentAlarm
underlyingResourceUnavailable (56)

Condition <text>

Corrective Action

Critical Any fatal error Board Fatal Error: A run-time | 1. Capture the alarm information and the
specific string describing the Syslog clause, if active.
fatal error 2. Contact AudioCodes' Support Center at

Stays ‘Critical’ until
reboot. A 'Clear’
trap is not sent.

After fatal error -

support@audiocodes.com which will want
to collect additional data from the device
and perform a reset.
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A.1.16.2 Configuration Error Alarm

Table A-43: acBoardConfigurationError

Alarm acBoardConfigurationError
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.2
Description Sent when the device's settings are invalid. The trap contains a message stating/detailing/explaining
the invalid setting.
Default Severity Critical
Event Type equipmentAlarm
Probable Cause underlyingResourceUnavailable (56)
Alarm Severity Condition <text> Corrective Action
Critical A configuration Board Config Error: A run- 1. Check the run-time specific string to
error was detected | time specific string describing determine the nature of the configuration

the configuration error

Stays 'Critical' until | After configuration | -

reboot. A 'Clear’
trap is not sent.

error

A.1.16.3 Temperature Alarm

Alarm
OID
Description

Source
Varbind Text

error.

2. Fix the configuration error using the
appropriate tool: Web interface, EMS, or ini
file.

3. Save the configuration and if necessary
reset the device.

Table A-44: acBoardTemperatureAlarm

acBoardTemperatureAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.3

Sent when the device exceeds its temperature limits. Applies only to 2000 and 3000 Series devices.

System#0

Event Type equipmentAlarm
Probable = The air filter is saturated.
Cause = One of the fans work slower than expected.
temperatureUnacceptable (50)
Alarm - . .
Severity Condition <text> Corrective Action
Critical Temperature is above 60°C | Board temperature 1. Check that the ambient environment around the
(140°F) too high chassis was not changed (room temperature, air-
For Mediant 3000: conditioner, and location of the chassis on the
Fans at High speed - site). If the ambient environment is the same,
check your ventilation make sure that all unoccupied module slots are
outlet and covered with blank panels.
environment 2. Clean the air filter — refer to the Hardware
temperature. Installation Manual on how to clean/replace the
air filter.
3. If after cleaning the air filter the alarm still exists:
Check if all fans in the system are properly
operating.
For Mediant 3000: Check if you also received a Fan
Tray alarm, which indicates that one or more fans in
the Fan Tray are faulty (major). If this is the case,
send the faulty Fan Tray to AudioCodes as RMA.
For Mediant 1000: Send an RMA request to
AudioCodes for the Fan Tray.
Cleared Temperature falls below 55°C - -
(131°F)
Version 1.0.5.65 137 AudioCodes SCOM Management Pack



QC oudiocodes

AudioCodes SCOM Management Pack

A.1.16.4 Software Reset Alarm

Alarm

OID
Description

Default
Severity

Event Type

Probable
Cause

Alarm Severity

Critical

Stays 'Critical'
until reboot. A
‘Clear" trap is
not sent.

Table A-45: acBoardEvResettingBoard

acBoardEvResettingBoard

1.3.6.1.4.1.5003.9.10.1.21.2.0.5

Sent after the device resets.

Critical

equipmentAlarm

outOfService (71)

Condition

When a soft reset is triggered
via the Web interface or SNMP

After raise

<text> Corrective Action

User resetting
board

A network administrator has taken action to reset the
device. Corrective action is not required.

A.1.16.5 Software Upgrade Alarm

Alarm
OID
Description

Default
Severity

Alarms
Source

Event Type

Probable
Cause

Alarm Severity

Table A-46: acSWUpgradeAlarm

acSWUpgradeAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.70

Sent for software upgrade process errors.

Major

System#0

processingErrorAlarm

softwareProgramError

Condition

<text> Corrective Action

Major Raised upon software SW upgrade error: Start up the system from BootP/TFTP.
upgrade errors Firmware burning
failed. Startup system
from Bootp/tftp.
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A.1.16.6 Call Resources Alarm

Alarm
OID
Description

Default
Severity

Event Type

Probable
Cause

Alarm Severity

Major

Cleared

Table A-47: acBoardCallResourcesAlarm

acBoardCallResourcesAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.8

Sent when no free channels are available.

Major

processingErrorAlarm

softwareError (46)

Condition <text> Corrective Action
Percentage of busy Call resources alarm | ® Expand system capacity by adding more channels
channels exceeds the (trunks)
predefined RAI high _OR-
threshold = Reduce traffic
Percentage of busy - Note that to enable this alarm, the Remote Alarm
channels falls below the Indication (RAI) mechanism must be activated
predefined RAI low (EnableRAl = 1).
threshold

A.1.16.7 Controller Failure Alarm

Alarm
OID

Description

Default
Severity

Event Type

Probable
Cause

Table A-48: acBoardControllerFailureAlarm

acBoardControllerFailureAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.9

Sent when the Proxy is not found or registration fails. Internal routing table may be used for routing.
Sent when the physical network link is up or down ("BusyOut Trunk/Line n Link failure").
GWAPP_TRAP_BUSYOUT_CONNECTIVITY: Sent when the connection to the Proxy is up or down
("BusyOut Trunk/Line n Connectivity Proxy failure").

GWAPP_TRAP_BUSYOUT_TDM_OVER_IP: Sent when a failure occurs in TDM over IP
(transparent T1/E1 without signaling) - "BusyOut Trunk n TDM over IP failure (Active calls x Min y)".
(Note: Applicable only to Digital Series.)

GWAPP_TRAP_BUSYOUT_PROXY_SET: Sent when the connection to the Proxy Set associated
with this trunk/line is up/down ("BusyOut Trunk/Line n Proxy Set Failure").
GWAPP_TRAP_BUSYOUT_REGISTRATION: Sent when a failure occurs in server registration for
this trunk/line ("BusyOut Trunk/Line n Registration Failure").
GWAPP_TRAP_BUSYOUT_SERVING_IPGROUP: Sent when a failure occurs in a Serving IP
Group for this trunk ("BusyOut Trunk n Serving IP Group Failure").

(Note: Applicable only to Digital Series.)

GWAPP_TRAP_PROXY_SET: Sent when a failure occurs in a Proxy Set (not per trunk/line, but per
Proxy Set) - "Proxy Set ID n".

Major

processingErrorAlarm

softwareError (46)
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Alarm acBoardControllerFailureAlarm
Alarm Severity Condition <text> Additional Information
Major Proxy has not been found or ' Controller failure alarm: = Check the network layer
the physical network linkis | proyy not found. Use internal ®  Make sure that the proxy IP and port are
up or down ("BusyOut routing. configured correctly.
Trunk/Line n Link failure"). -OR-

Proxy lost. Looking for
another Proxy.

Cleared Proxy is found. The 'Cleared’ ' - -
message includes the IP
address of this Proxy.

A.1.16.8 Board Overload Alarm
Table A-49: acBoardOverloadAlarm

Alarm acBoardOverloadAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.11
Description Sent when there is an overload in one or some of the system's components.
Default Major
Severity
Event Type processingErrorAlarm
Probable softwareError (46)
Cause
Alarm Severity Condition <text> Corrective Action
Major An overload condition exists | "System CPU overload 1. Make sure that the syslog level is 0 (or
in one or more of the system | condition - IdleUtilization not high).
=%d”
components percentage. %d 2. Make sure that DebugRecording is not
Where %d is the percentage running.
of available CPU resources . .
remainin 3. If the system is configured correctly,
9 )
reduce traffic.
Cleared The overload condition “System CPU overload -
passed condition - IdleUtilization

percentage=%"

A.1.16.9 Feature Key Error Alarm
Table A-50: acFeatureKeyError

Alarm acFeatureKeyError

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.6
Description Sent to relay Feature Key errors etc.
Default Severity Critical

Event Type processingErrorAlarm

Probable Cause configurationOrCustomizationError (7)
Alarm Text Feature key error

Status Changes

Note Support for this alarm is pending.
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A.1.16.10 Missing SA/M3K Blade (Alarm, Status and Synchronization) Alarm

A\

Note: Applicable only to Mediant 3000.

Alarm
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Critical

Cleared

Table A-51: acSAMissingAlarm

acSAMissingAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.32

Sent when the Shelf Alarm (SA) module is missing or non operational.

Critical

Chassis#0/SA#<m>, where m is the shelf Alarm module’s slot number

equipmentAlarm

underlyingResourceUnavailable

Condition

SA module removed or missing

SA module is in slot 2 or 4 and working.

<text>

SA Module Alarm. SA-Module | =

from slot #n is missing.

A.1.16.11 Administration Status Change Alarm

Alarm
OID
Description

Default
Severity

Event Type

Probable
Cause

Alarm Severity

Major

Major

Cleared

Table A-52: acgwAdminStateChange

acgwAdminStateChange
1.3.6.1.4.1.5003.9.10.1.21.2.0.7

Sent when Graceful Shutdown commences and ends.

Major

processingErrorAlarm

outOfService (71)

Condition

Admin state changed to shutting down

Admin state changed to locked

Admin state changed to unlocked

<text>

Network element
admin state change
alarm: Gateway is
shutting down. No
time limit.

Locked

Corrective Action
Reinsert the Shelf Alarm
(SA) module into slot #n

= Make sure it's correctly
inserted in the slot.

Corrective Action

No corrective action is required.

A network administrator took an
action to gracefully lock the device.

No corrective action is required.

A network administrator took an
action to lock the device, or a
graceful lock timeout occured.

No corrective action is required.

A network administrator has taken
an action to unlock the device.
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A.1.16.12 Operational Status Change Alarm

Alarm
OID

Description

Default
Severity

Event Type

Probable
Cause

Alarm Severity

Major

Cleared

Table A-53: acOperationalStateChange

acOperationalStateChange
1.3.6.1.4.1.5003.9.10.1.21.2.0.15

Sent if the operational state of the node goes to disabled; cleared when the operational state of the node
goes to enabled.

Major

processingErrorAlarm

outOfService (71)

Condition <text> Corrective Action

The alarm is cleared when the
operational state of the node goes to
enabled.

Operational state changed to
disabled

Network element operational -
state change alarm. Operational
state is disabled.

= In IP systems, check for initialization
errors - in IP systems the operational
state of the node is disabled if the
device fails to properly initialize.

=  Look for other alarms and Syslogs
that might provide additional
information about the error.

Operational state changed to - -
enabled

A.1.17 Network Alarms

A.1.17.1 Ethernet Link Alarm

Alarm
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Major

Critical

Table A-54: acBoardEthernetLinkAlarm

acBoardEthernetLinkAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.10
Sent when the Ethernet link(s) is down.

Critical

All except 3000 Series: Board#<n>/EthernetLink#0 (where n is the slot number)

3000 Series: Chassis#0/Module#<n>/EthernetLink#0 (where n is the blade's slot number)

This trap relates to the Ethernet Link Module (the #0 numbering doesn't apply to the physical Ethernet
link).

equipmentAlarm

underlyingResourceUnavailable (56)

Condition <text> Corrective Action

Ensure that both Ethernet cables
are plugged into the back of the
system.

2. Observe the system'’s Ethernet link
lights to determine which interface
is failing.

3. Reconnect the cable or fix the
network problem

Ethernet link alarm: 1.
Redundant link is down

Fault on single interface

Fault on both interfaces No Ethernet link
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Cleared Both interfaces are - Note that the alarm behaves differently
operational when coming from the redundant or the

active modules of a High Availability
(HA) system. The alarm from the
redundant is raised when there is an
operational HA configuration in the
system. There is no critical severity for
the redundant module losing both its
Ethernet links as that is conveyed in the
no HA alarm that follows such a case.

A.1.17.2 Ethernet Group Alarm

Note: Applicable only to Mediant 500 GW & E-SBC, Mediant 800B GW & E-SBC, and
Mediant 1000B GW & E-SBC.

Table A-55: acEthernetGroupAlarm

Alarm acEthernetGroupAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.86

Description This alarm is raised when both ports in an Ethernet port-pair group (1+1) are down, and
cleared when at least one port is up.

Default Severity Major

Event Type equipmentAlarm

Probable Cause underlyingResourceUnavailable

Alarm Text Ethernet Group alarm. %s

Status Changes
1. Condition Raised when both ports in a group are down

2. Condition Cleared when at least one port is up

A.1.17.3 WAN Link Alarm
Table A-56: acBoardWanLinkAlarm (only for MSBR Series)

Alarm acBoardWanLinkAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.79

Description This alarm is raised when the WAN Link is down (and cleared when link is up again).
Default Major / Clear

Severity

Event Type equipmentAlarm

Source Board#x/WanLink#y

Varbind Text

Probable underlyingResourceUnavailable

Cause
Alarm Severity Condition <text> Corrective Action
Major WAN link down - Connect the WAN port
Clear WAN link up - -
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A.1.17.4 Data Interface Status Alarm

A Note: Applicable only to MSBR series.

Table A-57: acDatalnterfaceStatus

Alarm acDatalnterfaceStatus

OoID 1.3.6.1.4.1.5003.9.10.1.21.2.0.83
Default Severity Indeterminate

Event Type communicationsAlarm

Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm Status
<text> Value

Corrective Action

A.1.17.5 Wireless Cellular Modem Alarm

No corrective action is required as this is an event, not an alarm.

A Note: Applicable only to Mediant 500 MSBR and Mediant 800B MSBR.

Table A-58: acWirelessCellularModemAlarm

Alarm acWirelessCellularModemAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.82

Description This alarm is raised when either the wireless modem is down or in backup mode, and cleared when

modem is up.

Default Major / Clear

Severity

Source Board#x/WanLink#y

Varbind Text

Event Type equipmentAlarm

Probable underlyingResourceUnavailable

Cause
Alarm Severity Condition Corrective Action
Major Raised when either the WAN wireless cellular modem Get the link up. Investigate the possibility

wireless modem is down or in | alarm
backup mode, and cleared
when modem is up.

Clear WAN link up -

A.1.17.6 NTP Server Status Alarm

of an electronics failure or a problem
with the radio frequency (RF) path.
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Table A-59: acNTPServerStatusAlarm

Alarm acNTPServerStatusAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.71
Description NTP server status alarm. Raised when the connection to the NTP server is lost. Cleared when the
connection is reestablished. Unset time (as a result of no connection to NTP server) may result with
functionality degradation and failure in device.
Default Major
Severity
Event Type communicationsAlarm
Probable communicationsSubsystemFailure
Cause
Alarm Severity Condition <text> Corrective Action
Major No initial communication to Network = NTP server alarm. No Repair NTP communication (the NTP
Time Protocol (NTP) server. connection to NTP server. ' server is down or its IP address is

configured incorrectly in the device).

Minor No communication to NTP server - -
after the time was already set once.

A.1.17.7 NAT Traversal Alarm

Alarm
OID

Description

Default Severity
Event Type
Probable Cause
Alarm Text

Status Changes

Corrective Action

Table A-60: acNATTraversalAlarm

acNATTraversalAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.17

Sent when the NAT is placed in front of a device and is identified as a symmetric NAT. It is
cleared when a non-symmetric NAT or no NAT replace the symmetric one.

Indeterminate
other (0)
NAT Traversal Alarm

The STUN client in the device is enabled and has either identified a NAT or is not finding
the STUN server.

Keep-alive is sent out every 9/10 of the time defined in the ‘NatBindingDefaultTimeout'
parameter.

See http://tools.ietf.org/html/rfc5389
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A.1.17.8 LDAP Lost Connection Alarm

Alarm

OID

Default Severity
Event Type

Probable Cause

Alarm Text
Status Changes
1. Condition

Alarm Status

Table A-61: acLDAPLostConnection

acLDAPLostConnection
1.3.6.1.4.1.5003.9.10.1.21.2.0.75
Minor

communicationsAlarm

communicationsSubsystemFailure

If a connection is idle for more than the maximum configured time in seconds that the
client can be idle before the LDAP server closes the connection, the LDAP server returns
an LDAP disconnect notification and this alarm is raised.

LDAP Lost Connection

This alarm is raised when there is no connection to the LDAP server

A.1.17.9 OCSP Server Status Alarm

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text

Corrective Action

Table A-62: acOCSPServerStatusAlarm

acOCSPServerStatusAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.78
Major / Clear
communicationsAlarm
communicationsSubsystemFailure
OCSP server alarm

= Repair the Online Certificate Status Protocol (OCSP) server
-OR-
= Correct the network configuration
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A.1.17.10IPv6 Error Alarm
Table A-63: aclPv6ErrorAlarm (Applicable only to E-SBC Series)

Alarm
OID

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Critical

Stays 'Critical'
until reboot.

A 'Clear' trap is
not sent.

aclPv6ErrorAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.53

Critical

System#0/Interfaces#<n>.

operationalViolation

communicationsProtocolError

Condition

Bad IPv6 address (already
exists)
disabled.

After the alarm is raised. -

A.1.17.11 Active Alarm Table Alarm

Alarm
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Major

Remains
‘Major' until
reboot. A
'Clear" trap is
not sent.

<text>

IP interface alarm: IPv6 -
configuration failed, IPv6 will be |

Corrective Action

Find a new IPV6 address.
Reboot the device.

Table A-64: acActiveAlarmTableOverflow

acActiveAlarmTableOverflow

1.3.6.1.4.15003.9.10.1.21.2.0.12

Sent when an active alarm cannot be entered into the Active Alarm table because the table is full.

Major

System#0<n>/AlarmManager#0

processingErrorAlarm

resourceAtOrNearingCapacity (43)

Condition <text>

Active alarm table
overflow

Too many alarms to fit
in the active alarm
table

After the alarm is -
raised

Corrective Action

=  Some alarm information may be lost but the ability of
the device to perform its basic operations is not
impacted.

= Areboot is the only way to completely clear a
problem with the active alarm table.

= Contact AudioCodes' Support Center at
support@audiocodes.com

Note that the status remains 'Major' until reboot as it
denotes a possible loss of information until the next
reboot. If an alarm is raised when the table is full, it is
possible that the alarm is active, but does not appear in
the active alarm table.
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A.1.17.12 Audio Staging from APS Server Alarm

A\

Note: Applicable only to Mediant 1000B series.

Alarm
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Table A-65: acAudioProvisioningAlarm

acAudioProvisioningAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.14

Sent if the device is unable to provision its audio.

Critical

System#0/AudioStaging#0

processingErrorAlarm

configurationOrCustomizationError (7)

Condition <text>

Corrective Action

Critical Media server times out | Unable to provision From the Audio Provisioning Server (APS)
waiting fora audio GUI, ensure that the device is properly

39‘39955.““' audio configured with audio and that the device

istribution from the

APS (Audio has been enabled.

Provisioning Server) Ensure that the IP address for the APS

Cleared After the alarm is i has been properly specified on the device.
raised, the media Ensure that both the APS server and
server is successfully application are in-service.

'f[’r:%'fr']%nzgg'th audio For more information regarding the
problem, view the Syslogs from the device
as well as the APS manager logs.
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A.1.18 Analog Port Alarms

A Note: These alarms are applicable only to Analog Series.

A.1.18.1 Analog Port SPI Out-of-Service Alarm
Table A-66: acAnalogPortSPIOutOfService

Alarm acAnalogPortSPIOutOfService
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.46
Default Severity Major
Source Varbind Text System#0/analogports#<n>, where n is the port number
Event Type physicalViolation
Probable Cause equipmentMalfunction
Alarm Severity Condition <text> Corrective Action
Major Analog port has gone out of Analog Port SPI out of service | ® No corrective action is
service required.
=  The device shuts down the
port and activates it again
when the Serial Peripheral
Interface (SPI) connection
returns.
Cleared Analog port is back in service | - -
A.1.18.2 Analog Port High Temperature Alarm
Table A-67: acAnalogPortHighTemperature
Alarm acAnalogPortHighTemperature
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.47
Default Severity Major
Source Varbind Text System#0/analogports#<n>, where n is the port number
Event Type physicalViolation
Probable Cause equipmentMalfunction
Alarm Severity Condition <text> Corrective Action
Major Analog device has reached Analog Port High Temperature | ®  No corrective action is
critical temperature. Device is required.
automatically disconnected. = The device shuts down the
analog port and tries to
activate it again later when
the device's temperature
drops.
Cleared Temperature is back to normal | - -

- analog port is back in service.
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A.1.18.3 Analog Port Ground Fault Out-of-Service Alarm

Alarm

OoID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Text

Corrective Action

Note

Table A-68: acAnalogPortGroundFaultOutOfService

acAnalogPortGroundFaultOutOfService

1.3.6.1.4.1.5003.9.10.1.21.2.0.76

Major / Clear

System#0/analogports#<n>, where n is the port number

physicalViolation

equipmentMalfunction (this alarm is raised when the FXS port is inactive due to a ground fault)

Analog Port Ground Fault Out Of Service

= No corrective action is required.
=  The device shuts down the port and tries to activate it again when the relevant alarm is over.

Relevant to FXS only.

A.1.19 Media Alarms

A.1.19.1 Media Process Overload Alarm

CE Note: This alarm is applicable only to the MSBR series, Mediant 1000B GW & SBC,

Mediant 2000, and Mediant 3000.

Alarm

OID

Description
Default Severity
Event Type

Probable Cause

Table A-69: acMediaProcessOverloadAlarm
acMediaProcessOverloadAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.81
Sent when there is overload of the device’s media processing and interfaces.
Major
environmentalAlarm

underlyingResourceUnavailable

Alarm Severity Condition <text> Corrective Action
Major Media Process Overload Alarm. %s = Avoid making new calls.
Although not corrective, this action
eventually causes the alarm to
drop.
Cleared - None
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A.1.19.2 Media Realm Bandwidth Threshold Alarm

A Note: This alarm is applicable only to Digital Series and E-SBC Series.

Alarm

OID

Default Severity

Event Type

Probable Cause
Alarm Severity

Major

Table A-70: acMediaRealmBWThresholdAlarm

acMediaRealmBWThresholdAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.87

ProcessingErrorAlarm

Raised when a bandwidth threshold is crossed

Condition <text> Corrective Action

- Media Realm BW Threshold Alarm Cleared when bandwidth threshold

returns to normal range

A.1.20 Network Monitoring (Probe) between Devices

A Note: This alarm is applicable only to Mediant 800B MSBR.

A.1.20.1 NQM Connectivity Alarm

Alarm

OID

Default Severity
Alarm Source
Event Type
Probable Cause
Alarm Severity

Minor

Table A-71: acNgmConnectivityAlarm

acNgmConnectivityAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.88

Board#%d/NgmSender#%d
communicationsSubsystemFailure

Raised when Connectivity with NQM probe destination is lost

Condition <text> Corrective Action
Connectivity with NQM probe Cleared when connectivity with the
destination is lost Noise Quality Measure (NQM) probe

destination is re-established
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A.1.20.2 NQM High RTT Alarm
Table A-72: acNgmRttAlarm

Alarm acNgmRttAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.89

Default Severity

Alarm Source Board#%d/NgmSender#%d

Event Type communicationsSubsystemFailure

Probable Cause Raised when Detected high RTT towards NQM probe destination
Alarm Severity Condition <text> Corrective Action

Minor - Detected high RTT towards NQM To correct long RTT (Round Trip Time):

probe destination = Test with traceroute.

= Contact your ISP with the
traceroute results.

= Use Wireshark or any other
diagnostic tool to perform a traffic
capture and determine who is
contaminating the network.

A.1.20.3 NQM High Jitter Alarm
Table A-73: acNgmJitterAlarm

Alarm acNgmJitterAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.90

Default Severity

Alarm Source Board#%d/NgmSender#%d

Event Type CommunicationsAlarm

Probable Cause Raised when Detected high Jitter towards NQM probe destination - thresholdCrossed
Alarm Severity Condition <text> Corrective Action
Minor - Detected high Jitter towards NQM To correct high jitter:

probe destination = Test with traceroute.

= Contact your Internet Service
Provider (ISP) with traceroute
results.

= Implement Quality of Service
(QoS).
= Note that there's no simple solution

for high jitter. A systemic level
solution may be required.
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A.1.20.4 NQM High Packet Loss Alarm
Table A-74: acNgmPacketLossAlarm

Alarm acNgmPacketLossAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.91

Default Severity

Alarm Source Board#%d/NgmSender#%d
Event Type CommunicationsAlarm
Probable Cause Raised when Detected high Packet Loss towards NQM probe destination
Alarm Severity Condition <text> Corrective Action
Minor - Detected high PL towards NQM probe | To correct high packet loss (PL):
destination

= Eliminate interference problems:
Distance your modem from
electrical devices

= Do not coil up any excess signal or
power cables.

= Check the statistics counters of
network nodes to determine where
loss is occurring. Typically, each
node in the network has a packet
loss counter. Isolate the network
segment where loss has been

occurring.
A.1.20.5 NQM Low Conversational MOS Alarm
Table A-75: acNgmCqgMosAlarm

Alarm acNgmCgMosAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.95

Default Severity

Alarm Source Board#%d/NgmSender#%d

Event Type communicationsAlarm

Probable Cause Raised when Detected low conversational voice quality towards NQM probe destination
Alarm Severity Condition <text> Corrective Action
Minor - Detected low conversational voice To fix the Noise Quality Measure

quality towards NQM probe destination | (NQM) result:

= Perform corrective action for jitter.
See Section A.1.20.3.

= Perform corrective action for Real
Time Protocol (RTP) packet loss.
See Section A.1.20.4.

= Perform corrective action for long
Round-Trip Time (RTT) - the time it
takes for packets to travel from
source to destination.
See Section A.1.20.2.

To fix the poor Conversational Quality
(CQ) that the test indicates:

= Try changing the coder
= Try using RTP-Redundancy

= Perform corrective action for RTP
packet loss.
See Section A.1.20.4.
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A.1.20.6 NQM Low Listening MOS Alarm
Table A-76: acNgmLgMosAlarm

Alarm acNgmLgMosAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.96

Default Severity

Alarm Source Board#%d/NgmSender#%d
Event Type communicationsAlarm
Probable Cause Raised when detected low listening voice quality towards NQM probe destination
Alarm Severity Condition <text> Corrective Action
Minor - Detected low listening voice quality To fix the Noise Quality Measure
towards NQM probe destination (NQM) result:

= Perform corrective action for Real
Time Protocol (RTP) packet loss.

See Section A.1.20.4.

To fix the poor listening quality that the
test indicates:

=  Try changing the coder
= Try using RTP-Redundancy

= Perform corrective action for RTP
packet loss.

See Section A.1.20.4.

A.1.21 Intrusion Detection Alarms

A.1.21.1 IDS Policy Alarm
Table A-77: acIDSPolicyAlarm

Alarm aclDSPolicyAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.99

The alarm is raised whenever a threshold is crossed in the IDS system.

Description . . ) .
The alarm is associated with the MO pair IDSMatch & IDSRule.

Default Severity
Event Type Other
Probable Cause

Policy NUM (NAME) minor/major/critical threshold (NUM) of REASON cross in

AT e global/ip/ip+port scope (triggered by IP)

Status Changes

1. Identify additional traps (aclDSThresholdCrossNotification) that were sent
alongside this Intrusion Detection System (IDS) alarm.

2. Locate the remote hosts (IP addresses) that are specified in the traps.

Corrective Action 3. Examine the behavior of those hosts (with regard to the reason specified in the
alarm), and attempt to fix incorrect operation.

4.  If necessary, change the configured thresholds in the IDS Rule table under the
IDS Policy table.
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A.1.22 SAS Alarms

A.1.22.1 Emergency Mode Alarm

Alarm

OID

Description

Default Severity
Event Type
Probable Cause

Alarm Text

Status Changes

Corrective Action

Table A-78: acGWSASEmergencyModeAlarm

acGWSASEmergencyModeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.59

Sent by the Stand-Alone Survivability (SAS) application when switching from “Normal”
mode to “Emergency" mode. This alarm is cleared once the SAS returns to “Normal”
mode.

Note: Applicable only to Analog and Digital Series.

Other

Other

Sent by the Stand-Alone Survivability (SAS) application when switching from 'Normal'
mode to 'Emergency' mode. The alarm is cleared once the SAS returns to 'Normal'
mode.

= This alarm is only for informative purposes.

= No corrective action is required.

A.1.23 High-Availability (HA)

Note: These SNMP events are applicable only to devices that support the High-
Availability (HA) feature.

A.1.23.1 Redundant Board Trap

Trap
OID

Description

Default Severity
Event Type
Probable Cause
Condition

Trap Text

Table A-79: acRedundantBoardAlarm

acRedundantBoardAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.97

Active board sends notification when an alarm or natification is raised in the redundant
board.

Indeterminate
Other (0)
Other (0)

Alarm or natification is raised in the redundant board
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A.1.23.2 HA Network Watchdog Status Alarm

Note: This SNMP event is applicable to all HA-supporting devices except Mediant 3000.

Table A-80: acHANetworkWatchdogStatusAlarm

Trap
OID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause
Trap Text

Failed sending ping

Network watchdog is disabled
while HA priority is in use

Network watchdog is disabled
while Redundant units has
less Eth groups available

Disabling network watchdog
due to network interface error
in Redundant unit

acHANetworkWatchdogStatusAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.98

This alarm indicates that the device's HA Network Reachability (network watchdog)
feature is configured, but is not functioning correctly due to, for example, the Ethernet
Group being down from where the ping is sent to the network entity.

The device's HA Network Reachability feature is used to configure a network IP address
to test reachability using pings. When the tested peer stops replying to the Active unit, a
switchover is made to the Redundant unit. For configuring the HA Network Reachability
feature, refer to the User's Manual.

Major
System#0/Module#<m>, where m is the blade module’s slot number
alarmTrap
outOfService
Condition Corrective Action

Some network configuration error -

When HA Priority is in use, the network -
watchdog module is disabled

One or more of the Redundant unit's Ethernet | -
Groups are down

One or more of the Redundant unit's Ethernet -
Groups are down
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A.1.23.3 Hitless Software Upgrade Status Trap

Note: Applicable only to Mediant 500 E-SBC, Mediant 800B Gateway & E-SBC, Mediant
3000, Mediant 2600 E-SBC, Mediant 4000 SBC, Mediant 9000 SBC, and Mediant
Software SBC.

Alarm

OID
Description

Default Severity
Event Type
Probable Cause
Source

Trap Text

"Hitless: Start software
upgrade.”

"Hitless: SW upgrade
ended successfully.”

"Hitless: Invalid cmp file -
missing Ver parameter.”

"Hitless fail: SW ver
stream name too long."

Note: Applicable only to
Mediant 3000.

"Hitless fail: Invalid cmp
file - missing UPG
parameter."”

"Hitless fail: Hitless SW
upgrade not supported.”

Table A-81: acHitlessUpdateStatus

acHitlessUpdateStatus

1.3.6.1.4.1.5003.9.10.1.21.2.0.48

A notification trap sent at the beginning and end of a Hitless Software Upgrade. Failure during
the software upgrade also activates the trap.

Indeterminate

Other (0)

Other (0)

Automatic Update
Condition

Hitless Upgrade has begun.

Successful Hitless Upgrade.

Hitless Upgrade failed because the
cmp file is invalid. The cmp file's
version parameter is incorrect.

Hitless Upgrade failed because the
cmp file is invalid. The number of
characters defining the software
version stream name in the cmp file
has been exceeded.

Hitless Upgrade failed because the
cmp file is invalid. An upgrade
parameter is missing from the file.

Hitless Upgrade failed because the
cmp file is invalid. The cmp file does
not support Hitless Upgrade of the
current software version to the new
software version.

Corrective Action

Corrective action is not required

Corrective action is not required

Replace the cmp file with a valid one.

Replace the cmp file with a valid one

Replace the cmp file with a valid one.

Replace the cmp file with a valid one that supports hitless
upgrade of the software from the current version to the

new one.
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Default Severity
Event Type
Probable Cause
Alarm Text

Status Changes

Corrective Action

A.2.2

Alarm

OID

Description
Default Severity
Event Type

Probable Cause
Alarm Text

Status Changes

Corrective Action

A.2 Event Traps (Notifications)
This subsection details traps that are not alarms. These traps are sent with the severity
varbind value of ‘Indeterminate’. These traps don't ‘Clear’ and they don't appear in the alarm
history or active tables. (The only log trap that does send 'Clear is
acPerformanceMonitoringThresholdCrossing).
A.2.1 IDS Threshold Cross Notification
Table A-82: acIDSThresholdCrossNotification
Alarm aclDSThresholdCrossNotification
oID 1.3.6.1.4.1.5003.9.10.1.21.2.0.100
Description Sent for each scope (IP or IP+Port) crossing a threshold of an active alarm.
Description The trap is sent for each scope (IP or IPport) crossing a threshold of an active alarm.

Other

Threshold cross for scope value IP. Severity=minor/major/critical. Current value=NUM

1. Identify the remote host (IP address / port) on the network which the Intrusion
Detection System (IDS) has indicated is malicious.

Note that the IDS determines a host to be malicious if it has reached or exceeded
a user-defined threshold of malicious attacks (counter).

2. Block the malicious activity.

IDS Blacklist Notification

Table A-83: acIDSBlacklistNotification

aclDSBIlacklistNotification

1.3.6.1.4.1.5003.9.10.1.21.2.0.101

securityServiceOrMechanismViolation
thresholdCrossed

Added IP * to blacklist
Removed IP * from blacklist

Identify the malicious remote host (IP address / port) that the Intrusion Detection
System (IDS) has automatically blacklisted or removed from the blacklist.

Note that a host is determined to be malicious if it has reached or exceeded a user-
defined threshold of malicious attacks (counter). The malicious source is automatically
blacklisted for a user-defined period, after which it is removed from the blacklist.
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A.2.3 Web User Access Denied due to Inactivity Trap
Table A-84: acWebUserAccessDisabled

Alarm acWebUserAccessDisabled

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.93

Default Severity Indeterminate

Event Type

Probable Cause Sent when Web user was disabled due to inactivity
Alarm Text

Status Changes

Contact your Web security administrator. Only the Web security administrator can
unblock a user whose access to the Web interface was denied (for example, because
the user made 3 unsuccessful attempts at access).

The Web security administrator must:

1. Inthe Web interface, access the Accounts page (Configuration > System >
Management > Web User Accounts).

2. lIdentify in the list of users table that user whose access has been denied.
Change the status of that user from Blocked to Valid or New.

Corrective Action

A.2.4 Power-Over-Ethernet Status Trap

A Note: This alarm is applicable only to Mediant 800B MSBR.

Table A-85: acPowerOverEthernetStatus

Trap acPowerOverEthernetStatus

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.80

Description Sent when Power over Ethernet (PoE) for a specific port is disabled.
Default Severity Indeterminate

Event Type environmentalAlarm

Probable Cause underlyingResourceUnavailable

Trap Text “POE Port %d Was Not Powered Due To Power Management”

where %d is the Ethernet port number

Condition This trap is sent when insufficient power is available for a plugged-in PoE client in a PoE-
enabled LAN port.

Trap Status Trap is sent
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A.2.5 Keep-Alive Trap

Trap
OID

Description

Default Severity
Event Type
Probable Cause
Trap Text
Status Changes

Condition

Trap Status

Note

Table A-86: acKeepAlive

acKeepAlive
1.3.6.1.4.1.5003.9.10.1.21.2.0.16

Part of the NAT traversal mechanism. If the STUN application in the device detects a
NAT, this trap is sent on a regular time laps - 9/10 of the acSysSTUNBindingLifeTime
object. The Additionallnfol varbind has the MAC address of the device.

Indeterminate
other (0)
other (0)

Keep alive trap

The STUN client is enabled and identified as a NAT device or doesn'’t locate the STUN
server. The ini file contains the following line ‘SendKeepAliveTrap=1'

Trap is sent

Keep-alive is sent every 9/10 of the time defined in the parameter
NatBindingDefaultTimeout.

A.2.6 Performance Monitoring Threshold-Crossing Trap

Trap
OID

Description

Default Severity
Event Type
Probable Cause

Trap Text

Status Changes

Condition

Trap Status
Condition

Trap Status

Table A-87: acPerformanceMonitoringThresholdCrossing

acPerformanceMonitoringThresholdCrossing
1.3.6.1.4.1.5003.9.10.1.21.2.0.27

Sent every time the threshold of a Performance Monitored object (‘Minimum', 'Average’,
‘Maximum', 'Distribution below/above/between thresholds', and 'Low and high thresholds")
is crossed. The severity field is ‘'Indeterminate’ when the crossing is above the threshold
and 'Cleared’' when it goes back under the threshold. The 'Source' varbind in the trap
indicates the object for which the threshold is being crossed.

Indeterminate
other (0)
other (0)

"Performance: Threshold trap was set”, with source = name of performance counter
which caused the trap

A performance counter (for the attributes 'Minimum', 'Average', 'Maximum', 'Distribution
below/above/between thresholds', and '‘Low and high thresholds') has crossed the high
threshold.

Indeterminate
A performance counter has returned to under the threshold

Cleared
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A.2.7 HTTP Download Result Trap
Table A-88: acHTTPDownloadResult

Trap acHTTPDownloadResult

OoID 1.3.6.1.4.1.5003.9.10.1.21.2.0.28

Description Sent upon success or failure of the HTTP Download action.
Default Severity Indeterminate

Event Type processingErrorAlarm (3) for failures and other (0) for success.
Probable Cause other (0)

Status Changes

Condition Successful HTTP download.

Trap Text HTTP Download successful

Condition Failed download.

Trap Text HTTP download failed, a network error occurred.

Note There are other possible textual messages describing NFS failures or success, FTP

failure or success.

A.2.8 Dial Plan File Replaced Trap

A Note: This alarm is applicable only to Digital Series.

Table A-89: acDialPlanFileReplaced

Alarm acDialPlanFileReplaced

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.45
Default Severity Indeterminate

Event Type Other (0)

Probable Cause Other (0)

Status Change
Condition Successful dial plan file replacement

Trap Text Dial plan file replacement complete.
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A.2.9 Hitless Software Upgrade Status Trap

A Note: This alarm is applicable only to Mediant 3000.

Alarm

OID

Default Severity
Event Type
Probable Cause
Source

Status Changes
Condition

Trap Text

Condition

Trap Text

A.2.10 Secure Shell

Alarm

OID

Default Severity
Event Type

Probable Cause

Alarm Text

Status Changes

Condition
<text> Value

Condition

Table A-90 acHitlessUpdateStatus
acHitlessUpdateStatus

1.3.6.1.4.1.5003.9.10.1.21.2.0.48
Indeterminate

Other (0)

Other (0)

Automatic Update

Successful SW upgrade
Hitless: SW upgrade ended successfully
Failed SW upgrade

Hitless fail: Waiting for module in slot <n> to burn new SW and reboot Timed out. (n —
slot number).

(SSH) Connection Status Trap
Table A-91: acSSHConnectionStatus

acSSHConnectionStatus
1.3.6.1.4.1.5003.9.10.1.21.2.0.77
indeterminate
environmentalAlarm

other

"SSH logout from IP address <IP>, user <user>"
"SSH successful login from IP address <IP>, user <user> at: <IP>:<port>"

"SSH unsuccessful login attempt from IP address <IP>, user <user> at: <IP>:<port>.
<reason>"

"WEB: Unsuccessful login attempt from <IP> at <IP>:<port>. <reason>"

SSH connection attempt

%s — remote IP
%s — user name

SSH connection attempt — success of failure

User's Guide

162 Document #: LTRT-30808



User's Guide

A. SNMP Traps

A.2.11 SIP Proxy Connection Lost Trap

Table A-92: acProxyConnectionLost

Alarm acProxyConnectionLost

OoID 1.3.6.1.4.1.5003.9.10.1.21.2.0.94

Description Sent when all connections in a specific Proxy Set are down. The trap is cleared when one
of the Proxy Set connections is up.

Source Varbind Text System#0

Alarm Text Proxy Set Alarm <text>

Event Type communicationsAlarm

Probable Cause = Network issue (connection fail due to network/routing failure).

= Proxy issue (proxy is down).
= AudioCodes device issue.

Alarm Severity
Severity Condition

Major When connection to the Proxy
Set is lost and this Proxy Set is
configured with fallback to
routing table.

Major When Proxy Set includes more
than one proxy IP with
redundancy and connection to
one of them is lost.

Cleared When connection to proxy is
available again

<text>

Proxy Set %d: Proxy
not found. Use
internal routing

Proxy Set %d: Proxy
lost. looking for
another proxy

Proxy found. ip:<IP
address>:<port #>
Proxy Set ID %d

Corrective Action

Ping the proxy server. If there is no ping, contact
your proxy provider. The probable reason is the
proxy is down.

Ping between the proxy and AudioCodes device.
If there is no ping, the problem could be a
network/router issue.

If you have more than one device connected to
this same proxy, check if there are more
AudioCodes devices with the same Alarm. If this
is the case, this could confirm that this is not
AudioCodes device issue.

Check that routing using the device's (internal)
routing table is functioning correctly.

Contact AudioCodes support center
(support@audiocodes.com) and send a syslog
and network capture for this issue.

Ping the proxy server. If there is no ping, contact
your proxy provider. The probable reason is the
proxy is down.

Ping between the proxy and AudioCodes device.
If there is no ping, the problem could be a
network/router issue.

If you have more than one device connected to
this same proxy, check if there are more
AudioCodes devices with the same Alarm. If this
is the case, this could confirm that this is not
AudioCodes device issue.

Check if routing via the redundant proxy is
operating correctly. If it is, then this could mean
that it's not a network issue.

Contact AudioCodes support center
(support@audiocodes.com) and send a syslog
and network capture for this issue.
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A.2.12 TLS Certificate Expiry Trap

Table A-93: acCertificateExpiryNotifiaction Trap

Alarm

OID

Description

Source Varbind Text
Alarm Text

Event Type
Probable Cause
Alarm Severity

Severity Condition

acCertificateExpiryNotifiaction
1.3.6.1.4.1.5003.9.10.1.21.2.0.92

Sent before (in days) the expiration of the installed certificate credentials, which cannot
be renewed automatically.

System#0
environmentalAlarm
The certificate key expired (keyExpired)

acCertificateExpiryNotifiaction

<text> Corrective Action

Intermediate | The certificate | Either: Load a new certificate to the device before the

key is aboutto |
expire.

The device certificate has expired expiration of the installed certificate (which cannot be
%d days ago -OR- renewed automatically).

The device certificate will expire
in %d days -OR-

The device certificate will expire
in less than 1 day

To replace certificates, refer to the section 'Replacing
the Device's Certificate' in the User's Manual.

%d — number of days

A.2.13 Cold Start Trap

Trap Name
OID
MIB

Note

Table A-94: coldStart

ColdStart

1.3.6.1.6.3.1.1.5.1

SNMPv2-MIB

This is a trap from the standard SNMP MIB.

A.2.14 Authentication Failure Trap

Table A-95: authenticationFailure

Trap Name authenticationFailure
OID 1.3.6.1.6.3.1.1.5.5
MIB SNMPv2-MIB
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A.2.15 Board Initialization Completed Trap
Table A-96: acBoardEvBoardStarted

Trap Name acBoardEvBoardStarted

OoID 1.3.6.1.4.1.5003.9.10.1.21.2.0.4

Description Sent after the device is successfully restored and initialized following reset.
MIB AcBoard

Severity cleared

Event Type equipmentAlarm

Probable Cause Other(0)

Alarm Text Initialization Ended

Note This is the AudioCodes Enterprise application cold start trap.

A.2.16 Configuration Change Trap
Table A-97: entConfigChange

Trap Name entConfigChange
OID 1.3.6.1.2.1.4.7.2
MIB ENTITY-MIB

A.2.17 Link Up Trap
Table A-98: linkUp

Trap Name linkUp
OID 1.3.6.1.6.3.1.1.5.4
MIB IF-MIB

A.2.18 Link Down Trap
Table A-99: linkDown

Trap Name linkDown
OID 1.3.6.1.6.3.1.1.5.3
MIB IF-MIB
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A.2.19 D-Channel Status Trap

A Note: This alarm is applicable only to Digital Series.

Table A-100: AcDChannelStatus

Trap Name acDChannelStatus
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.37
Description Non-alarm trap sent at the establishment, re-establishment or release of LAPD link with

its peer connection occurs. The trap is sent with one of the following textual descriptions:
= D-channel synchronized
= D-channel not-synchronized

MIB AcBoard

Severity Minor

Event Type communicationsAlarm

Probable Cause communicationsProtocolError

Alarm Text D-Channel Trap.

Source Trunk <m> where m is the trunk number (starts from 0).

Status Changes

Condition D-Channel un-established.

Trap Status Trap is sent with the severity of 'Minor'.
Condition D-Channel established.

Trap Status Trap is sent with the severity of 'Cleared'.
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A.2.20 Enhanced BIT Status

A Note: This alarm is not applicable to MSBR.

Alarm
OID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Text

Status Changes
Additional Info-1
Additional Info-2

Additional Info-3

Corrective Action

Table A-101: AcDChannelStatus

acEnhancedBITStatus
1.3.6.1.4.1.5003.9.10.1.21.2.0.18

Sent for the status of the BIT (Built In Test). The information in the trap contains blade
hardware elements being tested and their status. The information is presented in the
Additional Info fields.

Indeterminate
BIT

Other

other (0)

Notification on the board hardware elements being tested and their status.

BIT Type: Offline, startup, perodic

BIT Results:

BIT_RESULT_PASSED
BIT_RESULT_FAILED

Buffer: Number of bit elements reports

Not relevant
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B Performance Monitoring Counters

This section lists the supported SNMP PM counters. These counters are polled by the SCOM
at default interval of 15 minutes. In the SCOM, the PM data that is polled from the
AudioCodes devices is represented in the SCOM by the following entities:

B Rules: Each counter is represented by a separate rule. For example, "Attempted Calls
IP2Tel Counter Rule".

B Threshold Monitors: Each counter includes a corresponding pair of threshold
monitors (High Threshold Monitor and a Low Threshold Monitor). For example,
"Attempted Calls IP2Tel High Threshold Monitor" and "Attempted Calls IP2Tel Low
Threshold Monitor"

The SCOM supports the following PM counter groups:
B |P-to-Tel Performance Monitors. See below.

B Tel-to-IP Performance Monitors. See Section B.2 on page 170.

B SBC Performance Monitors. See Section B.3 on page 171.

For more information, see Section 7.5 on page 82.

B.1 IP-to-Tel Performance Monitoring

The table below describes the SIP IP-to-Tel Performance Monitoring counters.

A\

Note: These PM counters are not applicable to Mediant 4000.

Table B-1: SIP IP-to-Tel Performance Monitoring

SCOM Name

Attempted Calls IP2Tel High
Threshold Monitor

Attempted Calls IP2Tel Low
Threshold Monitor

Established Calls IP2Tel High
Threshold Monitor

Established Calls IP2Tel Low
Threshold Monitor

Busy Calls IP2Tel High Threshold
Monitor

Busy Calls IP2Tel Low Threshold
Monitor

No Answer Calls IP2Tel High
Threshold Monitor

No Answer Calls IP2Tel Low
Threshold Monitor

Forwarded Calls IP2Tel High
Threshold Monitor

Forwarded Calls IP2Tel Low
Threshold Monitor

Counter (MIB Name)

acPMSIPAttemptedCallsVal

acPMSIPEstablishedCallsVal

acPMSIPBusyCallsVal

acPMSIPNoAnswerCallsVal

acPMSIPForwardedCallsVal

Description

Indicates the number of attempted calls for
IP to Tel direction, during last interval.

Indicates the number of established calls
for IP to Tel direction, during last interval.

Indicates the number of calls that failed as
a result of a busy line for IP to Tel direction,
during last interval.

Indicates the number of calls that weren't
answered for IP to Tel direction, during last
interval.

Indicates the number of calls that were
terminated due to a call forward for IP to
Tel direction, during last interval.
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SCOM

SCOM Name

No Route Calls IP2Tel High
Threshold Monitor

No Route Calls IP2Tel Low
Threshold Monitor

No Match Calls IP2Tel High
Threshold Monitor

No Match Calls IP2Tel High
Threshold Monitor

No Resources Calls IP2Tel High
Threshold Monitor

No Resources Calls IP2Tel Low
Threshold Monitor

SIPFailCalls IP2Tel High Threshold
Monitor

SIPFailCalls IP2Tel Low Threshold
Monitor

Counter (MIB Name)

acPMSIPNoRouteCallsVal

acPMSIPNoMatchCallsVal

acPMSIPNoResourcesCallsVal

acPMSIPFailCallsVal

Description

Indicates the number of calls whose
destinations weren't found for IP to Tel
direction, during last interval.

Indicates the number of calls that failed
due to mismatched media server
capabilities for IP to Tel direction, during
last interval.

Indicates the number of calls that failed
due to unavailable resources or a media
server lock for IP to Tel direction, during
last interval.

This counter is incremented as a result of
calls that fail due to reasons not covered by
the other counters for IP to Tel direction,
during last interval.

B.2 SIP Tel-to-IP Performance Monitoring

This table below describes the SIP Tel-to-IP PM counters supported by the SCOM.

Note: These PM counters are not applicable to Mediant 4000.

Table B-2: SIP Tel-to-IP Performance Monitoring

SCOM Name

Attempted Calls Tel2IP High
Threshold Monitor

Attempted Calls Tel2IP Low
Threshold Monitor

Established Calls Tel2IP High
Threshold Monitor

Established Calls Tel2IP Low
Threshold Monitor

Busy Calls Tel2IP High Threshold
Monitor

Busy Calls Tel2IP Low Threshold
Monitor

No Answer Calls Tel2IP High
Threshold Monitor

No Answer Calls Tel2IP Low
Threshold Monitor

Forwarded Calls Tel2IP High
Threshold Monitor

Forwarded Calls Tel2IP Low
Threshold Monitor

Counter (MIB Name)

acPMSIPAttemptedCallsVal

acPMSIPEstablishedCallsVal

acPMSIPBusyCallsVal

acPMSIPNoAnswerCallsVal

acPMSIPForwardedCallsVal

Description

Indicates the number of attempted calls for
Tel to IP direction, during last interval.

Indicates the number of established calls
for Tel to IP direction, during last interval.

Indicates the number of calls that failed as
a result of a busy line for Tel to IP direction,
during last interval.

Indicates the number of calls that weren't
answered for Tel to IP direction, during last
interval.

Indicates the number of calls that were
terminated due to a call forward for Tel to
IP direction, during last interval.
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SCOM Name

No Route Calls Tel2IP High
Threshold Monitor

No Route Calls Tel2IP Low
Threshold Monitor

No Match Calls High Threshold
Monitor

No Match Calls Low Threshold
Monitor

No ResourcesCalls Tel2IP High
Threshold Monitor

No ResourcesCalls Tel2IP Low
Threshold Monitor

FailCalls Tel2IP High Threshold
Monitor

FailCalls Tel2IP Low Threshold
Monitor

B.3

Counter (MIB Name)

acPMSIPNoRouteCallsVal

acPMSIPNoMatchCallsVal

acPMSIPNoResourcesCallsVal

acPMSIPFailCallsVal

SBC Performance Monitoring

Description

Indicates the number of calls whose
destinations weren't found for Tel to IP
direction, during last interval.

Indicates the number of calls that failed
due to mismatched media server
capabilities for Tel to IP direction, during
last interval.

Indicates the number of calls that failed
due to unavailable resources or a media
server lock for Tel to IP direction, during
last interval.

This counter is incremented as a result of
calls that fail due to reasons not covered by
the other counters for Tel to IP direction,
during last interval.

This table below describes the SBC PM counters supported by the SCOM.

Note:

e This section applies to the E-SBC series only.
e Only the 'IP Group Invite Dialogs' counter is by default enabled.

e Other counters are by default not enabled in order to optimize SCOM performance.
Selectively enable Performance Monitors.

Table B-3: SBC Call Admission Control Performance Monitoring

SCOM Name

SRD Dialogs High Threshold
Monitor

SRD Dialogs Low Threshold Monitor

SRD Invite Dialogs High Threshold
Monitor

SRD Invite Dialogs Low Threshold
Monitor

SRD Subscribe Dialogs High
Threshold Monitor

SRD Subscribe Dialogs Low
Threshold Monitor

SRD Other Dialogs High Threshold
Monitor

SRD Other Dialogs Low Threshold
Monitor

Group Dialogs High Threshold
Monitor

Counter (MIB Name)

acPMSIPSRDDialogsTable

acPMSIPSRDInviteDialogsTable

acPMSIPSRDSubscribeDialogsTable

acPMSIPSRDOtherDialogsTable

acPMSIPIPGroupDialogsTable

Description

Indicates all dialogs currently being
handled by the SBC per SRD.

Indicates all calls (initiated by
SIP:INVITE) currently being handled
by the SBC per SRD.

Indicates all SUBSCRIBE dialogs
(initiated by SIP:SUBSCRIBE)
currently being handled by the SBC
per SRD.

Indicates dialogs other than INVITE
and SUBSCRIBE (initiated by
SIP:REGISTER) currently being
handled by the SBC per SRD.

Indicates all dialogs currently being
handled by the SBC per IP Group
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SCOM

SCOM Name

Group Dialogs Low Threshold
Monitor

Group Invite Dialogs High Threshold
Monitor

Group Invite Dialogs Low Threshold
Monitor

Group Subscribe Dialogs High
Threshold Monitor

Group Subscribe Dialogs Low
Threshold Monitor

Group Other Dialogs High
Threshold Monitor

Group Other Dialogs Low Threshold
Monitor

Group In Invite Dialogs High
Threshold Monitor

Group In Invite Dialogs Low
Threshold Monitor

Group Subscribe Dialogs High
Threshold Monitor

Group Subscribe Dialogs Low
Threshold Monitor

Group Out Invite Dialogs High
Threshold Monitor

Group Out Invite Dialogs Low
Threshold Monitor

Group Out Subscribe Dialogs High
Threshold Monitor

Group Out Subscribe Dialogs Low
Threshold Monitor

Invited Dialogs High Threshold
Monitor

Invited Dialogs Low Threshold
Monitor

Subscribe Dialog High Threshold
Monitor

Subscribe Dialog Low Threshold
Monitor

SBC Registered Users High
Threshold Monitor

SBC Registered Users Low
Threshold Monitor

Counter (MIB Name)

acPMSIPIPGrouplnviteDialogsTable

acPMSIPIPGroupSubscribeDialogsTable

acPMSIPIPGroupOtherDialogsTable

acPMSIPIPGrouplninviteDialogsTable

acPMSIPIPGrouplInSubscribeDialogsTabl
e

acPMSIPIPGroupOutinviteDialogsTable

acPMSIPIPGroupOutSubscribeDialogsTa

ble

acPMSIPInvitedDialogsTable

acPMSIPSubscribeDialogTable

acPMSBCRegisteredUsersTable

Description

Indicates all calls (initiated by
SIP:INVITE) currently being handled
by the SBC per IP Group

Indicates all SUBSCRIBE dialogs
(initiated by SIP:SUBSCRIBE)
currently being handled by the SBC
per IP Group

Indicates all other dialogs other than
INVITE and SUBSCRIBE (initiated
by SIP:REGISTER) currently being
handled by the SBC per IP Group

Indicates the number of incoming
calls (SIP INVITE) per IP Group

Indicates the number of incoming
SUBSCRIBE dialogs per IP Group

Indicates the number of outgoing
calls (SIP INVITE) per IP Group.

Indicates the number of outgoing
SUBSCRIBE dialogs per IP Group.

Indicates the number of calls (SIP
INVITE).

Indicates the number of
SUBSCRIBE dialogs.

Indicates the number of registered
users.
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C

Optimizing SCOM Server Load-Example
Scenario

This appendix describes how to balance the loading of the AudioCodes MP-related functional
items (Discoveries, Monitors and Rules) running on the SCOM server. For each functional
item launched, a script is run. Each script represents an equivalent CPU utilization
percentage. This appendix presents a scenario with models of gateways with different
numbers of trunks. The scenario shows the affect on the CPU utilization both before and
after load balancing is performed. Load balancing is achieved by overriding the polling
frequency and Sync time for each functional item (see Chapter 8 on page 91).

C.1 Default Loading
The following describes the default loading for the different monitored AudioCodes gateway
models:
B Six gateways with six modules where each module includes one trunk, one Fan Tray
module and one power supply module— type A.
B Six gateways with six modules where each module includes four trunks, one Fan Tray
module and one power supply module — type B.
B Six gateways with six modules where each module includes 16 trunks, one Fan Tray
module and one power supply module — type C.
The table below shows the maximum number of scripts that are run for each of the SCOM
elements for the different AudioCodes MP-related objects.
Table C-1: Management Pack Objects and Number of Scripts Run
Management Pack Discoveries Monitors Performance
Object
Gateway One discovery with 1 80 monitors with | 26 performance counters with 26
script. 52 scripts. scripts.
Module three discoveries with two monitors with | -
two scripts. no scripts (Fan
Tray has one
monitor with no
scripts).
Trunk two discoveries with two ' eight monitors Three rules with three scripts.
scripts. with no scripts.
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C.2  Script Load Estimation
The tables below describe the different script load estimations for the different models that
are described in Section C.1 on page 173.

C.2.1 Type A Gateways

The following table describes the script load estimations for Type A Gateway models.

Table C-2: Type A Gateways

Management Gateway Scripts Module Trunk Scripts Total
Pack Object Scripts
Discovery 1 16 12 29
Monitors 52 0 0 52
Performance 26 0 18 54
Counters
Total 143

C.2.2 Type B Gateways

The following table describes the script load estimations for Type B Gateway models.

Table C-3: Type B Gateways

Management Gateway Scripts Module Trunk Scripts Total
Pack Object Scripts
Discovery 1 16 48 65
Monitors 52 0 0 52
Performance 26 0 72 98
Counters
Total 215
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C.2.3 Type C Gateways

The following table describes the script load estimations for Type C Gateway models.

Table C-4: Type C Gateways

Management Gateway Scripts Module Trunk Scripts Total
Pack Object Scripts
Discovery 1 16 192 209
Monitors 52 0 0 52
Performance 26 0 288 316
Counters
Total 577
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C.3 Load Analysis

The figure below shows a comparison of the number of scripts that are run (Y-axis) for the
different model types (described in Section C.1 on page 173).

The key observation from the graph is that an increasing number of trunks significantly
affects the number of loaded scripts.

Figure C-1: Load Analysis
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The following summarizes the specific limitations and restrictions on possible frequencies for
different kinds of processes:

Performance counters rules (see Section 7.6 on page 83) have to be launched
precisely every 15 minutes due to their dependency on SNMP counters on devices.
For example, Tel2IP Calls.

High and Low Threshold Monitors must also be launched precisely every 15 minutes
due to their dependency on SNMP counters on devices. For example, Tel2IP Calls
High Threshold Monitor and Tel2IP Calls Low Threshold Monitor.

Trunk monitor rules 'Audiocodes Digital Trunk Available Channels Counter Rule' and
'Audiocodes Digital Trunk Blocked Channels' Counter Rule and the corresponding
threshold monitors 'Audiocodes Blocked Channels High Threshold Monitor' and
'‘Audiocodes Free Channels Low Threshold Monitor' by default are launched once per
minute. This is due to the relatively large number of trunk objects and their dynamic
states. For more information, see Section 8.1.4 on page 102.

Discoveries for Gateways and Modules can be launched at very low polling
frequencies because the probability of any parameter changing is low to impossible.
At the same time, the trunks discoveries should be launched much more frequently
since the probability of any parameter modification is relatively higher.
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C.3.1 Script Execution Without Load Balancing

The figure below shows the number of scripts executed (Y-axis) over a 60 second time period
(X-axis) without load balancing.

The key observation from the figure is that aproximately once every 15 minutes, there is a
peak in the script execution due to the running of the counter rules and threshold monitor

scripts.
Figure C-2: Non-Balanced Script Execution
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C.3.2 Script Execution with Load Balancing

For the implementation of load balancing, it is recommended to make the following overrides:

B Since gateways and modules do not need to be frequently discovered, it is
recommended to set the launching of these processes to once per 60 minutes.

B For the discoveries of trunks, it is recommended to set their launching to once every
three minutes (instead of the one minute default).

B All performance measurements (counter rules) and gateway threshold monitors
should still be launched once per 15 minutes.

B Performance measurements of trunks (see Section 8.1.4 on page 102) are not
dependent on PM counters of devices; and in the SCOM indicate which trunk
channels are in-service and which trunk channels are out-of-service. Therefore, we
recommend to reduce the polling frequency for running these scripts from the default
one minute to once every three minutes.

The overidding of Discoveries, Monitors and Rules are described in Section 8 on page 91.

C.3.2.1 Script Execution Without Overriding Sync Time

The figure below shows the number of scripts executed (Y-axis) run over a one minute time
axis (X-axis) following the modifications described above (without overidding the Sync time
values).

The key observation of the figure shows an improvement; however, there are still a lot of
loading peaks.

Figure C-3: Frequency Without Syncronization
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C.3.2.2 Script Execution when Overriding Sync Time

This section describes how to modify the Synchronization time. Highest peaks are defined
as peaks when gateway counters and monitors are executed. It is possible to modify them
so every counter and monitor will have its own designated minute of synchronization where
the starting minute will be the second minute because discoveries of gateways and modules
will be executed at the first minute of an hour.

The table below shows an example of setting a sequence of different Sync times for the
different counters.

Table C-5: Sync Time Sequence

Counter Sync Time
AttemptedCalls 00:01
BusyCalls 00:02
EstablishedCalls 00:03
FailCalls 00:04
ForwardedCalls 00:05
IPGroupDialogs 00:06
IPGrouplnviteDialogs 00:07
NoAnswerCalls 00:08
NoMatchCalls 00:09
NoResourcesCalls 00:10
NoRouteCalls 00:11
SRDDialogs 00:12
SRDOtherDialogs 00:13
SRDSubscribeDialogs 00:14

In addition, note the following:

B The corresponding threshold monitors of the above-mentioned counters will have the
same minute of synchronization.

B There are 252 discoveries of trunks with scripts that represent 35% of all remaining
scripts. Let's set their synchronization minute to 00:01.

B Atthe same time, there are 288 performance measuring rules of gateways of type C
that represent 40% of all remaining counters. Let's set their synchronization time to
00:02.
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The figure below shows the results following the above modifications.

The key observation of the figure is that peaks are much lower and smoother over the time
axis, which consequently implies lower CPU utilization.

Figure C-4: Frequency and Sync
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C.3.3

Resource Monitor

You can monitor the running SCOM processes in the SCOM Server Resource Monitor as
shown in the figure below.

You can change the service name of the SCOM ?

» To open the Resource Monitor on the Windows Server:

B Press Cntrl+ Shift + Esc.

Figure C-5: SCOM Server Resource Monitor
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